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The Artlantis Family

Artlantis combines the most advanced and effective functions for realistically simulating the material and lighting
effects needed for any three-dimensional project. Artlantis Render communicates directly with the leading CAD archi-
tecture software (such as ArchiCAD, VectorWorks, SketchUp, AutoCAD, etc.) and can import the main CAD file
formats: DXF, DWG, 3DS, DWF, OBJ, FBX SKP.

Artlantis technology is available in two main versions, offering a product line suited to different needs and practices.

Artlantis Render - Radiosity for fixed images

Artlantis Render is a unique and ideal tool for performing very high resolution rendering easily and in real time. The
FastRadiosity™ engine lets you calculate radiosity images... with preview in real time. Artlantis Render uses 3D com-
ponents and 3D vegetation directly in the preview window by simply dragging and dropping them. This enables
users to work quickly on the various scenarios and simulate virtual scenes in a real environment.

Artlantis Studio - Animation for everyone

Artlantis Studio is the perfect tool for professionals who design presentations based on fixed images, animation,
QuickTime VR panoramas, etc.

Equipped with the new FastRadiosity™ engine, Artlantis Studio offers advanced functions such as scene animation
and object animation, to name just a few. Just like with most Artlantis functions, camera pan, viewpoints and aim
points are defined easily and intuitively.

Artlantis Media

In addition to the standard library, Abvent offers theme-oriented CD-ROMs that provide a multitude of materials and
3D objects that you can use to produce composite images. These are produced specially for Artlantis by a number of
industry partners or independent designers.
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"1 This icon indicates functions that are particular to the Artlantis Studio version.

Artlantis 4 New Features

General Points

Artlantis is now a 64 bit program.

Viewpoint Inspectors

Tone Settings post-process with separate treatment for light and dark tones.See "Tone Settings" page 160

Materials

Split a material by Mesh, giving the possibility to apply a different treatment. See "Split Material by Mesh" page
124

New way to reaffect a Material by creating a new material or using an existing one.See "Reaffect a Material"
page 122

Shader creation adding the Fresnel Effect. A new Fresnel transition slider is displayed.See "Create Shader and
Shader Interface Match:" page 108

Projection settings new item: Horizontal projection. The Shader is required to be set horizontally. See "Horizontal:
the Shader is required to be set horizontally." page 121

New surface Fresnel Shader (diffuse and transparent).

Clearness of the textures.

Material and texture colors: more faithful rendering of colors (grayish veil over).

Heliodons

New physical 3D sky, much deeper with better horizon color gradation.

Objects

Objects Inspector a multiple selection of objects is now possibleSee "Multiple selection” page 137

Gravity can be applied to an object, makes it possible to be set precisely on a surface.

In 2D View object's a single or multiple duplication of an object follows the topography of the scene, e.g. a tree
duplicated along a path on a hill follows the slope of the hill.See "The multiple duplication of objects follows the
topology of the geometry. Example: a tree duplicated along a path on a hill will follow the different heights of this
hill." page 40

Panoramas (Studio only)

New integrated Multi-nodes panoramas authoring tool.

Multi-nodes management with multiple links.

Flash Player generator for Web publishing (free of use).

Conversion tool to iVisit 3D1 (a multi-node panorama player for i0S).

Rendering

Artlantis Batch Rendering now offers the possibility of editing the document settings before the final rendering.See
"Artlantis Batch Render" page 171

Rendering speed is much faster than on Artlantis 3: it is now at least twice as fast and is up to seven times faster
when the scene uses Neon Light or Neon Glazing Shaders.

Radiosity enhanced, better energy diffusion, better treatment of transparency, less artefact and better neon lighting dif-
fusion.

IThis is an i0S application for iPad, iPhone or iPodTouch. It is used to view Artlantis pan-
oramas.
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Opening Old Artlantis Files

Opening Artlantis 2 files

By default, the files will keep the same appearance as in version 2. The Radiosity rendering settings will be under
Custom in the drop-down menu. According to the type of view you can redefine an interior or exterior lighting type.
You can also define other custom settings - see Expert Rendering Parameters.

Opening Artlantis 1.2 files

Scenes produced in Artlantis 1.2 must be converted.

Shaders Inspector

Texture Definition Controller

In Artlantis 3, the software engine automatically computes the level of texture definition.

Modifying the Material Definition

In earlier versions of Artlantis (including version 1.2), material definition was based on an "Extended Phong"
model that was perfectly suited to rendering for launching rays, but was not appropriate for radiosity. Artlantis 3.0
interprets material components more realistically. The definition of Shaders is not changed by compatibility concerns
with the Shader collection acquired.

Viewpoints Inspector

The old Atmosphere function is no longer supported and more advanced functionalities are available in the Hel-
iodons inspector (simulation of sky and sun, natural fog, cloud editor).

The two-color gradation has been replaced with a new three-color gradation.
Gradation rotation is no longer supported.
Depth of field effects are slightly different.

The hatch engine is no longer available and has been replaced by the Post-Process Effects.

Heliodons Inspector
The radiosity contribution check box has been removed. The sun and sky contribute to overall illumination.

Five colors have been deleted for customizing the sky. Artlantis 3 uses a new sky and sun simulation with natural
lighting. When files produced in 1.2 are opened, they are converted to this new physical simulation model.

Lights inspector
Artlantis 3 uses a physical light model that is not compatible with the version 1.2 light settings.
The radiosity contribution check box has been removed. The light contributes to overall illumination.
The parallel light has been removed.
The spot and lighting point are merged under lights.

The blurred shadow and transition parameters have been removed and replaced by a variable that is available for all
lights.

Catalog
It is no longer necessary to catalog the media folder.
Simply specify your preferred folder.

System Requirements

Minimum System Requirements

e Mac Intel Dual-Core Duo 2,66 GHz

e RAM :4 GB on a Mac 32 bit and 8 GB on a Mac 64 bit*
e System: Mac OS X 10.5.8

e 256 MB graphics card **, OpenGL 1.4 capable.

e Display resolution: 1280 x 1024 million colors

e Internet access

e QuickTime™7.6.6
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3-button mouse with wheel.

* On Mac 64 bit when the RAM is limited to 4 GB, please force the application to be launched in 32 bit.
(Cmd-I on the application, then check the box Open in 32 bit mode). Doing so will avoid slow atl file open-
ing and slow data base navigation.

** Graphic chipsets are not supported.

Recommended System Configuration

e Mac Intel® Core i3, i7, Mac Pro Quad-Core, 6, 8 Core

e System: Mac OS X 10.7.1

e 1 GB graphics card, OpenGL capable.

e Display resolution: 1600 x 1200 or greater

e  QuickTime™10.0

Installation

e Be in Administrator session.

e Follow the steps: Users License, Customized Installation, Installation Disk.

e By default, an Artlantis folder is created at the first level of the Programs folder. In this folder are installed
the executables. The folder contains the following: Artlantis, Artlantis Batch, Artlantis KeyServer, and the
Media folder.

e The online help is accessible from the menu: Help > Artlantis Help.

e Sample files are available into the Scenes folder installed in the Artlantis 4 folder.

NB: When first launching Artlantis, the Firewall displays a QTSocketServer process to reach the network.

Please

authorize to assure the compatibility of certain Artlantis 32 bit components running in 64 bit.
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About the Software activation.

In this chapter you will learn about the following subjects:

Activating and Evaluating Artlantis. .. ... ... 5
License Activation for Mac OS X .. ... il 5
Creating an Artlantis License Port. .. . i 7
Deactivating the License. ... il 9
Evaluation Period. . . ... il 10
Installing and activating network licenses. ... ... ... . ... 11

Activating and Evaluating Artlantis

The first time Artlantis is launched, the activation and evaluation dialog box appears, as shown below:

License not activated

The evaluation period will expire in 30 days. You can activate a new license, run Artlantis in
demo mode or guit

Evaluate r Check Network ) [ Quit )  Activate License

License Activation for Mac OS X

By Internet

License Manager

Enter your serial number: |

( Activate License )

] —_—
J‘I Click the lock 1o prevent further changes. (" Close )

First:

e Locate the serial number* (composed of two numbers separated by a dash) shown on your registration card or
which was e-mailed to you.

e Check that you are connected to the Internet. Artlantis will have to connect to the activation server.

NB: when launched, Artlantis will check automatically for an Internet connection.

e Enter the serial number.

e Click on the Activate License button. A message will be displayed confirming activation. Close the message to
display the open file dialog.

NB: *the serial number can be used regardless of whether you are using a Mac or Windows.
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Potential Problem: License Cannot Be Validated

— Unable to activate license: No available
W licenses (1).

The maximum number of users associated with the license in question has been reached. To activate the license
number on a new workstation, you must first deactivate it on the workstation(s) currently using this license*. You
can then activate the number on the new workstation. Another solution is to purchase a new license at a reduced cost.
Contact your reseller for more information.

NB: *You do not have to uninstall the software. Simply deactivate the license.

Manual

In case of no Internet connection.

License Manager

Manual Activation, no server connection available.
1°/ Enter your serial number

2% Enter the dentity mumber at hitp://Stvatan. ariantis com
3*/ Enter the activation code returned by the server

4%} Click the Activate License buttor

Enter your serial number;

Your identity number is:

Enter the activation code:

Activate License

1 —
1_4 Click the lock 1o prevent further changes. ( Close )

e Locate the serial number (composed of two numbers separated by a dash) shown on your registration card or
which was e-mailed to you.

e Note down the identification number located on the license handler (this number is encrypted).

e Use a machine connected to the Internet and go to the Artlantis activation site at: http:/-
/activation.artlantis.com

e Once the activation page appears, enter the identification number that you had written down earlier then click on
the button "Connect to server".

v [

ARTLANTIS

1°/ Enter your Identity Number here

29/ Connect to server by clicking this button

P
(Connect ta server... )

3°/ Copy this code and enter it in Artlantis dialog
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Serialization - Creating an Artlantis License Port s

You will be issued with a license number that you will need to copy and paste in the Enter your Activation code field
of the license handler.

Congratulations! Your license has been

E properly activated.

—

NB: You can access the license manager by going to: Artlantis Menu > License...

Creating an Artlantis License Port

Mac OS X 10.5 Step Sequence

e If Artlantis is not activated and your Firewall settings are on, it will ask you to authorize the connection to the

activation server.

Do you want the application
“Artlantis.app” to accept incoming
network connections?

Clicking Deny may limit the application's behavior.
This setting can be changed in the Firewall pane of
Security preferences.

(w0

e If'you want to set this Firewall connection manually, select the Security icon on the Preferences System dialog.

Security

e Seclect the Firewall Tab.
e Click on the + icon to add the application to the services list.

aon Security

[ General _Filevault | Fir

(O Mllow all incoming cennections

) Allow only essential services

(3 Ser access for specific services and applications
Mac 05 X normally determines which programs are allowed incoming connections. Select this
option if you want to allow or block incoming connections for specific programs.

File Sharing (AFP)

+‘ (Advanced . )

1
[ l Click the lock to prevent further changes.

e Select the Artlantis application icon then click on 4dd.
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[m| |3 Artlantis 2 B (@ search )
Artlantis Batch
Artlantis KeyServer Help

ﬁ W

Media L

v

@I
A

Artlantis is then added to the list, and you can authorize the connections with the popup menu.

[ General _FileVault | Firewall }

O Allow all incoming connections
O Allow only essential services
1) Set access for specific services and apglications

Mac 05 X normally determines which Select this
option If you want to allow or block for

File Sharing (AFF)

+ Allow incoming connections 1. &
Block incoming connections
—————

on
dﬂ
Click the lock 1o prevent further changes. ®

Artlantis Keyserver with OS X 10.5

e At the System prompt, click to authorize the incoming network connections.

ous que I'ap « Artlantis
KeyServer 2.app » accepte les connexions
réseau entrantes 7

Cliguer sur Refuser risque de limiter le
comportement de I'application. Ce réglage peut étre
modifié dans I'onglet coupe-feu des préférences de
sécurité.

( Refuser ) f—hﬂm—)

Mac OS X will validate this condition on the Firewall Tab of the Security Services
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Sécurité

Général  FileVault | Coupe-feu

O Autoriser toutes les connexions entrantes

(O Autoriser uniquement les services essentiels

® Définir I'aceés de certains services et applications
Mac 05 X détermine normalement les programmes gui autorisent les connexions entrantes.
Sélectionnez cette option si vous souhaitez autoriser ou bloguer les connexions entrantes pour
cerains programmes.

Partage de fichiers (AFP)

& Artlantis KeyServer 2 Autoriser les connexions entrantes :

o

N .
1" Pour empecher les modifications, cliquez icl. @

NB: changing this setting does not affect the security of the Mac or the operation of other sofiware.

Deactivating the License

Artlantis Menu > License... click the Deactivate tab.

License Masages,

A license can be activated on only one computer at the same time.
For your canvenience, you can deactivate a license from one computer and activate it on another one
without installing andfer un=installing the software.

You can also buy additional licenses at special discount.
Please contact your local distributar o reseller for more information.

Deactivate License

ﬂf Click the lock to prevent further changes. Close )

To deactivate the license, click on "Deactivate license". Then click Close.

Manual

In case of no Internet connection.

License Masages,

Alicense can be activated on only Gne computer at the same time,
For your convenience, you can deactivate a license from one computer and activate it on anather one
without installing and for un-installing the software.

You can also buy additional licenses at special discount. Please contact your local distributor or reseller
for more information

Manual deactivation, no server connection available.
1%/ Click the Deactivate button
2*/ Enter your Identity number at http:/ /activation.artantis.com
3% Enter the deactivation code returned by the server
47 Click the Close button
Your identity number is:

Enter the deactivation cade:

Deactivate License

ﬂf Click the lock to prevent further changes. Close )

o Click on the Deactivate license button then confirm the deactivation.
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LicaneqManssat

Alicense can be activated on only one computer at the same time.
For your convenience, you can deactivate a license from one computer and activate it on anather ane
without installing and/or un-installing the software

Yau can also buy additional licenses at special discount. Please contact your focal distributor or reseller
far more infarmation.

Manual geactivation, no server connection avalable.

1%} Click the Deactivate bitton

2'/ Enter your Identity number at htp: //activation ardantis.com
3°/ Entes the deactivation code returned by the server

4*} Click the Close button

Your identity number is: _

Enter the deactivation code: | |

1
J,{ Click the Iock to prevent further changes. ( Close )

e Note down the identification number located on the license handler (this number is encrypted).

e Use a machine connected to the Internet and go to the Artlantis activation site at: http:/-
/activation.artlantis.com

e Once the activation page appears, enter the identification number that you had written down earlier then click on
the button "Connect to server".

ki 7

ARTLANTIS

1°/ Enter your Identity Number here

2°/ Connect to server by clicking this button

(Connect to server... )

3°/ Copy this code and enter it in Artlantis dialog

The server will send you a code number that you need to copy and paste in the Enter the deactivation code field in
the License Manager.

e Click on the Close button, then validate to confirm the deactivation.

— Your license has bean properly
W deactivated.

Evaluation Period

Clicking on "Evaluate" launches Artlantis in evaluation mode for 30 days. All of the application's commands are oper-
ational for this period of time: Open, Save, etc. The only restriction is that the Artlantis demo logo appears at the bot-
tom of renderings.

The application will no longer open files after the 30-day trial period has expired. However, it will continue to start up
so it can be activated. Contact your reseller to purchase a license.
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License not activated

o The evaluation period has ended. You can activate a new license or quit

Teate)  (our) (RS

o Click on "Activate License" to access the activation dialog.
e Click on "Quit" to close the program.

NB: With the licensed version, you can continue any work you started using the evaluation version.

Installing and activating network licenses

Purpose:
Using the Artlantis Keyserver enables you to launch Artlantis on a specific number of client computers connected to
the same network.

At an instant t, Artlantis can be launched on x-number of client workstations simultaneously (with "x" being the
number of licensed workstations). Once it is launched on x-number of workstations, Artlantis will not launch on any
additional workstations without first closing it on one of the stations where it is open.

Requirement:

e A single network with Mac and/or PC workstations connected (Important: no sub-network).
e A special "Network" serial number.
e The Artlantis Keyserver application located in the Artlantis installation directory.

Installation:

Install and validate the license either over the Internet (recommended) or manually.

Step 1 - Activate the network license on the server

e OnalLAN, select the computer that will act as the server*, then launch ArtlantisKeyserver in the Artlantis instal-
lation folder.

* The server can be any computer connected to the network. It is best to select a computer that is connected to the

Internet.

e Click on "Edit License...". The license manager is displayed.

Artlantis KeyServer

ARTLANTIS

STUDIO

KEYSERVER

Copyright 2005 ~ 2000 Abvent RAD:
Sorry, ne valid Artlantis KeyServer lieense on this machine

Update Licenses ) ( Edit License... @ Quit )
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Validation by Internet:

License Manager,
Enter your serial number: | LR e |
(" Activate License )
{ ==
U7l Click the lock 1o prevent further changes. [ Close )

e Enter the network number (composed of two numbers separated by a dash) shown on your registration card or
which was e-mailed to you. Then click on Activate License. A message should confirm that the license has been
activated correctly.

Validating manually:

Licerise Manager,

Manual Activation, no server connection available.
1/ Entes your serial number

2% Enter the Identity number at hitp: //activation. artiantis.com
3*/ Enter the activation code retumed by the server

4" Click the Activate License button

Enter your serial number, |

Your identity number is: —.

Enter the activation code.

1
.1,4 Click the lock 1o prevent further changes. (" Close

e Locate the serial number (composed of two numbers separated by a dash) shown on your registration card or
which was e-mailed to you.

e Note down the identification number located on the license handler (this number is encrypted).

o Use a machine connected to the Internet and go to the Artlantis activation site at: http:/-
/activation.artlantis.com

e Once the activation page appears, enter the identification number that you had written down earlier then click on
the button "Connect to server".

ki Ly

ARTLANTIS

19/ Enter your Identity Number here

2°/ Connect to server by clicking this button

(Connect to server__)

3%/ Copy this code and enter it in Artlantis dialog

You will be issued with a license number that you will need to copy and paste in the Enter your Activation code
field of the license handler.
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Congratulations! Your license has been

w properly activated.

Start the Artlantis Keyserver* application located in the Artlantis folder that was installed.

NB: Artlantis KeyServer must be launched only on the server workstation. The server identification number
is activated only once on client workstations.
* In order for the client workstations to be able to use Artlantis, the Server must be activated and Artlantis Key-

Server launched. They can operate on the Artlantis server and Artlantis Keyserver at the same time.

Step 2: Install Artlantis on the client workstations.

e Make sure that Artlantis Keyserver is launched on the server.Y ou can now launch Artlantis on the client sta-
tions.

e Click on Check Network to find an available key. If there is an available license on the server, the application
will be activated immediately.

Sorry, no valid Artlantis KeyServer license on this machine

( Update Licenses ) 'r Edit License... _‘ L Quit y

Potential Problems

e If Artlantis prompts you for a serial number on a client workstation: Check that the computer is connected to the
local network. Check that the Artlantis Keyserver has been started on the server.

e For Server workstations, the standard Mac firewall settings pose no problem. If this turns out not to be the
case, manually open UDP from the "Terminal" application by using the command "sudo ipfw add allow
udp from any to any 49150 1in". You will be prompted to enter the administrator password. Under
Mac OS X 10.5 you can unblock the port when the System invites you to.

e For a Client workstation, the Firewall settings have to be changed. Select System preferences > Security >
Firewall and add the Artlantis application to unblock incoming connections. See creating Artlantis License

port images.

NB: changing this setting does not affect the security of the Mac or the operation of other sofiware.
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Opening 3DS Files

Scale factor: Translations (values in cm)
1 dawingunitsequals  L0d | em %) pe 0.00
¥: 0.00
# Convert camera: s ™ Convert lights z 000
(o) G

e Scale factor: reduces or enlarges object size. The scale factor is a homothetic coefficient.
e Converting cameras or lights: Imports lights and/or cameras defined in the original model.

e Translation: Redefines the position of the imported object relative to the scene's geometric tag.

NB: Artlantis imports material names, textures and fixed cameras.

Opening an Artlantis File
Either by:
Double clicking on an ATL or AOF file.

When the following dialog appears on opening a file, this means that one of the Medias associated with the project is
missing. Click on the missing element(s)

CO6)

Media used in this document but not found:
Tile430.xsh ]

PO

(" Delete ) ( Folder.. ) ( Replacewith...

{ Continue _ﬁ

o Delete: permanently deletes the missing linked Media, it will no longer be requested when the document is
opened.

e Folder...: lets you browse the hard disk to find the folder containing the missing listed elements.
e Replace with...: allows the missing Media to be substituted by another.

e Continue: closes the dialog box and saves the options selected.

Opening a File when the Application Launches

Welcome to Artlantis Studio (OpenRecert %) (@EOpenid)

There is 00 open document. What 60 you want to do? Qi
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Open Recent

e Lists the last 10 Artlantis documents opened.
Open...

e Displays the dialog box for opening documents.

Artlantis files saved in a version earlier than 2.0 must be converted when they are opened. When this occurs, Art-
lantis displays a data conversion dialog:

‘80N
This file was created by an older version of Artlantis.
When saved, it will be converted to the new Artlantis format, which cannot be opened by
earlier versions.

Artlantis 2.0 uses a physical like rendering engine so some of the values must be adjusted/converted to
obtain similar rendering results.
Please use the settings below for a smoother transition,

S5 Sunand Skylighting parameters wil be replaced by an automatic Sun and sky physical 5

) # Convert all lights power values to: 500,00
Lights with power values higher than réquested will 1t be converted.

g% By defauit the "Neon" shaders will not participate o the lighting of the scene. Use the new menu in the View
pet

iy e backgruna oyt and sy for s g anoden

The Atmosphere settings used in 1.2 have been replaced by clouds, fog and pollution which you can adjus in
the Heliedon Inspectar

& () Actvate infinice ground.

(S ]

Convert lamp power:

In version 1.2, lamp powers varied from 0.10 to 5,000. From version 2.1, the power varies from 1 to 1,000,000.

m  Box checked: The lamp power values will be readjusted according to the new 1 to 1,000,000 scale. If you use
the digital field to set the value beyond that, the power values will not be replaced.

m  Box unchecked: Lamp power values are retained. Note: the lamps will not have the same intensity.

The neon Shaders are not activated, so they will not take part in the lighting of the scene:

By default, the neon Shaders in version 1 will be deactivated. Y ou can activate them using the viewpoint inspector
drop-down menu.

Replace current background with natural sun and sky:

m  Box checked: The sky and sun replace the background defined in version 1.2.
m  Box unchecked: The version 1.2 background is not changed.

Activate infinite ground:

m  Box checked: An infinite ground will be placed at an altitude of 0. The altitude setting will be made in the Object
inspector.

m  Box unchecked: No infinite ground. However, infinite ground may be activated in the Object inspector.
Quit
e Closes the program without opening any document.

Drag/Drop a file to the Artlantis icon

NB: Artlantis also reads the old OPT/DB file formats produced by Artlantis 4.0
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Opening DWG/DXF Files

Scale factor:

= curve segmentation value: 16

1 drawing units equals  1.00 em B9

[ import closed contour

Bloc reatment. Affect marerial

_) per bloc definition
Lo @ per color

) per black instance =
O per layer

@ per black name

-_C:\nce'l )

e Scale factor reduces or enlarges object size. The scale factor is a homothetic coefficient.
o Curve segmentation value: The number of stops needed to define a curve or a circle entity.
e Import closed contour: Considers closed edges to be the same as surfaces.
e Block treatment: Interprets the block's material based on the following:
m [ts composition
= [ts instantiation
m [ts name
m A distinct block has a distinct material.
= FEach component of a given block has a distinct material.

m A distinct material is attributed to each block name.

o Allocating materials: To be defined either depending on the colors or the block layers.

NB: Artlantis recognizes the ACIS 3DSolid entities of AutoCad dwg and dxf files.

Opening DWF Files

Scale factor:

L | duawing unitsequals | 1.00 | [cm  F8)

Coordinate system

Convert from up-axis | ¥ %] Convert from handedness | rignt 1%

W Use units and coordinate system settings from the DWF file

{ Cancel ) (EOpen)

e Scale factor reduces or enlarges object size. The scale factor is a homothetic coefficient.
e Coordinate system:

m  Convert from up-axis: The height is defined in the modeler according to the depth of the Y axis or the
height of the Z axis.

m  Convert from handedness: Right or left, viewed from above, changes the object's symmetrical view.

e Use units and coordinate system settings: import the file with the standard settings.

NB: Artlantis imports material names and textures.
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Opening OBJ Files

Scale factor.
1 drawing unitsequals 100 | em |9}

Coordinate system.

Convert from up-axis | Y ) Convert from handedness | rght 1%

(_Cancel ) Gﬂa

e Scale factor reduces or enlarges object size. The scale factor is a homothetic coefficient.

e Coordinate system:
m  Convert from up-axis: The height is defined in the modeler according to the depth of the Y axis or the
height of the Z axis.
m  Convert from handedness: Right or left, viewed from above, changes the object's symmetrical view.

NB: Artlantis imports material names and textures*.
* You must also generate an MTL file when importing textures. The OBJ and MTL files must be side by side when

importing.

Opening FBX Files

Scale factor:
1 drawing units equals  1.00 | em D]

Coordinate system

Convert from up-axis | Y : I Convert from handedness | right I

# Use units and coardinate system settings from the FEX file

(_Cancel ) (EOpens)

e Scale factor reduces or enlarges object size. The scale factor is a homothetic coefficient.

e Coordinate system:
m  Convert from up-axis: The height is defined in the modeler according to the depth of the Y axis or the
height of the Z axis.
m  Convert from handedness: Right or left, viewed from above, changes the object's symmetrical view.

NB: Artlantis imports material names, textures, light sources and fixed cameras.

Using Reference Files

File Menu > Use Reference File...

Use Reference File Options.

Identical Material Identifier:
™ Replace Current Shaders by Reference File Shaders

Add from ReferenceFile: ¥ 4F @ @ 00 B & 6
(" AddAl ) ((Addbore J W W WM & &M & W W

:'_ Cancel |
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This command lets you:

e Refer to a previously created .atl file in order to recover Shaders, Lights, Heliodons, Objects, Perspectives,

Parallel Views, Panoramas, VR Objects or Animations u as desired.
e Update the geometry and materials between the modeling software and Artlantis.

In the dialog box, check the elements to be recovered from the reference file: Shaders, Lights, Heliodons, Objects,
Perspectives, Parallel views, Panoramas, VR Objects, Animations.

Example of Updating Geometry*:

Let us assume that you need to add a door to a document named "A.atl" that is dressed, lighted, etc.

Steps:

1. Save the current 4.a#/ document.
2. Return to the modeler and add the door. Export the file again and rename it B.atl.
Open the B.atl file in Artlantis. Select Use Reference File... from the File menu and select the reference file A.at/

in the dialog box.

Artlantis will apply the checked options from file A to file B, i.e. Shaders, Lights, Heliodons, Objects, Per-
spectives and Parallel Views.

NB: for files from modelers which export in file formats DWG, DXF, 3DS, FBX, OBJ, DWF or SKP, you

must first save the files in .atl format.

NB: limitations to the Use reference file... command :
1 - if a material has been renamed or reassigned, it will not be included

2- if a part of the geometry has been saved as an object, the destroyed geometry will reappear
3- if the Artlantis layers containing the geometry of the scene are renamed, the geometry they contain will not be

included.

NB: * the CAD sofiware ArchiCAD and Vectorworks allow you to directly update an atl file already worked
on in Artlantis. Please refer to the documentation for the software involved.
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Saving a Document

Artlantis saves in the following file formats:
ATL: The working document.
AOQF: Format for scenes, as well as objects.

Archive : Contains all elements of a project.

DWEF: The vector graphics file format for AutoCAD 2D and 3D.

OBJ: Wavefront file format.
SKP: SketchUp file format.

In this chapter you will learn about the following subjects:

Saving an ATL Document. . ... .. . ... . .. iii...
Saving an AOF Document. ... ... ... .. . ... ... ...
Saving a DWF Document. ... ... ... .. ......
Saving an OBJ Document. . .. ... . ... i.....
Saving an SKP Document. ... ... .. . ... ...,

Saving an Archive ...

Saving an ATL Document

Saves the current Artlantis document to your file system. If you try to close an unsaved document, or you attempt to
quit Artlantis when an unsaved document is open, Artlantis will warn you to save your work before continuing.

File > Save

NB: Saved documents will no longer be compatible with earlier versions.

Saving an AOF Document

Saves the entire active scene as an .aof object. Does not replace or close the file you are currently working on.

NB: The origin of the created object is similar to the Scene origin, to modify See "Transfer the origin of the

anchor point:" page 132

e Select File > Export as Object...

Save
Save As: | Flar_Start [ "]
Where: Documents TI
# Include Light Group Light Group_L B

Object placement property:
@ Abways vertical
) Perpendicular v support

[§ Cancel ) (m
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1. Include light group:
e Choose the light group you wish to save with the object. This group will be automatically integrated

into the project concerned.

2. Object positioning:
e Always vertical regardless of the surface to which it is applied (for example, a vehicle).

e Perpendicular to support on which it is placed.

Saving a DWF Document

Saves the whole active scene in DWF format. Does not replace or close the file you are currently working on.

o Select File > Export...> DWF.

Save As: | Lofi_Start23 {52
Where: | [l Pictures 4
File format; + dwf [}
foe
cbj
skp h_:’
udd | =

Saving an OBJ Document

Saves the whole active scene in OBJ format. Does not replace or close the file you are currently working on.

e Select File > Export...> OBJ.

Save
Save As: | Lofi_Start23 152
Where: [ & Pictures H
File format;  dwf 1

fox

obj

skp F’
u3d —

Saving an SKP Document

Saves the whole active scene in SketchUp format. Does not replace or close the file you are currently working on.

o Select File > Export...> SketchUp.

Save
Save As: | Loft_Start23 &2
Where: | (i Pictures '—ﬂ
File format; « dwf E

fbx

obj

skp F’
uidd | =
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Saving a Document - Saving an Archive

Saving an Archive

Saves the current document in the folder that groups all of the elements pertaining to the active document: *.atl files

and media folders: Shaders, Objects and Images and an ArchiveReport.txt file. This is a useful function for users to
share their projects.

File > Export as Archive...
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Artlantis Interface

General Information

By default, the Artlantis menu bar, the inspector navigation palette and the Preview window appear when the pro-
gram is started up.

The following other elements can be called up: General Preferences, the 2D View window, the Media Catalog, the
Timeline and the Batch Rendering window.

Place the cursor over the palettes and window commands to display pop-up help bullets.

You can drag and drop Objects, Shaders, Textures and Background Images from the catalog or directly from the
hard drive to the Preview window.

Placement of Artlantis Palettes and Windows

Menu Bar
Inspector palette
Toolbar

2D View Window
Catalog

Timeline

Preview

Viewpoints List

e A o e
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In this chapter you will learn about the following subjects:
Navigation InSpector . . .. il 26
The Artlantis Menus. . . ... ... 27
Artlantis Menu. . ... 27
File Menu. . e 28
Edit Menu. .. e 29
Display Menu. . . . 29
Inspector MenU. . . ... . e e 31
Window Menu. . e 31
TOOIS IMIeNU. . . . e e 32
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Help Menu. . il 32
The 2D View WINAoOW. . .. .. 32
Editing in 2D VieW. . e 33
Fixed Images. . . . .. 33
ANIMations. | .. 33
2D View Display and Navigation Tools. . ... . ... ... .. 33
Customizing the 2D View Toolbar. . ... .. . i 34
Editing in 2D View. . .o 34
Editing the Clipping BoxX _ .. ... .. 76
In 2D VaeW. e 76
Preview Representation. .. ... .. 77
The Preview Window. . ... ... e 71
Preview Display and Navigation Tools. .. .. ... ... ... 78
Customizing the Preview Toolbar. ... . ... 79
The Timeline Window. . . e 79
Introduction:. . ... e 79
DS PlaY. i 80
ANIMAtiN G e 80
The Timeline window is divided into the following four areas:. ... _ . _ . . .. .. .. .. . ... .......... 80
Keyframes and Guides. .. .. ...l 84
Keyframes. .. ... 84
GuUideS . | il 87

Navigation Inspector

Enables the user to edit viewpoints and animations, to configure model dressing, apply lighting effects and integrate
the project into its environment.

The behavior of certain mouse and keyboard shortcuts is dependent on the current Inspector.

The Inspector is a floating palette which can be repositioned at will.
The following nine inspectors are available:

Shaders
Heliodons
Objects
Perspectives

Parallel Views

i

e
Panoramas __|

arry

VR Objects

ol
Animations __|

Heliodon

& e o B

Activation and changing from one Inspector to another: either using the Inspector menu, or via the navigation bar at
the top of the Inspector palette.

e Click on the desired Inspector (e.g. Heliodon in the figure below).
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e To navigate between viewpoint and animation inspectors right click on the current icon.

The Artlantis Menus

Use the menu bar to access the following commands: file management, display, navigation among the various edit
modes, managing window opening and closing, and online help.

In this chapter you will learn about the following subjects:

Artlantis Men . _ . il 27
File Menu. . .o e 28
Edit Menu. . . e e 29
Display Menu. .. 29
Inspector Menu. . . .ol 31
WINAow MeNU. . . ... e 31
BT S L 32
Help Menu. . e 32

Artlantis Menu

About Artlantis

Information on the Artlantis version being used.
Preferences...

Defines the program's overall behavior.
Keyboard Shortcut: Cmd,

License

Displays the License activation manager.
Services

Provides access to Mac OS X system services.
Hide Artlantis

Hides Artlantis allowing the user to work in a different program. To return to Artlantis, click on the Artlantis icon in

the dock.

Keyboard Shortcut: Cmd H

Hide Others

Hides all visible applications except for Artlantis. To go to a different application, click on the application's icon in the
dock.

Display All
Displays all Mac OS X programs that are active.

Quit Artlantis

Quits Artlantis after saving (or not saving) the open document.

Keyboard Shortcut: Cmd Q
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File Menu
Contains the commands for managing documents (opening, saving and printing).

Open...
Saved Artlantis *.atl document. This command will directly open files in the following formats: atl, aof, opt/db, dwg,
dxf, dwf, obj, fbx, skp and 3ds.

NB: Artlantis recognizes the ACIS 3DSolid entities of AutoCad dwg and dxf files.

Keyboard Shortcut: Cmd O
Open Recent File

Fast access to a list of recently used files. You can clear the list by using "Clear Menu".

Merge Geometry from File...

A file currently opened can be merged with another file: atl, aof, opt/db, dwg, dxf, dwf, obj, fbx, skp and 3ds.
Close

Closes the document if the Preview window is active.
Closes the active window: The 2D Window, Media Catalog.

Keyboard Shortcut: Cmd W
Save

Saves the current Artlantis document to your file system. If you try to close an unsaved document, or you attempt to
quit Artlantis when an unsaved document is open, Artlantis will warn you to save your work before continuing.

NB: Saved documents will no longer be compatible with earlier versions.

Keyboard Shortcut: Cmd S

Save As...

Opens the Save As dialog box, pointing to the current folder. You can save the current file as a new document. (Ena-
bles the user to rename the file and save it to a different folder). The new file becomes the active document.
Keyboard Shortcut: Shift Cmd S

Reverts to the saved version

Active document when it was last saved.
Export as Object...

Saves the entire active scene as a "*.aof" object. Does not replace or close the file you are currently working on.

Export as Archive...

Saves a current document to the folder containing all elements belonging to the active document: *.atl files and media
folders: Shaders, Objects and Images and an ArchiveReport.txt file. This is a useful function for users to share their
projects.

Export...

Exports the geometry of the current document in OBJ, SKP or DWF format.

Use reference file...

Imports complete elements or parts of elements from a different atl. file into the current file. Shaders, lights, hel-
iodons, objects, Perspective cameras, Parallel Views, VR Objects and Animations can be imported.

Page setup...
Accesses Mac OS X page layout controls: Used for selecting and configuring the printer and options for the pages to
be printed. For more information, see Mac OS X help.

Keyboard Shortcut: Shift Cmd P
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Print...

Sends the contents of the active document's Preview window to the selected printer. For more information, see Mac
OS X help.

NB: The Preview window is printed in "draft" mode. This is a check and not a quality printout.

Keyboard Shortcut: Cmd P

Edit Menu

Contains the following standard commands for managing the file: Undo/Redo/Cut/Copy/Paste/Erase/Special Char-
acters.

Undo

Undoes the last command. Also allows the user to step backwards, undoing all operations performed since the doc-
ument was opened. The number of operations that can be recovered is limited only by the amount of memory avail-
able. The command's heading shows what action is undone and applies to the active window. Redo is the opposite
operation of Undo.

Keyboard Shortcut: Cmd Z

Redo

Reverses the last Undo command and displays the action to be redone in the heading.

Keyboard Shortcut: Maj Cmd Z
Cut

This command works in numeric fields and inspector lists.The cut element is stored in the clipboard. Clipboard con-
tents are retained until the next Cut/Copy operation is performed.

Keyboard Shortcut: Cmd X
Copy

This command works in digital fields and inspector lists.The element copied is stored in the clipboard. Clipboard con-
tents are retained until the next Cut/Copy operation is performed.

Keyboard Shortcut: Cmd C

Paste

Pastes the contents of the clipboard into inspector lists and numeric fields. Clipboard contents are retained until the
next Cut/Copy operation is performed.

Keyboard Shortcut: Cmd V

Delete

Removes the selected elements from inspector lists, numeric fields, and objects in the scene.

Keyboard Shortcut: Del
Select All

Selects all elements in Light and Object inspector lists.

Keyboard Shortcut: Cmd A
Special Characters

Opens the Mac OS X character palette so the user can insert special characters (mathematical symbols, accented
letters, arrows, etc.). For more information, see Mac OS X help.

Display Menu

Contains commands for displaying the project in the active view (Preview Window, 2D View window).
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Enlarge/Reduce

° In the Preview window:

Factor of x1.5 from center. Sizes are to be defined in the Artlantis Preferences. Maximum size 1200x1200,
minimum size 640x640.

° In the 2D View window:

Factor of x1.5 from center.

Keyboard Shortcut: Enlarge Cmd + and Reduce Cmd -
Fit to Window

° In the Preview window:
Fit the view to the window size.
° In the 2D View window:

Instantly displays all elements of a project.

Keyboard Shortcut: Cmd =
Zoom
Acts the same way in the Preview and 2D View windows except that, in Preview, the camera target and the focus are

recomputed.

. Zoom + click in the window enlarges the view x2 from the point clicked.

. Zoom + click, followed by dragging and dropping into the window enlarges it in relation to the center of the
rectangle.

To zoom out, depress the A/t key before clicking or describing the limiting box. The tool deactivates when the com-
mand is finished.

Keyboard shortcut: Zoom in Cmd * Zoom out Cmd * then alt
Pan

Moves the content by dragging and dropping in the desired window. The tool deactivates when the command is fin-
ished. The camera target is recalculated for the Preview window.

Keyboard Shortcut: Cmd /

Holding down the middle button on the mouse produces the same effect.
Change 2D View

Replaces the current projected view with a different one: Top, front, right, left or back.

Keyboard Shortcut: 1,2, 3,4 or 5
2D View Display
Enables the user to change the type of display: Wireframe or Textured mode.

Previous

In 2D view, this enables the user to navigate by back-stepping upwards through the sequence of views displayed in
the tree structure.

Keyboard Shortcut: Cmd <
Next

In 2D View, this enables the user to navigate downwards through the sequence of views displayed in the tree struc-
ture.

Keyboard Shortcut: Cmd >

Hide Toolbar

Displays/hides the bar for the view active in Preview or 2D View.

Customize Toolbar...

The view activated in Preview or 2D View dictates whether this function is active or not. You can customize the tool-
bar to meet your needs and the way you work.
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Inspector Menu

Contains the inspectors for views (perspectives, parallel views, panoramas, VR Objects and animations), lighting
effects (lights and heliodons), scene dressing (shaders, textures and objects), and environment (sun, sky, background
and foreground images, insertion to site, depth of field, fog, pollution, ambient and post-production effects).

NB: It is not always necessary to change the edit inspector in order to modify a project. There are sufficient
commands available, regardless of which inspector is active.

Perspectives

Displays the Perspectives inspector.
Parallel Views

Displays the Parallel View inspector.

Panoramas
Displays the Panoramas inspector.

VR Objects
Displays the VR Object inspector.

Animations

Displays the Animations inspector

Shaders

Displays the Shader inspector.
Displays the Lights inspector.
Heliodons

Displays the Heliodon inspector.
Objects

Displays the Object inspector.
Render

Displays the rendering window for defining the rendering format and options, as well as the destination.
Keyboard Shortcut: Cmd R
Partial Render

In the Preview window, draw a rectangle by dragging across two opposite corners to define the area you wish to
render. The rendering appears in a new window. The Save Image dialog box appears when you close the rendering.

Keyboard Shortcut: Cmd Shift R
Batch Rendering...

The Batch Rendering window handles the state, destination and format of batch renders that have been defined in
advance using the Render command.

Window Menu

Contains the window activation commands: 2D View, Catalog
2D View

Displays the projected view: Top, front, right, left or back.
Catalog

Displays the Media Catalog.
Timeline

Displays the Timeline.
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Scene information:

Displays the scene settings dialog .

Minimize

Reduces the size of the window for the current document to a minimum and places it in the Dock. For more infor-
mation, see Mac OS X help.

Keyboard Shortcut: Cmd M
Bring everything to the foreground

Brings all open Artlantis windows to the foreground (document, windows, etc.). For more information, see Mac OS
X help.

Tools Menu

Create Shader

Opens the Edit Shader dialog
Create a Postcard™

Saves the current view as a Postcard™

Help Menu

Artlantis Help

Online Artlantis documentation containing reference information on each of the program's functions, plus detailed
illustrated tutorials.

Keyboard Shortcut: Cmd ?

Artlantis web site

Opens your Web browser to the Artlantis Home page by default: The English language Artlantis forum, product
information, updates, FAQs, training, etc.

Additional Media

Displays additional media available on the Artlantis Web site.

Online Tutorials

Displays the tutorials page in your Browser.

Online registration...

Lets you register the product directly on the Abvent site. Fill out the form displayed then confirm.

The 2D View Window

This is used for viewing and editing the project in the following five projected views: Top, front, right, left or back.

View display is independent of the current inspector. Example: In the Perspectives inspector, you can edit lights in
2D View without activating the Lights inspector.
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(oY) 2D view =7
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2D View Display and Navigation Tools

Customizing the 2D View Toolbar
Keyboard and Mouse Shortcuts

Editing in 2D View

Right clicking on the element you wish to edit displays a pop-up menu for the current operations: Duplicate, Delete,
Attribute To, etc. These are performed in real time in the Preview window and in the relevant inspectors.

Fixed Images

Working with Objects in 2D View
Working with Parallel Views in 2D View
Working with Perspectives in 2D View
Working with Lights in 2D View
Modifying Heliodons

Working with the Clipping Box in 2D View

Animations

Working with Panoramas in 2D View ]
Working with VR Objects in 2D View

Working with Panoramas in 2D View ]

2D View Display and Navigation Tools
= () B o 72 mAE 2 O N

Default tools available

-
Previous and Next: Used for moving between displays.

= Fit to Window: Maximizes the display of all of the geometry and lights to the full size of the window.
U‘—Zoom: Increases the zone defined by a rectangle. Alt+Zoom reduces the display.

a5

4 .
———Pan : Reframes the content of the window.
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=R
Change View: A drop-down menu for selecting the projected view.

.J‘.

object

Edit Path: In animation mode, is used for creating or modifying a path relative to a camera, a light oran |

Customizing the 2D View Toolbar

The following tools are available by right clicking on the toolbar:

Drag your faverite item into the toclbar..

= z = &
e 2 _ alxl‘.L'.'..Jr,l)\: (]| .@,
Fit Zoom Pan Change View Change View Display Mode
|EE|=:|5 * » =
Display Mode Previous Mext Edit Path Mode Flexible Space Space
Separator

-.or drag the default set.

® (» ®a 2 IiE
Prévious Next Fit Zoom Pan Cn:mge Wi Edit Parh Mode
show [iconOnly B8 ([ Use Small Size  Done )

To add a tool, drag and drop it onto the bar. To delete a tool, drag it outside of the bar.

L i)

Display Mode Djsplay mode: Switches from wireframe to textured display.

Editing in 2D View

In this chapter you will learn about the following subjects:

Working with Perspectives in 2D View. ... ... il 35
Working with Parallel Views in 2D View. _ . ..., 37
Working with Objects in 2D View. ... . .. 39
Working with Lights in 2D View. .. 41
Editing Heliodoms. . . .. il 45
Working with the Clipping Box in 2D View. .. ... .. 47
Working with VR Objects in 2D View. ...l 48
Working with Panoramas in 2D View. ... ... 52
Working with Camera Animation in 2D View. .. _ ... ... 55
Working with Light Animation in 2D View. . ... . ... 63
Working with Object Animations in 2D View. . ... ... 69
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Working with Perspectives in 2D View

Display Wireframe Mode State or Action Comments

Viewpoint inactive Represented by the cam-

era (gray point).

Active viewpoint selected. Represented by the camera
(red point), the target (gray
point), the focusing angle
(blue lines) and the angle's

bisector line (gray line).

o Move the camera. e Move the red point.

o Move the target. e Move the gray point.

Move the camera in a
parallel direction.

Move the gray bisect-
ing line.

Change the focusing
angle.

Move one of the two
blue lines.

Duplicate viewpoint

or

Press ALT and move
the camera (red
point).

Right click on the
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s

Dalete

Add to Parallel View List
Add to Panorama List
Add to VR Object List
Add to Sequence List

Edit Heliodon

Edit Light [ 3

Duplicate" in the
pop-up menu.

T—
Duplieate
D

Add vo Paralbel View List
Add vo Panorama List
Add to VR Object List
Add to Sequence List

o Delete viewpoint

e Right click on the
camera then select
"Delete" in the pop-
up menu.

Edit Helimdon

Edit Light [ ]
———

Duplicate

Delete

Add to Parallel View List
Add to Panorama List
Add to VR Object Lise

e [Edit an active light
with this viewpoint.

e Right click on the
camera (red point).
In the pop-up menu,
choose "Edit Light",
select the name of

the light.
Add 1o Sequence List
Edit Heliodon
- - - NB: The inspector pal-

e ¥ =i ette switches from Per-

spectives mode to Lights

mode.

e Edit an Active Hel- e Right click on the

Duplican: . . . 1 .
Delete iodon with this View- camera (red point)

Add to Parallel View List
Add to Panorama List
Add to VR Object List
Add to Sequence List

Edit Heliodon [

Edit Light [ 3

point.

then select "Edit Hel-
iodon" in the pop-up
menu.

NB: The inspector pal-
ette switches from Per-
spectives mode to Heliodons
mode.
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Working with Parallel Views in 2D View

| Display Wireframe Mode | State or Action | Comments
Viewpoint inactive Represented by the camera
(gray point).

<

Active viewpoint selected. Represented by the camera
(red point), the target (gray
point), the width of view
(red lines) and the symmetry
axis linking the camera and

the target (gray line).
o Move the camera. e Move the red point.
e Move the target. e Move the gray point.
e Move the camera in a e Move the gray sym-

; i parallel direction. metry axis.
e Define the view area. o Move one of the red

; f lines.
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Deletre

add to Perdpective View List
aAdd 1o Panorama List
Add ta VR Object List
Add 1o Seguence List

Edit Heliodon

Edit Light [ 3

e Duplicate the view-
point

e Pressthe ALT key
then move the cam-
era (red point), tar-
get (gray) or the
symmetry axis
(gray).

or

e Right click on the
camera then select
"Duplicate" in the
Ppop-up menu.

Dugplicate

add to Perdpective View List
Add 1o Panorama List
Add ta VR Object List
Add 1o Seguence List

e Delete viewpoint

e Right click on the
camera then select
"Delete" in the pop-
up menu.

Add to Pasorama List
Add ta VR Object List
Add to Seguence List

oramas, VR Objects or

Sequences

Edit Heliodan

Edit Light [ 3

Duplicate e Add to Viewpoints Right click on the camera
Delete List: Perspectives, Pan- then select "Add To List..."

in the pop-up menu.

add to Perdpective View List
Add 1o Panorama List
Add ta VR Object List
Add 1o Seguence List

Edit Heliodon

Edit Heliodon

Edit Light [ 3

Duplicate e Edit an Active Hel- e Right click on the

Delete iodon with this View- camera (red point)
point. then select "Edit

Heliodon" in the
Ppop-up menu.

NB: The inspector pal-
ette switches from the Par-

Add to Perdgective View List
Add to Parorama List
Add to VR Object List
Add to Seguence List

Edit Heliodon

Edit Light 3
allel View mode to
Heliodons mode.
Duplicats e Edit an active light e Right click on the
Delete with this viewpoint. camera (red point).

In the pop-up menu,
choose "Edit Light",
select the name of
the light.

NB: The inspector pal-
ette switches from Parallel
View mode to Lights mode.
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Working with Objects in 2D View

| Display Wireframe Mode State or Action

Comments

Object deselected

Represented by the geometry
and a green center point.

Selected object

Represented by the geometry
and a blue center point.

e Move an object.

e Move the blue point if
the object is active or
green point if it is inac-
tive.

5 e Duplicate an Object.

e Press Alt and move blue
or green point.

—~3 e Multiple duplication of
an object

1. Press Shifi+Alt keys and
draw out a (green) line.

2. Hit the "plus" key to
indicate the number of
copies (pink points).
Press the "minus" key to
remove them.

3. Confirm by hitting
Enter.

Make Multiple Duplicates of
i More than One Object.

Select the objects:
Cmad-+click the objects

1. Press Shifi+Alt keys and
draw out a (green) line.

2. Hit the "plus" key to
indicate the number of
copies (pink points).
Press the "minus" key to
remove them.

3. Confirm by hitting
Enter.
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Find all Similar Instances
Define as Target

Find all Similar Instances

Use as camera target/Do not
use as camera target for an
animation or perspective
view

Redefine the anchor point of
an object

e Select the object, press
D then in 2D View drag
the object's blue anchor

point.

This works for internal or

external object).

multiple duplication of
jects follows the topology of
geometry. Example: a tree
licated along a path on a
hill] will follow the different
heiphts of this hill.

te duplicated, the new
s follow the topography.

NB: Objects are deleted from the inspector list.

Page - 40



Artlantis Interface - The 2D View Window

Working with Lights in 2D View

Display Wireframe Mode State or Action Comments
Deselected light is off Represented in shaded yellow.
@
Selected light is off Represented in shaded yellow cir-
cled in black.
o

Deselected light is on

Represented in bright yellow with
thin black circle.

a
Selected light is on Represented in dark orange with
thick black circle.
o
e Move a light Move the yellow point(s) depend-
@ ing on the type of light.
£ e Turn On/Off Turn current light on/off.
Duplicare
NB : Selecting more than
Cust one light enables you to turn them
Copy on/off at the same time.
Delete
Edit View Using This Light 2
e Duplicate a light. e Hit the 4/t key to move the
yellow point.
or
Pimbsr
Turn On e Right click on the yellow
Turn QFf point and select "Duplicate"
in the pop-up menu.
Cut
C
D::“ NB: The duplicated light
wre .
retains the parameters of the ref-
Edit View Using This Light » erence light (power, shadows, etc.).
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e Multiple duplication
of a light

1. Press Shifi+Alt keys and
draw out a (green) line.

2. Hit the "plus" key to indi-
cate the number of copies
(pink points). Press the
"minus" key to remove
them.

3. Confirm by hitting Enter

o Make multiple dupli-
cations of more than
one light

e Select lights belonging to
the same group:

Cmd-+click the lights.

1. Press Shift+ALT keys and
draw out a (green) line.

2. Hit the "plus" key to indi-
cate the number of copies
(pink points). Press the
"minus" key to remove
them.

3. Confirm by hitting Enter

NB: The duplicated lights
retain the parameters of the ref-
erence light (power, shadows, etc.).
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L
[
o
2
L]
L] L]
-] L]
L L] L
e o
° e o
o e
L] -]
L]
]
3
Z e Cuta light Deletes the current light, but
'/._ Turn Or | holds it in memory so it can later
Turn Off be pasted into a light group from
Duplizate the lights list. (To paste into the
lights list, right click on the name
Copy of a group and select Paste).
Delete
Edit View Wsing This Light [ 3 !
o Copy a light Copy the current light without
deleting it. It is held in memory
so it can later be pasted into a
Y light group on the lights list. (To
Fiiyi paste into the lights list, right
1 TurmOff click on the name of a group and
Duplicate select Paste).

Delete NB: Selecting more than
one light enables you to copy
Edit View Using This Light » them at the same time.

a e Delete a light e Right click on the light then
'/., T Ch select "Delete" in the pop-
T“""_D" | up menu. The light is
L | deleted. To recover the
| light, go to Edit > Undo

|  Copy | Delete Lights
| Edit View Using This Light -
e Edit a view using this e Right click on the light. In
L light. the pop-up menu, choose
/ Turn Or "Edit View Using This
TP ENT | Light". Select the name of
. Duplicate | .
the view.
Cut
Copy |
Delete |

Edit View Using This Light

NB: The inspector palette
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switches from the Lights mode to
Viewpoints mode (Perspectives or
Parallel Views).
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Editing Heliodons

Sun Position

Display Wireframe Mode

State or Action

Comments

Position the
sun based on

the geo- /
graphical / \
location, date / \ True North (compass
and place / \Ill Orientation point).
&5‘" Franghce e Setting the orientation The rays of the sun
4 of North (vellow lines with
L arrow points) are
Pivot the yellow point positioned depending
around the compass. on the location, true
The yellow arrow North and the date
will move accord- and time.
ingly around the cir-
\lll cle.
/ ll'l._ NB: Use the
Heliodons inspector
to configure these ele-
ments, except for true
North.
Shadows are then
recomputed in the
Preview window.
Manually o Manually positioning Shadows are then
move the the sun. recomputed in the
sun. Preview window.
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Limit the e Graphically moving Shadows are then
sun to the viewpoint redi- recomputed in the
alwayscast- rects shadows cast to Preview window.
ing shad- 45°.

ows at 45°

depending

on  view-

point posi-

tion.
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Working with the Clipping Box in 2D View

Wireframe Display Mode

State or Action

Comments

Limiting box

Represented by a blue cross-
hair and rectangle.

e C(lick/drag inside
the box to move
it.

e Resize Clipping
Box

Move the blue points located
at the corners.

e Turn Clipping
Box

Turn the blue handle of the
crosshair around its center.

@
Move the center of the cross-

hair to redefine the axis of
rotation

Elevated view

Editing operations are the
same as in plane view, except
that the box does not pivot.
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Working with VR Objects in 2D View

Wireframe View on Plane Mode Display

J Hemispherical
I 7 | Toric
— Spherical

'

Wireframe
View in
Elevation
Mode Display
mode

State or Action

Comments

VR object dese-
lected

Represented grayed by the
target and a circle.

VR object
selected.

Top view: represented by
the camera (gray dot on
the circle), the target (cen-
tral red dot).

The camera moves around
the blue circle. The focus
opening angle is defined by
the two blue lines and the
angle bisector (gray line).

In Elevation: The target
point is red. Two gray
points linked by a shaded
line represent the camera
altitude.

The small red points on the
circle represent the cam-
era movement pitch (pitch
value dissociated in top
and elevated views).

VROBIECT 0 -'""F

or

e Move VR
objects.

Top view:

e Move the target in
red, or the bisector
in gray.

In Elevation:
o Move the target in

red or the shaded
horizontal line.
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VROBJECT D

v

= e Move the Top view:
£

camera.

e Move the gray point
in the blue circle.

A ] In Elevation:
VROBIECT O -

e Adjust the camera

/ » height by moving
the shaded hor-
izontal line that

runs through the
[ = | two gray points.

NB: In these views,
the camera position defines
T the starting image when the

VR objects are read.

&

N/A e Change the o Move one of the
focusing two blue lines.
angle.

VROBJECT O
N/A Angle Opening Indicates the starting posi-
Constraint tion of the angle opening

relative to 0° in a trig-
onometric circle.

e Pivot the blue
radius around the

BH

e Lock posi- red point in the
tio.n of VR center. This
f)bJeCt start- changes the con-

e ing angle. straint value in the
» o e VR Object/Co-

ordinates inspector.
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N/A e Limit VR Enter an angle value of
Object Open{ <360° in the VR Object/Co-
ing Angle ordinates inspector.
Horizontally.
Horiz. Shift  Horiz. Angle Radius
20 120| LE.00 m
Once open, the circle can
% be edited graphically.
Horiz. Shift  Horiz. Angle Radius
63 120 16.00 m
The opening angle value
depends on the Constraint
angle value.
Horiz, Shift  Horiz. Angle Radius
63 240 16.00 m
Same as o Duplicate ® Press ALT and
Alt plane view VR move the camera
Object. target in red..
+
or
e Right click on the
camera then select
"Duplicate" in the
pop-up menu.
VROBIECT O L~
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or

Duphcatbe:

Add o Perspective View List
Adid to Paraliel View List
#dd to Panorama List

Add to Sequence List

Edit Hedodon
Ed Light

Same as plane e Delete VR e Right click on the
view Object. camera then select
"Duplicate" in the
pop-up menu.
Duphcate
| Deete |
Fudd b Perspactive Yisw List
Audd bo Parallel View List
HAudd bo Panorama List
Audd bo Sequence List
Edit Light, ]
Same as plane e [Edit Light e Right click the red
view active with target. In the pop-up
this VR menu, select "Edit
Object. Light", select the

Duphcake

Add to Perspectine Yiew List
Add to Paralls] View List
Add to Panorama List

Add to Sequence List

name of the light.

NB: The inspector pal-
ette switches from VR Object
mode to Lights mode.

Dot

Kudd b Perspactive Wiew List
R b Par el Wiews List

Same as plane
view

e Edit active
Heliodon
with this VR
Object.

e Right click on the tar-|
get in red and select
"Edit Heliodon" in
the pop-up menu.

NB: The inspector pal-
ette switches from VR Object
mode to Heliodons mode.
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Working with Panoramas in 2D View

Wireframe Display Mode

State or Action |

Comments

Node deselected

Indicated by the camera (gray
dot) and the horizontal or vertical
viewpoint movement circle.
Viewpoint active.

Node selected

Represented by the camera (red
point), with the target (blue) mov-
ing in a circle (blue circle), the
focus angle (blue lines) and the
angle's bisector line (red line).

e[

e Move the e Use the red point for this.
viewpoint.

o Move the o Move the blue point in the
target. blue circle.

o

NB: The target point posi-
tion defines the starting image
when the panorama is read.
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e Move the
node in a
parallel
direction.

o Move the red bisecting
line.

o Change the
focusing
angle.

o Move one of the two blue
lines.

Alt

or

Delete ! —_—

Add to Perspective View List
Add to Parallel View List
Add to VR Object List

Add to Sequence List

Edit Heliadon

Make First Node

o Duplicate
the node

or

® Press ALT and move the
camera (red point)

e Right click on the camera
then select "Duplicate" in
the pop-up menu.

C\DUDII(J}:‘ B

Add to Perspective View List
Add to Parallel View List
Add to VR Object List

Add to Sequence List

Edit Heliodon
Edit Light [ 3

Make First Node

o Delete the
node

e Right click on the camera
then select "Delete" in the
pop-up menu.
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Swimminn nan i 2
“i Duplicate
Delete —_—

Add to Perspective View List
Add to Parallel View List
Add 1o VR Object List

Add 1o Sequence List

Edit Heliadon

e Edit Light
active with
this view-
point.

e Right click on the camera
(red point). In the pop-up
menu, choose "Edit Light",
select the name of the light.

NB: The inspector palette

Light_1
— S switches from the Panorama mode
to Light mode.
e [Edit active e Right click on the camera
SRR Heliodon with (red point) then select "Edit
e L this view- Heliodon" in the pop-up
Add to Perspective View List pOint' menu'

Add to Farallel View List
Add to VR Object List
Add to Sequence List

Edit Heliodon [

Make First Node

NB: The inspector palette
switches from Panorama mode to
Heliodons mode.

N
o The selected e Right click on the node of
node becomes the panorama select "Make
\ the first node; First Node". When the node
o - this is the is already the first node a
g:rel::m B first one disabled "Is First Node" is
layed when displayed.
Add 1o Perspective View List pl y. h Py
Add 1o Parallel View List playing the
Add to VR Object List panorama.
Add o Sequence List
Edit Heliodan
. e How to e Click and move around, turn|
\ define a new the red arrow tip to define
\ direction? the new direction of the
\ node, all the direction of the

other nodes will become
affected. Only the first
node is defined with a red
arrow.

o When the panorama is
played, this view is dis-
played by default.
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e How to
create a link
between two
nodes.

e Click in the blue circle
node, hold the mouse button
down and drag the cursor in
the blue circle of the node
to connect. A green arrow
is drawn between the two
nodes.

e How do you
delete a link
between two
nodes?

o To delete a link between
two nodes. Click on the link
to select it, it turns green,
then make a right click on it
and choose Delete.

Working with Camera Animation in 2D View

2D View Window

Path edits are clearly distinguished from keyframe edits.

This concerns the paths for cameras, lights, and objects as well as the relevant pop-up menus.

Editing Paths

Camera path is in red.
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NB: Camera target points can be edited graphically at any time, regardless of whether record mode is on or
not.

Use the Edit Path |\f\| tool in the window bar to select the mode.

® Button raised: |\ﬂ| Keyframe editor is active (As a result, the path is visible but cannot be edited).
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Create Path

e In S mode, move the camera viewpoint.
e This draws a red path in a straight line.

e White dots circled in gray indicate start and end points that have tangents.
e The tangent handles are indicated by red dots circled in black.

Move Path
e Click on the path and move it.

Editing the Path

e Use the handles to graphically edit the tangents.

Add a Control Point

e Right clicking on the red path line and selecting "4dd Control Point" displays a gray circle and a tangent with
two editing handles.
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Add Control Point . gt
Remowve Control Paint

Unlock tangent

Close path

Delete Path

To edit a portion of the tangent at a point

e Right click on the point and select "Unlock Tangent" to create an inflection point on the path.

e

Add Control Paint -—v——;;""c

Remowve Control Point

Unlock tangent

Close path | = ———a

Delete Path ;
T —
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To delete the inflection point

e Right click on the point and select "Lock Tangent".

oE— '
Add Control Point _;——7'!
Remove Control Point ;
Close path I
Delete Path -
T —

Extend Path
Extends the path without touching the existing animation.

e Alt+Click on the last control point created for the path.
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e Creates a new control at the end of the path.

NB: The timeline can be used to play the sequence at any time.

Path Edit Pop-up Menu

e Right clicking on the red path displays a pop-up menu with the following options:

Add Control Paint
Remowve Control Point

Unlock tangent
Close path
Delete Path

Add Control Point: adds an editable point to the path.

Delete Control Point: deletes the point from the path (except the end points).
Close Path: closes the path on itself.

Open Path: re-opens the path.

Delete Path: deletes the path.
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Editing Keyframes

Camera path is in red.

NB 1: You must be in record mode in order to edit in the Timeline.

Keyframe Edit Pop-up Menu:

o Add Keyframe: adds a keyframe.
e Delete Keyframe: deletes a keyframe

Add a keyframe
e In W mode, button is raised (not active).

O

o In the Timeline window, click on record
pop-up menu.

in 2D view, right click the path, select "Add key frame" from the

M A

e

This creates the keyframe.
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The keyframe can be moved graphically on the path, making it possible to speed up, slow down, etc.

NB: A keyframe selected in 2D View appears with a red pin on the Timeline. A pause can be created in the
movement of the element by duplicating a keyframe in the Timeline.

NB 2: When editing or reading a sequence, the Preview window displays the content in OpenGL Navi-
gation mode if "Automatic Switch to OpenGL" has been checked in the preferences.

The 2D View Edit Filters Pop-up Menu:
This displays and/or hides paths in order to improve editing in 2D View.

e Right clicking on the white background of the 2D window displays the following pop-up menu that makes it
easier to edit in 2D View, as well as display and hide paths.

v Show All
Show Only Current Type Elements
Show Only Current Element

o Show All: displays all camera, light and object paths.

e Show only current type elements: Depending on which inspector is active (Animations, Lights or Objects), dis-
plays all camera, light or object paths.

e Show Only Current Element. displays only the path currently being edited.

Viewpoint Edit Pop-up Menu:

Regardless of whether the user is in path or time edit mode, right clicking on a camera's target or one of the blue lines
that represent the focus opening will display a pop-up menu with the following options:

Duplicate
Delere

Add to Perspective View List
Add to Parallel View List
Add e Parsorama List

Add to VR Object List

Edit Heliodon

Edit Light 3

e Duplicate: duplicates the sequence; the current camera position becomes the default view and the path is not
duplicated. Uses the original to create a new superimposed viewpoint.

e Add to: Perspectives View List:
o Add to: Parallel Views list
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e Add to: Panorama list
e Add to: VR Object List

Depending on option selected, adds current view from Perspectives to Parallel Views, Panoramas, or VR Objects.

e Edit Light Activated With This Viewpoint :

Choose a light. The inspector palette switches to Lights mode and the light is selected.
e Edit Heliodon Activated With This Viewpoint:

The inspector palette switches to Heliodons mode and the heliodon is selected.
e Delete: The viewpoint is removed from the list.

Working with Light Animation in 2D View
2D View Window:

Path edits are clearly distinguished from keyframe edits.
This concerns the paths for cameras, lights, and objects as well as the relevant pop-up menus.
Editing Paths

N\

The light path is in yellow.

Use the Edit Path A tool in the window bar to select the mode.

Button pressed: Path editor is active (As a result, editing the keyframe in the view is inactive).
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Button raised: |\ﬁ| Keyframe editor is active (As a result, the path is visible but cannot be edited).

Create Path

In |$|

e This draws a yellow path in a straight line.

mode, move the light source.

e White dots circled in gray indicate start and end points that have tangents.
e The tangent handles are indicated by red dots circled in black.

Move Path

e Click on the path and move it.
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Editing the Path

e Use the handles to graphically edit the tangents.

Add a Control Point

\

Add Control Point |
Remove Control Point

Unlock tangent
Close path
Delete Path

e Right clicking on the yellow path line and selecting "Add Control Point" displays a gray circle and a tangent

with two editing handles.
e aYa|

Result.

Page - 65



Chapter 5

To edit a portion of the tangent at a point:

]

',,-/( Add Control Paint

o | Remove Control Point II

Unlock tangent .

Close path

Delete Path
T

e Right click on the point or on an "Unlock Tangent" item handle to create an inflection point in the path.

:
| I

Result.

To delete the inflection point

../’{ Add Control Point

= Remove Control Point Jl—

Lock tangent .

Close path

Delete Path

e Select "Lock Tangent".
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Result.

Extend Path

Extends the path without touching the existing animation.

e Al+Click on the last control point created for the path.

NB: The timeline can be used to play the sequence at any time.
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Path Edit Pop-up Menu

e Right clicking on the yellow path displays a pop-up menu with the following options:

Add Control Point

Close path

Delete Path

e Add Control Point: adds an editable point to the path.

e Delete Control Point: deletes the point from the path (except the end points).
e Close Path: closes the path on itself.

e Open Path: re-opens the path.

e Delete Path: deletes the path.

e Right clicking on a control point or tangent handle displays a pop-up menu with the following options:

Remaowe Control Point

Lock tangent

m  Lock Tangent: to delete an inflection point.

m  Unlock Tangent: to create an inflection point. This makes it possible to create an inflection point to
manipulate sections of the tangents independently.

Editing Keyframes

NB 1: You must be in record mode in order to edit in the Timeline.

Keyframe Edit Pop-up Menu:

o Add Keyframe: adds a keyframe.
o Delete Keyframe: deletes a keyframe.

Adding a key image

3t

e In mode, button is raised (not active).

e In the Timeline window, click on record o in 2D view, right click the path, select "Add key frame" from
the pop-up menu.
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This creates the keyframe.

The keyframe can be moved graphically on the path, making it possible to speed up, slow down, etc.

NB: A keyframe selected in 2D View appears with a red pin on the Timeline. 4 pause can be created in the
movement of the element by duplicating a keyframe in the Timeline.

NB 2: When editing or reading a sequence, the Preview window displays the content in OpenGL Navi-
gation mode if "Automatic Switch to OpenGL" has been checked in the preferences.

Keyframe Edit Pop-up Menu:

This displays and/or hides paths in order to improve editing in 2D View.

e Right clicking on the white background of the 2D window displays the following pop-up menu that makes it
easier to edit in 2D View, as well as display and hide paths.

v Show All

Show Only Current Type Elements
Show Only Current Element

o Show All: displays all camera, light and object paths.

e Show Only Current Type Elements: Depending on which inspector is active (Animations, Lights or Objects),
displays all camera, light or object paths.

e Show Only Current Element. displays only the path currently being edited.

Working with Object Animations in 2D View
2D View Window

Path edits are clearly distinguished from keyframe edits.

This concerns the paths for cameras, lights, and objects as well as the relevant pop-up menus.
Editing Paths
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Object path is in green.

e Use the Edit Path |\ﬁ| tool in the window bar to select the mode.
® Button pressed: |\n| Path editor is active (As a result, editing the keyframe in the view is inactive).

® Button raised: N\l Keyframe editor is active (As a result, the path is visible but cannot be edited).

Page - 70



Artlantis Interface - The 2D View Window

Create Path

In v mode, move the object.

e White dots circled in gray indicate start and end points that have tangents.
e The tangent handles are indicated by red dots circled in black.

This draws a green path in a straight line.

Move Path

e Click on the path and move it.

Editing the Path

e Use the handles to graphically edit the tangents.

Add a Control Point

Add Control Point

Rem Control Point

Unlock tangent

Close path |

Delete Path |
T ————
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e Right clicking on the green path line and selecting "Add Control Point" displays a gray circle and a tangent with

two editing handles.

|

Result.

To edit a portion of the tangent at a point:

Add Control Point

Remove Control Point |

Unlock tangent [ |
—

Close path | B ~
Delete Path
——

e Right click on the point or on an "Unlock Tangent" item handle to create an inflection point in the path.

Result.

Page - 72



Artlantis Interface - The 2D View Window

To delete the inflection point:

—

Lock tangent

Add Control Point

Remove Control Point |

Close path

Delete Path

I

e Select "Lock Tangent".

N

Result.

Extend Path

L

Extends the path without touching the existing animation.

e Alr+Click on the last control point created for the path.
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Result.

NB: The timeline can be used to play the sequence at any time.

Path Edit Pop-up Menu

e Right clicking on the green path displays a pop-up menu with the following options:
m  Add Control Point. adds an editable point to the path.
m  Delete Control Point: deletes the point from the path (except the end points).
m  Close Path: closes the path on itself.
m  Open Path: re-opens the path.
m  Delete Path: deletes the path.

Add Contrel Point

Close path

Delete Path

e Right clicking on a tangent handle or control point displays a pop-up menu with the following options:
m  Lock Tangent: to delete an inflection point.

Remowe Control Point

Lock tangent

or
m  Unlock Tangent: to create an inflection point.

After unlocking the tangent, you can create an inflection point to work independently with half tangents.
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Editing Keyframes

Object path is in green.

NB 1: You must be in record mode in order to edit in the Timeline.

Keyframe Edit Pop-up Menu:
Right clicking on the green path displays a pop-up menu with the following options:

m  Add Keyframe: adds a keyframe.
m Delete Keyframe: deletes a keyframe.

Add a keyframe

Add Key Frame

Kay

e In W mode, button is raised (not active).
e In the Timeline window, click on record o
pop-up menu.

This creates the keyframe.

in 2D view, right click the path, select "Add key frame" from the
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The keyframe can be moved graphically on the path, making it possible to speed up, slow down, etc.

NB: A keyframe selected in 2D View appears with a red pin on the Timeline. 4 pause can be created in the
movement of the element by duplicating a keyframe in the Timeline.

NB 2: When editing or reading a sequence, the Preview window displays the content in OpenGL Navi-
gation mode if "Automatic Switch to OpenGL" has been checked in the preferences.

The 2D View Edit Filters Pop-up Menu:

e Right clicking on the white background of the 2D window displays the following pop-up menu that makes it
easier to edit in 2D View, as well as display and hide paths.

v Show All
Show Only Current Type Elements
Show Only Current Element

o Show All: displays all camera, light and object paths.

e Show Only Current Type Elements: Depending on which inspector is active (Animations, Lights or Objects),
displays all camera, light or object paths.

e Show Only Current Element: displays only the path currently being edited.

Editing the Clipping Box

This is a blue box with corner handles that can be edited.

™ Show ™ acvivare g

e Activation and display in Viewpoint inspectors: Perspectives, Parallel Views, Panoramas, VR Objects and
Animations.

e Entering an angle value in degrees in the numeric field pivots the box within the plane.

In 2D View

Change the view (above, front, right, left or back) to define more than one clipping plane in the space (up to a max-
imum of six clipping planes).

anf 30 Vi
.2 & B8 r:H
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e Edit the blue handles to define the clipping planes.

Elements outside the blue box are excluded from the scene.
When viewing from above, the rotation angle can also be defined graphically in 2D View.

NB: When elements are clipped, the shadows projected are adapted.

Preview Representation
Example of a clipping box in Perspective view.

ann P Sapesrmarhd Firalkid (=}

FCREAE - O o - &

Inactive Clipping Box

LT P S Finid iid (=}

v oa waw [ e »

Active Clipping Box

The Preview Window

The main working window. It displays the final rendering in real time before any calculation is initiated!
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‘@06 7% Island_Final-2.atl § =M
® [Ka@Eo B B & &3 =

Last rendering time: 3.50sec.

Both the toolbar commands (Navigation, Zoom, Pan and Front View) and the Keyboard and Mouse Shortcuts spe-
cific to the Preview window are used to navigate within a scene.

Preview Display and Navigation Tools

Customizing the Preview Toolbar

Redimensioning the size of the Preview Window

e Move the lower right corner. The size of the displayed content is not affected (Preview preferences, or key-
board and mouse shortcuts).

Preview Display and Navigation Tools

=

¥ Activates and deactivates display in OpenGL mode. Useful for navigating within large databases.

NB: Shadows and lighting effects in OpenGL depend on the Preference settings.

S

~ Back: Resets the camera to the position defined when the view was activated.

——Zoom: Moves the camera (the zone in question is defined by a rectangle). The Alt+Zoom option moves the cam-
era backwards.

Z
4

| Lj Update: Saves the viewpoint position (viewpoint, target, focus distance and camera roll). This tool only works
when the Automatic Update option is not activated in the General Preferences.

Pan: Pans the scene by moving the active camera.

Pan To: Positions the camera perpendicular to the surface clicked.

E Displays the 2D View window.

e Catalog: provides access to Catalogs and Media (Shaders, Objects, Images and Postcards).

@ Refine Preview: Radiosity display becomes close to end result.

ﬂ Render: Opens the dialog box for preparing and launching rendering.

Partial Render: Within the scene, this initiates rendering of the zone bounded by the rectangle.
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==l Create Postcard: saves current viewpoint as a Postcard.
| L Plantes 30 B

" Current layer: destination of an object when dragging and dropping an object in
the scene.

e If Auto is checked:

Drag and drop an object in the scene, this object will go into the layer appropriate to its type or into the active
layer if there is no default destination layer for this object type.

e If Auto is unchecked:

The popup menu for the layer shows the destination layer for an object during a drag-and-drop in the scene,
as long as there is no default destination layer for this object type.

e =) S .
{L, Navigation in viewpoints.

Customizing the Toolbar

SpaceNavigator Peripheral Compatibility:
o Ergonomics: hardware compatibility with SpaceNavigator from 3D Connexion, a 3D navigation tool.

Lets you navigate through the scene and edit items in the scene using the mouse.

Customizing the Preview Toolbar

e Right clicking on the bar displays the following:

Drag your favorite items into the toolbar...
o) | Sequence e L7 I-§ 8 t.| i 4
Navigation Change View Back Zoorm Pan PanTo Update Show 2D View Render Render Zone
12 .Ai.‘-.' - ;_‘ip =
e o |
Catalog  Customize Flexible Space Space Separater Create Posteard Refine Preview
™ Radicgity = Plantes 3D . ‘B ™ aute
Activate Radiosity Current Layer
... or drag the default set into the toolbar.
& ] 2R 0 |_| b | = Plantes 30 & aurn :‘ &
Navigaticn Back Zoom Pan PanTo Update Show 2D View Catalog Current Layer Refine Preview Render
Show | lcon Only B‘ ™ Use Small Size i Dane *

To add a tool, drag and drop it onto the bar. To delete a tool, drag it outside of the bar.

ﬁ/(

S
Access toolbar customization settings.

The Timeline Window

Introduction: __J

Animation work is done using the Animations, Lights, Heliodons or Objects and the 2D View, Preview window
and the Timeline window.

The timeline enables the user to record, edit and play a scene. The scene is made up of sequences that are managed in
the Animations Inspector list.
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806 Sequence
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=l El= 1 P e W W O Cuarrent Time: Duration Frame:  FPS  Loop
— o > ) @ 00-00:17 Sequence:  00:02:00 17 25 []

Display

Activating the Animations inspector displays the Timeline window.
If the Timeline window closes again, click on the Animations inspector icon or go to Windows > Timeline.

Animating

Artlantis animates practically all commands relating to the inspectors:

e Cameras (animations)

e Lights
e Heliodons

e Objects

e Animated Textures

Begin as follows to animate the parameters for cameras, lights, heliodons, objects and animated textures:

1. Activate the Animations Inspector, then
2. Activate the Light, Heliodons, Object or Shaders inspector

Comment: The Timeline window will remain open to enable you to edit animation times.

NB: In 2D View, the Timeline and the appropriate inspector must remain open in order to create
and edit animated paths for lights, objects or cameras.

The Timeline window is divided into the following four areas:

e0e -1
el
i S v (2) eauerce b
L 2 X g3) y — RIS
4l (]
F i
(ull A0 _\_\! Temps courant Durée: | Bowtle
e—— Q (ae) ,;\l (o) | - "?' 0004118 | | Stauence oa.uﬁ:é-} o

Title Bar: Shows the name of the current sequence.

2. Time scale : Gives duration of the scene with a slide bar and cursor for positioning and editing keys and
sequences.

3. Recorder : Controls recording and playback of animations.
Sequence Duration Control: Used for editing the duration and rate of images.

Title Bar

KsXeks! Castel exterior
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Name of the current sequence, as defined in the animations list. The timeline updates relative to
the current sequence (blue band). The other sequences in the scene (gray bands).

Time scale
AT o . . | | ! | vt
T T T T i T T T T T T
A A A Position de I'objet b
o B
———— b 5
WOd A0r
'—e—

The slide bar is the time scale that shows the total time in the scene. The time runs from left to
right.

The cursor shows the current scene time at instant T.

NB: The current position also displays in 2D View, if the element is animated on a path.
Click and drag to move the cursor. The cursor is blue. When a keyframe passes, it sticks to the
pin and becomes red.
The cursor moves away from it when:
* The time is edited
* The current sequence is played.
* The mouse wheel can be used to zoom on the scene when rolling over the time scale.

({nl] A0
e .
Time scale zoom cursor: Enables the user to show the entire scene or focus on
just a portion of it.

|

Current sequence: The sequence is delimited by its start andend ™ pins.

. The start, end or duration of the sequence can be modified by clicking and dragging the pins
to change them individually.

. The entire sequence can be moved without changing the duration by clicking and dragging it
on the blue line.

00:01:08
——

A tooltip with a yellow background indicates
the current position in min: sec: on the Time-
line.

NB: The keyframes and guides do not follow the movement. Subsequently, the
numeric Time and Duration fields are updated.

The top of the time scale indicates the events that relate to an animated element.

The bottom of the time scale shows the events relating to one of the values for the animated ele-
ment in question.

Selecting keys of an animated element.
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g
Heliodon | ]
Light 02

. Right clicking above the slide bar: displays the keys of an animated element, and selects
one of the elements.

Consequences:

" All animated keys corresponding to the element in question display on the slide bar.

L] The inspector corresponding to the element becomes the current inspector, enabling
the user to edit its parameters rapidly.

NB: The user can also access the animated element by clicking on the triangle
located in the upper right-hand section of the window (above the slide bar).

Car. Gm

—a
Object Position b

Selecting keys of the current animated element.

Light 02 »
| |
] 1

S

Light Position
Light LensFlare Values e
Light OnjOff

. Right clicking below the slide bar: Displays the animated settings for the current element.
The sub-keys matching the setting appear below the slide bar.
Result:
All sub-keys corresponding to the parameter for the element in question appear on the slide
bar.

NB: The user can also access the animated parameter by clicking on the triangle
located in the lower right-hand section of the window (below the slide bar).

Car_01_1 p
|

Object ?csiw

=
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NB: In order to select the parameter for an animated element, you must first
select the element and then select the parameter.

Recorder

QICICICIONO)

. This enables the user to navigate in time through the scene, and to play or stop playback of
the sequence. The cursor moves as a result.

. Description of buttons from left to right:
= Go to start of sequence
u Go to previous image

L] Play or stop sequence

] Go to next image
= Go to end of sequence
L] Record animations: starts o or stops ® the recording.

NB: Sequence playback can be started or stopped by pressing the space
bar.

Sequence Duration Control

Current Tima: Daration Frama: FPS: ™ Loos
00:03:18 Sequence: | 00:10:00 | | 79 | [28 3
Curra e
. 00:03:18 . . ' .. .
Current time of the scene: | indicates the cursor's current position in

the time scale. Expressed in: minutes: seconds: image number. Entering a value
updates the position of the cursor. Dragging the cursor updates the scene time
again.

Deararsos.

Sequence: | 00-10:00 |

Duration of the currentsequence: . indicates the duration of
the sequence between the start and end pins. Expressed in: minutes: seconds: image
number. Entering a value updates the position of the end pin. Dragging the pins
updates the sequence duration.

Frame:

73 . .
Current sequence image: displays the number of the current image. Enter-

ing a value positions the cursor on the time line.

FFS

FPS: (frames per second), rate at which images are played per second
Entering a value updates the number of frames played.

# Looa

Loop: Indicates that the sequence will be repeated == Type in a value to spec-

ify the number of loops. The loop will be applied only to the current parameter of
the current animated element.
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v yv T %
s A A
Keyframes: oo appear as colored guides distributed throughout

the time scale.

A pin represents a particular animation event at an instant T. A camera, light, hel-
iodon or object element for which one of the position, rotation, scale, etc. param-
eters has been modified.

Animation is interpreted between two keys.

Guides: == serve as visual markers for synchronizing animated parameters.

° Animations: Makes a sequence or edit of animated elements the current
one, whereupon the appropriate inspector displays.

. Shortcut: Right click above the time scale.

. Modlfication indicator: Shows the type of animation attached to the current
element (position, rotation, lighting power, atmosphere, etc.). Updates depend-
ing on which item is selected in the Animations pop-up.

Shortcut: Right click below the time scale.

Keyframes and Guides

Keyframes

A keyframe indicates a particular event at an instant T in the scene. Keyframes are linked to the following animated
elements: cameras, lights, heliodons, objects and animated textures.

Current animated elements at an instant T: Cameras, lights, heliodons, objects and animated tex-
tures.

Animated setting for current element:

Camera: position, rotation, focal, etc.

Light: position, state, type, power, color, etc.
Heliodon: date, time, etc.

Object: position, rotation, scale, etc.

Animated texture: plays the avi or mov sequence.

Animation is interpreted between two keys.

How Keys are Represented

SR
_d

i
b-|

General Information:

e Upper pin indicates a key relative to the current animated element.
e Lower pin indicates that an animated setting of the element is current.

Pin Description
e | An animated element with edit setting activated (in key). Keyframe not selected (gray).
[ |
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An animated element with edit setting deactivated (no sub-key). Keyframe not selected (gray).

1~

An animated element with edit setting(s) activated. Keyframe selected (red).

-

An animated element with edit setting deactivated (no sub-key). Keyframe selected (red).

|

An animated element. Synchronized editing of animated settings for the element in question. Represents
overlap of at least two keyframes.

More than one synchronized animated element. Move the yellow pin and the superimposed keys follow.
Keyframes selected (red).

bl -1

m  Moving the cursor over a synchronized key (yellow pin) displays the name of the current element,
the position in time and the parameters associated with the element.

More than one synchronized animated element. Move the yellow triangle and the superimposed keys follow.
Non-selected keyframes.

1

m  Moving the cursor over a synchronized key (yellow pin) displays the name of the current element,
the position in time and the parameters associated with the element.

More than one animated elements are synchronized. The elements are not standard. Moving the yellow pin
with the arrow moves all superimposed keyframes. Non-selected keyframes.

-

m  Moving cursor over synchronized keys: Displays the information concerning them
m  Moving the cursor over a synchronized key (yellow pin) displays the name of the current element,
the position in time and the parameters associated with the element.

00:12:07: Lumiére ILSequencg_,_Lumiére 1_1, Bench_01_1

| & |

1 T © T
| %

Selecting keys of an animated element.

Car_01_1 |
Sequence_l L 1p :

—_— Lurmigre 1 |
Lurnigre 1_1 E » |

e Right clicking above the slide bar: Enables you to select an animated element.
e Consequences:
»  All animated keys corresponding to the element in question are displayed on the slide bar.

= The inspector in question becomes the current inspector, enabling the user to edit its parameters rapidly.

NB: The user can also access the animated element by clicking on the triangle located in the upper
right-hand section of the window (above the slide bar).

Bench_ a
..

Position de 'objet p
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Selecting keys of the current animated element.

Light Position
Light LensFlare Values e
Light On/Off =

e Right clicking below the slide bar: Displays the animated settings for the current element. The sub-keys match-
ing the setting appear below the slide bar.

e Consequences:

m  All sub-keys corresponding to the parameter for the element in question appear on the slide bar.

NB: The user can also access the animated parameter by clicking on the triangle located in the lower
right-hand section of the window (below the slide bar).

NB: In order to select the parameter for an animated element, you must first select the element and
then select the parameter.

Creating keys

Three options:

1. Upon creating a trajectory in 2D View: two keys are created in the Timeline window - one at the start and
one at the end of the sequence.

2. With record mode turned on in Timeline, right click on the path for the "4dd Keyfiame" pop-up menu (valid
only for one path).

3. In the Timeline window with record mode turned on, edit a parameter of the current element.

NB: When an element is no longer animated, turning on record mode will create two key images.
The one located at the start of the sequence assumes the parameter value before the modification. The sec-
ond one located in current time assumes the post-modification parameter value.

If the parameter of an element already has keyframes, the record mode creates a single keyframe. This key-
frame is located in the current time and has the post-modification parameter value.

NB: Turning on record mode in the Timeline window forces the 2D View to appear when editing key-
frames.

Cursor pop-up menu:

Right click on the cursor (blue or red bullet icon).
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1. Add Keyframe:

m  Position the cursor on the Timeline.

b- |~
b- |~

@

7 ¥
B dd Key Frame [ |
— -
=== addGuide
fa F we Gu

= Right click on the cursor to choose Add Keyframe.

—

LT
"A

¥
A

¥

Result: The keyframe is added.

2. Delete a Keyframe

L T
A KLy

= Add Guide

A0

= Right click on the keyframe and choose Delete Keyfirame.
Keyboard Shortcuts
1. Move a Keyframe:
m  Click and drag the pin.

2. Duplicate a Keyframe:

»  Alt+Click and drag the pin. (Both keyframes have the same value. Hence, they can freeze a parameter
at a given time.)

3. Moving a set of keyframes for an element (either the camera, lights, heliodon or objects):
»  Shift+Click/Dragging the pin results in: all pins to the right of the click moving in a proportional time.

Guides:

These serve as visual Timeline tags ——(blue vertical line).

Enables the user to synchronize more than one animated element (e.g.: moving a camera must match the same instant
T as opening a door) or to synchronize animated settings tied to the same element.

Page - 87



Chapter 5 hd

o Creating a Guide: Double clicking in the Timeline (not on the slide bar) causes a vertical blue line to appear .
e Deleting a Guide: Double clicking on the vertical blue line makes it disappear.
e Moving a Guide: Drag and drop.

NB: Moving the cursor on the slide bar near a blue guide magnetizes the cursor. This makes it easier to syn-
chronize parameters among several animated elements.

1. Add Guide at the cursor
= Position the cursor on the Timeline.

e Right click on the cursor and choose the Add Guide item. Double clic in the Timeline near the cursor
will also add the guide for the cursor position.

The guide is created.

2. Deleting a guide at the cursor

e Right click on the cursor and choose the Add Guide item. Y ou can also double click the guide.
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The Perspectives Inspector

Manages viewpoints defined by a camera, a target and a focal length. Each viewpoint is considered to be an inde-
pendent document with its own parameters which can receive its own environment:

In this chapter you will learn about the following subjects:

The Perspectives List . . .. ... 90
Foreground Images. . ... .. il 91
Background Images. . . ... .. 92

=

Viewpoints List: for handling viewpoints displayed on the list.

Focal in es
- O €
] Depth of field ™
Or
(] Show [ Activate g d
Lighting
| Heliodon_3 b5
| l.um-iu:_h!on:Lumuir:_{uisine_--v1
None v
Visible layers
| ScénePlantes 3D,Dbj:cls!um®
Environment
Background Foreground
< el
[ 20 image 2]
Coordinates
® ¥ z
8 13.35m 14.31m 8.14m
Target on: [ Fixed Vertex +
08sm || -S.l4m | 493m
rmera Roll:
(6]
o

1. Camera: settings, check elements to activate.
e Focal Length: by using the cursor or entering a value (Change the camera angle). The units depends on
the preferences settings.
e Depth of Field: click ' * | then, in the Preview window, click to define the clear point of the scene,
with the rest remaining blurred. The cursor adjusts the blur amount.
e Clipping Box: for defining clipping planes.
o Show:In 2D View
e Activate: Preview Representation
2. Lighting: To handle light schemes linked to the view, select them from the drop-down
menus.

e Heliodon: links a heliodon to the view. Selecting "None" deactivates the heliodon.
e Light Group: links one or more light groups to the view. Selecting "None" deactivates the light groups.
e Neon Shaders: Links one or more Neon Shaders to the view. Selecting "None" deactivates the lighting.
3. Visible layers: check them in the drop-down menu.
4. Environment: handles the background and foreground of the scene.
o Defining a background: Background type: 3D Sky, Gradient, 2D Image, 3D Image, 3D Cubic

o Foreground Images
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o Site insertion tool automatically sets the camera with a background image.

Clicking g opens the dialog.
5. Coordinates:
e Camera XYZ Position.

e Target XYZ Position. Clicking on * " locks them and clicking on - unlocks them.

e Itis possible to limit a camera's target to an object's movement: In Object mode, right click on and
object and select "Define As Target" in the drop-down menu. Then, in Perspectives mode select the
name of the object in question in the Target on menu.

e Camera Roll: Pivots camera laterally. Turn the circular cursor or enter a value in degrees in the related
field.

6. Post-production

e Applies effects to the current viewpoint: The effects combine with and between the parameters set in

the inspector.
7. Rendering Parameters

e Prepares the document for final rendering.

NB: editing the scene information such as the infinite ground, movement of the origin, redimensioning of
the model and the coordinates may be accessed via the Window menu.

The Perspectives List
[

opens the viewpoint list. Each is displayed by name and preview thumbnail. To edit, double-click on the name.

(T

Pers 1

is

l@ deletes it.

adds a viewpoint

List drop-down menu

e Right-clicking on a view displays the pop-up menu:

Duplicate
Delete

Mdd to Parallel View List
add to Pandrama List
Mdd to VR Object List
Add 1o Sequence List

Edit Heliodon

Edit Light k

Page - 90



The Perspectives Inspector - The Perspectives List N

Duplicate: Uses the original to create a new superimposed viewpoint.
Delete: The viewpoint is removed from the list.

Add to Parallel Views List:

Add to Panorama list:

Add to VRObject List

Add to Animation list
Depending on option selected, adds current view from Perspectives to Parallel Views, Panoramas, VR
Objects or Animations.

Edit Heliodon: The palette inspector switches to Heliodon mode and the heliodon is selected.
Edit light: select a light, the inspector palette switches to Lights mode and the light is selected.

Foreground Images
Defining a Foreground

Foreground

. b L. A double click opens the search dialog for image files.

Loading Foreground Images

. By dragging and dropping into the inspector's Foreground image area.
. Using the Foreground image dialog: double click in the image zone.

NB: The foreground image must have an alpha channel (representing the opacity or transparency of
the image), for example, to view the scene through vegetation.

The file formats accepted are Photoshop, TGA, TIFF and PICT.
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Background Images

In the local Viewpoints menu:

Haliode= Sy + White

Gradigr Cradient

20 image 20 image

. 0 Image
30 Cisbic 30 Cubsc
or
Background Description
type
Background 3D Sky:
In the Viewpoints inspector, the current view is associated with a configurable 3D Sky:
day/night, type of clouds and cloud density.
Heliodon Sioy 18
This is assuming that the clouds have been associated with the heliodon.
¥ Clouds and the heliodon in question has been associated to the current Viewpoint.
NB: If the viewpoint doesn't have an associated heliodon then the sky is white.
=Eackarond Graduated:
1 Three colors that mix linearly. By default, one top color, one middle color and one bottom
color, with one graduating horizontally towards the other.
Gradient =
Background

2D Image:

Adjusts to the size of the Preview while maintaining its ratio (width x height). Use this option

i
Dimge ) to make an insertion in the site. To move the background image, Ctrl-click on the
thumbnail and drag the cursor.
Resetting the image position: double-click right on the thumbnail.
Background 3D Image:
Creating a 3D environment from an image. To move the 3D background, Ctrl-click on the
“ thumbnail and drag the cursor.
30 Image )
Resetting the image position: double-click right on the thumbnail.
NB: Check the left-right continuity of the image being used.
SR 3D Cubic:

Creates a 3D environment from a .mov file comprised of six surfaces of equal size. To move
the 3D background, Ctrl-click on the thumbnail and drag the cursor.

Resetting the image position: double-click right on the thumbnail.

NB: Check the left-right continuity of the image being used.

Loading a Background Image:

Background

e By dragging and dropping into the inspector's e area

Background

e By using the background image dialog: double-click in the background image area

Page - 92




The Perspectives Inspector - The Perspectives List N

Deleting a Background Image

e Click within the background image and then use the DEL key on your keyboard. A dialog will appear asking
you to confirm the deletion.

a Do you really want to delete this image?

=y

NB: the file formats supported are: Photoshop, TGA, TIFF, PICT, BMP and JPEG.
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The Parallel Views Inspector

Manages viewpoints defined by a viewpoint, a target and a display width. Each viewpoint is considered to be an inde-
pendent document with its own parameters which can receive its own environment:

In this chapter you will learn about the following subjects:

The Parallel Views List . e 96

=

Parallel Views List: for handling parallel views on the list shown.

Parallel view @ £r B
i - @
Model Width: | 32.75 m

W Show ™ Activare [0 =
Lighting
(Fms 3]
[ Limitre_Cuisine ﬂ
& [Hone =l
Visitile layers
[ Scéne:Pantes i‘n.ﬂl‘:urcts lu
Environment
Background Foreground
@ P =
[ Cradiem 7]

Coordinates
x Y z

5 Gim | -16.2Zm | 10.43m
A5 m 1622 m 0.00 m

1. Parallel views:

®

e Type of projection : Click on Elevation, Top, or Axonometry.

e Camera Roll: Pivots camera laterally. Turn the circular cursor or enter a value in degrees in the related
field (available only in Top View).

e Scene width: defines the width of the selected view (current unit).

NB: value modification depends of the ViewPoint Update Mode settings in Preferences.

e Clipping Box: for defining clipping planes.
e Show: in the 2D View
e Activate: Preview Representation.
2. Lighting: To handle light schemes linked to the view, select them from the drop-down
menus.

e Heliodon: links a heliodon to the view. Selecting "None" deactivates the heliodon.
Light Groups: Links one or more light groups to the view. Selecting "None" deactivates the light
groups.
e Neon Shaders: Links one or more Neon Shaders to the view. Selecting "None" deactivates the lighting.
3. Visible layers: check them in the drop-down menu.
4. Environment: handles the background and foreground of the scene.
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o Defining a background: Background type: 3D Sky, Gradient, 2D Image, 3D Image, 3D Cubic
e Foreground Images.
5. Coordinates:
e Camera XYZ Position.
e Target XYZ Position.
6. Post-Production:

e Applies effects to the current viewpoint: The effects combine with and between the parameters set in
the inspector.

7. Parallel View Rendering Parameters:

e Prepares the document for final rendering.

NB: editing the scene information such as the infinite ground, movement of the origin, redimensioning of
the model and the coordinates may be accessed via the Window menu.

The Parallel Views List
=

opens the viewpoint list. Each is displayed by name and preview thumbnail. To edit, double-click on the name.
o e

Elévation

Plan masse

Axonométrie

e — adds aviewpoint.

2

o — (eletes it.

List drop-down menu

e Right-clicking on a view displays the pop-up menu:

Duplicate
Delere

Add 1o Perspective View List
Add to Panorama List
Add 1o VR Object List
Add to Sequence List

Edit Heliodon

Edit Light ]

e Duplicate: from the original, creates a new superimposed viewpoint.
e Delete: The viewpoint is removed from the list.
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e Add to Perspectives list
e Add to Panoramas List
e Addto VR Object List
e Add to Animation list
Depending on the option selected, adds current Parallel view to Perspectives, Panoramas, VR Objects
or Animations.
e Edit Heliodon Activated With This Parallel View:
The inspector palette switches to Heliodons mode and the heliodon is selected.
e FEdit Light Activated With This Parallel View:
Choose a light.The inspector palette switches to Lights mode and the light is selected.
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The Media Catalog

A media enables the project to be dressed by dragging and dropping the thumbnail view onto a scene medium (mate-

rial, object or background from the Preview window).

In this chapter you will learn about the following subjects:

Catalog Manager. ... .. ..ol
Dressing the Scene with Media. ... ... ... ...
Posteards. . ..ol

Four types of Media: Shaders, Objects, Images and Postcards divided into two categories.

____________ 100

The Media Catalog window is divided into three areas: Favorites, Thumbnails and Preview.

8686
e '_ - .
‘ 4
i | ——
¥ Objects
» 20 Blbards 1 eucnurcwlmwcwfm: amsim
Basic Geomen 1
Details i
g
- Furnitures |
objets
» Transportation M [ . H
b shaders
|+ = e —a—

SEALJIG  Sky Rjpg Sky R10.jpg Sky R11JPG

1. Favorites:

= Lists the catalogs, edits catalogs.
2. Thumbnails:

= Displays Media thumbnails and adjusts their size.
3. Media Preview

= Drags and drops Media or Postcard elements to the scene.

NB: Additional samples of Media catalogs are available from Artlantis on DVD or free for download from

our site at www.artlantis.com
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Catalog Manager

Favorites area

&
¥ Medias
B Images
= Objects
wShaders
a Surface
Bricks
Moguette
Enduit
Craviers
Pelouse
Pargquet
Pavage
- Textures procédurales
Toiture
Muirs
Bois
Postcards

+ | =

Navigating Media Types
Used to go from one Media folder to another:

e Click on the catalog to be displayed in the favorites area. The Catalog structure is the one on the hard drive.

Adding a Catalog

Opens the dialog for locating folders.

e Selecting the Media folder to be added.
Updating Catalogs

8o08e

wMedias
P images
b Objects
Postcards

Reload Favorites
S —————

==
Updates the content of a catalog folder whose content has been changed.

e Right click in the favorites area and select "Reload Favorites".

Removing a Catalog

e || Deletes the selected catalog from the favorites area.

NB: Deleting a folder does not erase it from the hard drive. It is available only at the first level of the hier-
archy folders.
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Filtering Catalog Media Display

Shiva' Shaders
Show Obgects
Shiw Images
Shiww Mavids
Shore Posicards

ok 4 AN

| | Update Cache

e Click on the local menu of the Display button.
e Select the desired option so that the media type you have selected will not be displayed.

Editing the Size of Catalog Thumbnails

e @ @ [Z] Change the cursor to display or reduce the size of the thumbnails.

Dressing the Scene with Media

Dragging and Dropping a Media from the Catalog to the Preview Window

In the Media view area, select the desired media and then drag and drop it into the scene over a material, object or
background (for only one image). The element that is ready to receive the Media is highlighted when the cursor
moves over it.

In this example, we are applying a shader to the wall:

808 @ Island_Final-4.atl (=]
® 2azao B B @&

Last rendering time: 3.75s¢c.

LY S ifand_Final-4.at -
® #az20 [ B & E © =)

Last rendering time: 3.7550¢.

- [ ——
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‘80806 < Island final-4.at =N
& Pazd o T & W la =

Last rendering time: 4.091c.

Result

Postcards

Collecting and Organizing Postcards. Collecting a Postcard is equivalent to taking a snapshot of the contents of the
current scene at any time, storing all parameters assigned to the materials: Colors, Shaders and textures. The idea is to
facilitate recovery of its settings and, if necessary, to be able to quickly send the information it contains to any other
user, or from one project to another.

Saving a Postcard

Saves the current view as a Postcard.
Tools Menu > Create a Postcard, a dialog box enables the user to name and specify the location where it is saved.

e Clicking on Save stores the Postcard. There is an unlimited number of saves.

NB: Postcards are saved to jpeg format either in a Postcards folder or another folder that you will have to
catalog.

NB: Although the Postcard is in jpeg format, editing it with an image touch-up program will cause it to lose
Shader and texture-specific information and makes it unusable in Artlantis.

From the Favorites area, navigate to a catalog containing Postcards and select the Postcard in the thumbnail area.

Using a Postcard

In the Catalog Preview area, simply drag and drop Postcard elements to an element displayed in the Preview win-
dow.

Sending a Postcard

To send Postcards, find the folder on your hard drive where the Postcards are saved.

e Find the Postcard on the hard drive and send it to another computer.To catalog the Postcard, use the Favorites

area in the Catalog window.

On a Mac platform, by default Postcards are saved in the Postcards directory in the Media directory placed next to the
application.

Deleting a Postcard

Locate the Postcard saved on the hard drive and delete it.
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Using Postcards

Select the Postcard. Drag and drop the attributes of a material (color, Shader, texture) to the receiving material in the
Preview window .

1. Starting scene

CXGX:] 5 lsland Final-d.au =)

® Pazao] O B @& @__Q j

Last rendering time. 3.68sec

2. Drag and drop

e0e 5 tstand. Final-4.a1 =

® @Pazao B B B EH B

ECOLEMUSAR.  ECOLEMLSIQU
| m—

| [y ——
3. Result
®06 < lsland Final-4.at - =N

® Pazao 0 B @B @& @ =&

NB: Textures associated with a Shader are maintained and go with the assignment.

When a Postcard includes textures associated with a Shader, once it has been dragged and dropped to a material in the
scene, these textures will also be applied.
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The Shaders Inspector

Shaders

The following different types of shader are available: Basic Shader, Expert Shader,Realistic Glazing
Shader,Luminous Glazing Shader,Neon Light Shader,Realistic Water Shader,Texture, Diffuse Fresnel
Shader and Transparent Fresnel Shader

Procedural shaders (formerly Artlantis 4.5 Shaders)

Shaders: Procedural, Mirror, Transparent, Marble, Lines

NB: Shaders can be found in the Media Catalog. Different types of Shaders may have different Shader inter-
face palettes.

NB: Editing the scene information such as the infinite ground, movement of the origin, redimensioning of
the model and the coordinates may be accessed via the Window menu.

In this chapter you will learn about the following subjects:

Creating a Shader. . ... 105
Materials LiSt . . e 108

List Organization. . . ... ... e 109
Realistic Water Shader. ... ... 110
The Neon Light Shader. . ... 111
The Basic Shader. . .. 112
Expert Shader. .. ... e 113
Diffuse Fresnel Shader. . . ... .. 114
Transparent Fresnel Shader. .. ... i 115
Shaders: Procedural, Mirror, Transparent, Marble, Lines. .. ... _._. ... . . ... . . ... ... ... ... ......... 116
Luminous Glazing Shader. . .. ... .. 117
Realistic Glazing Shader. . . ... ... e 118
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Creating a Shader

This is done using an existing Shader either:

e from the active Shaders inspector, menu: Tools > Create Shader From...

e or by right clicking on the name of a ~ ##¢Tre- material and selecting the option Create Shader
From...

The edit dialog opens with the image of the current Shader. If the current Shader is a procedural, the dialog is empty.
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The dialog must be populated with images and values. Do this by dragging and dropping where appropriate or dou-
ble click on the thumbnail to open a dialog to choose an image.

Once stored, the new Shader will appear as a Standard Shader.

Title .Ra.w gold
Preview
L]
= | F
i-é, h Width: | 1.00 m
o g’ﬂ
Dittuse
Width: [1.00 m ]
; Mirror: v e
Reflection
PE—— [} ] ]
e Shider Range: L E'UF I
[ i Max 100
i AT
- NIt WAl —— D.el
Lhininess
M 1.00
b s o Shier Rangi i
e et Mz | 1000.00
.-" i‘*‘. Initial Value: sffe——— S0.00
Esmp
- — T —
1.!'1? » Shder Range |r|. . ].E'l.._
il = Max 100
by iy
i B4 innisl Value i — 0.30
Nermal
Slidar Ranga: 100
& Max 1.0
Initial Walise e 0000
Transparemnty

o Add fresnel effect

® [ Cancel ) (Sm.hsShad!r }

1. Title:
e Enter the name of the Shader. This name will appear in the top left of the inspector.
2. Preview

This is the thumbnail that appears in the Shader Inspector and in the thumbnail field of the Catalog.
The thumbnail representing the Shader must be a 128 x 128 pixel jpeg file.

The width of the thumbnail gives the size of the image in cms to a scale of 1.

NB: If you do not provide a thumbnail, Artlantis will use the diffuse image resized to 128 x 128 pix-
els.

3. Diffuse:

The image must be present. This is the visible part of the Shader. Depending on the pattern, we rec-
ommend an image size of 512 x 512 or 1024 x 1024 pixels.

NB: Ifthe image is not square, Artlantis will stretch it to make it square.
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The diffuse width gives the the image in cm on a scale of 1.

Depending on the representation, this size may differ from the preview thumbnail. The diffuse image does
not necessarily represent the same image as the thumbnail.

NB: The diffuse image represents 4 times the size of the thumbnail image but its pattern is 3 x 3 the
size of the thumbnail in order to avoid a repeat effect.

The diffuse image is not visible in the Shaders inspector but displays in the Catalog Preview field.
4. Reflection

The image is optional. It is generally in gray scale but may be in color.

Its size in pixels must be the same as the diffuse image. Otherwise, Artlantis will stretch it depending on the
size of the diffuse image.

The purpose of the reflection image is to modify the value of the reflection cursor:

e In black pixels, the slider value is multiplied by 0.

e In white pixels, the slider value is multiplied by 1.

e In intermediary pixels, the slider value is multiplied by the intermediary value.
It is useful to limit the effects of reflection at certain parts of the diffuse image.

NB: The slider is limited to a minimum and maximum value. For example, entering a value of 0.35
will define a slider that will range from a minimum of 0 to a maximum of 0.35.

You can test the effects of each of the settings in real time in the Preview window.
5. Shininess

The image is optional and should be in gray scale.

Its size in pixels must be the same as the diffuse image. Otherwise, Artlantis will stretch it depending on the
size of the diffuse image.

The Shininess image is used to modify the slider value: Same as Reflection.

6. Bump:

If the Shader has no Bump image, the slider will be available in the Shaders inspector and Artlantis will use
the diffuse image to provide bumps. Hence, the bump image will always be available and will use less sys-
tem memory.

7. Normal:

The image is optional. The colors use strict rules to define the bump simulation. Generally, it replaces Bump,
but Artlantis can support both.

Important: It is not simple to create a "Normal" image. If the Shader has no Normal image, the
slider will be disabled in the Shaders inspector.

8. Transparency:

The image is optional and should be in grayscale.
It is used to simulate holes and transparencies in the Shader.

e In black pixels, the Shader is opaque.
e In white pixels, the Shader is transparent.
9. Add Fresnel Effect:
If checked it adds to the created Shader the Fresnel Transition cursor

10. Save Shader as:

Opens the save dialog.
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Create Shader and Shader Interface Match:

width: L00m o

width: o0 m

Planetary =]

Taespareney ol Material ID Parameters

Mo Smootness  wax
———— o0

2 Material i isible
4 Material Cast Shadows
f A el efec # 1 Macerial Receves Shadows

® G

@

Some Basic Shader settings are not available in Create Shader: Rotation, Mix Color, Transparency, Projection
Options, and Materials Identifiers have default values.

Materials List

=]

=H Opens/closes the list of Materials.
They are displayed by name. To edit, double-click on a name.

Material
| Infinite Ground Material .

w Model
¥ SCERT

[ 1 Defaudt front color :

Snow.

Fuchsia

Moccasin:

Blue

Sibver !

Rosylirgwn
SreaiBlue @ ShectMetalShingle
MediumPurple @ Bebeere
Black :

@ CarregateShing
DimGray :
Blue Glass : Fresnel Glazing
SeaCreen - Brickwall 01
LightBlue : basic
Bed : SheetMetalShingle
Coral : basic
SaddieBrown : mzhoganyd2

Toolbar:

° Creates a new material based on the material selected.

m The material created appears at the end of the Materials List (before the Object Materials). The textures
linked to the duplicated material are also duplicated.

° Add a texture to the selected material. Select a TGA, JPEG, BMP, PICT, PNG, TIFF, EPIX, Pho-
toshop, MOV, AVI, or MPG file.
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° o Delete the selected material or the selected texture linked to a material. Activates when the material is not
associated with the geometry.
Shortcut: Hit the Back key.

o = & .
e Enables the user to Reaffect a Material.

List Organization

 5cene

| wTare

| Material
| infinite Marerial @ m
|

Surf jewash_1 : basic
Metal-Sainless Steal :
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|
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1. Material:

Names of Materials in the scene are listed in alphabetical order and followed by the name of the Shaders.

Click on the Material name to arrange the names of the materials in alphabetical order or reverse alphabetical
order.

Infinite Ground Material:

This is the material applied to infinite ground (Scene Information). It appears at the top of the mate-
rials list.

Scene:

Clicking on the Scene tab opens/closes the listed materials that are specific to the scene or internal
component.

Object Name:

Clicking on the Object tab opens/closes the list of Materials with Shaders and Textures linked to the
object in question.

Material Name

When the material is assigned, the name is written in black.
Shader Name

Follows the material name: in blue.
Texture Name

Follows the material or Shader name: in green. Y ou can use drag/drop to re-arrange the order in which tex-
tures associated with a material are mapped. Dragging/dropping one texture to another makes it dependent.
This enables you to move them at the same time.

Newly created materials not associated with geometry

The name of the material is written in red.
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9. Object Instance Name
The Object Instance is made up of several materials
The user can drag and drop a Shader onto a material in the list.
The Copy/Paste shortcuts can be used within this list.

NB: Limitations - in an ATL reference file, any material that has been renamed or re-assigned will not be
recognized by the "Use Reference File...” command.

Here, we recommend that you go back to your modeler to distinguish the material names and then, if your mod-
eler allows it, update the atl file or use the "Use Reference File" function.

Realistic Water Shader

=

Materials List: displays the materials of the scene.

Fresnel Water Shader
£ @
@ | 250 |
. | 250 |
Transparency L
(ter CREEE

) Reflection | [ | Umit:  [0.00 m |
Shininess: -
——) | 1000.0

Fresnel Transition:

—_—
Warer surface

Wave s YT

il 1,00

Flatness: .00

R -

Animation parameters

" @
Matgsial ID Parameters
Min  SmoDthness M -
e S —— | .15
W Material 1s Visible
&' Material Cast Shadows
™ Material Receives Shadows

1. Color Selector:

Click to select a diffusion color or enter numerical values (1 to 255) in the RGB fields.
2. Saturation:
Use the slider to choose the color saturation level.
3. Transparency
Reflection, Shininess
Gives a reflective appearance to the material.

May be used in conjunction with the color from Diffiise, Transparency or both. Drag the slider to make the
material reflect its environment or enter a value in the related field. The reflection intensity is managed using
gray scale values or RGB values from 0 to 255. Click on the selector to choose a color.

Entering a Limit value defines the maximum distance of the reflection.
5. Fresnel Transition
Water surface:

Wave size: Drag the cursor to adjust the wave amplitude or enter a value in the related field. The wavelength
value can be from 0 to 500.

Flatness: Drag the wave amplitude cursor or enter a value in the related field.
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7. Animation settings:

Allows the user to automatically adjust the moving water effect which will only be visible in sequence
animation mode. If the box is unchecked, the movements are suspended.

Allows the user to animate the water movement speed. Values from 1 to 3.
8. Material ID Parameters:
Use the slider to choose the smoothness level for the material.
9. Material Characteristics:
The material is visible or invisible.
The material either casts shadows or it does not.
The material either receives shadows or it does not.
10. Shader/Textures Navigator:

For a material, this makes it possible to navigate between related Shader and Textures editors.

NB: effect only in Artlantis Studio in animation mode

The Neon Light Shader
o

Materials List: displays the materials of the scene.

Neon Light @
-}
| 2ss
J | =55 ]
. [

@ Lighting ¥
Pewer: -
_____ P

() Transparency |
Air W 100 |

Shininess @
i —
Maserial 1D Parameters
Min Smoothness felax
—_—— - (34
™ material is Visible
™ Material Cast Shadows
# Material Receives Shadows

1. Color Selector:
Click to select a diffusion color or enter numerical values (1 to 255) in the RGB fields.
2. Saturation:
Use the slider to choose the color saturation level.
3. Lighting Power:
Drag the slider to change power or enter a value (from 0.1 to 5000) in the related field. Click to choose a
color from the system color picker.
4. Transparency
5. Neon:

Drag the slider to adjust the neon power or enter a value in the related field. Click on the selector to choose a
color.
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6.
7.

8.

9.

Shininess
Material ID Parameters:

Use the slider to choose the smoothness level for the material.
Material Characteristics:

The material is visible or invisible.

The material either casts shadows or it does not.

The material either receives shadows or it does not.
Shader/Textures Navigator:

For a material, this makes it possible to navigate between related Shader and Textures editors.

The Basic Shader

=

Materials List: displays the materials of the scene.

Basec Shader
f ]

[ 160 ]

Diffuse Calor.

[

‘r«;ﬂc{mn: bl 0.00

Umitc  [0.60 m
@ shlﬂ'n!:si. 50
Special j

T
!.unsmrtnr\' 000

A -:} 100 |

Marerial I Parameters

Min Smogthness  max
—— .34
] Material is Visible

¥ Material Cast Shadows
# Material Receives Shad

Color Selector:

Click to select a diffusion color or enter numerical values (1 to 255) in the RGB fields.
Saturation:

Use the slider to choose the color saturation level.
Diffusion Color:

Another way to select a color is to click to choose a color from the system color picker.
Reflection, Shininess

Reflection: Drag the slider. When the diode is red, the material reflects its environment or enter a value in the
related field. Click on the diode to cancel the command.

Limit: Entering a Limit value defines the maximum distance of the reflection.
Transparency
Material ID Parameters:

Use the slider to choose the smoothness level for the material.
Material Characteristics:

The material is visible or invisible.

The material either casts shadows or it does not.

The material either receives shadows or it does not.
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8. Shader/Textures Navigator:

For a material, this makes it possible to navigate between related Shader and Textures editors.

Expert Shader

[

Materials List: displays the materials of the scene.

Expert Shader @

=n

[ 100

@ Diffuse i |

Reflection
Lmit: 0,00 m
’s_nol.flw 6
Transparency -
Air ) 1o
~) Neon -

—% 1010

Material 1D Parameters

Min Smoathness b
—_— =

0.34
® Material is Visible

® Material Cast Shadows.

# Material Receives Shadow

Color Selector:

Click to select a diffusion color or enter numerical values (1 to 255) in the RGB fields.
Saturation:

Use the slider to choose the color saturation level.
Diffusion Color:

Another way to select a color is to click to choose a color from the system color picker.
Reflection, Shininess

Gives a reflective appearance to the material.

The reflection intensity is managed using gray scale values or RGB values from 0 to 255. Click on the selec-
tor to choose a color.

Entering a Limit value defines the maximum distance of the reflection.
Transparency
Neon:

Drag the slider to adjust the neon power or enter a value in the related field. Click on the selector to choose a
color.

NB: Neon color does not emit light.

Material ID Parameters:

Use the slider to choose the smoothness level for the material.
Material Characteristics:

The material is visible or invisible.

The material either casts shadows or it does not.
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The material either receives shadows or it does not.
9. Shader/Textures Navigator:

For a material, this makes it possible to navigate between related Shader and Textures editors.

NB: Before editing a color, click on the button associated with the command.

Diffuse Fresnel Shader
5 .

| Materials List: displays the materials of the scene.

yaris-body : Diffus Fresnel

Bt 9| XE Q| B |[

Diffus Fresnel Shader
pE—
‘ =| je.

= Diffuse ]

() Reflection
Lmit: | 0.00m)

Shininess:
—_— 775

Fresnel Transition:
a.70

"o

Marerial ID Farameters

Min Smoathness Max
_ 0.20

™ Material Is Visible
Ij Marerial Cast Shadows
IE Material Receives Shadows
@

1. Color Selector:

Click to select a diffusion color or enter numerical values (1 to 255) in the RGB fields.
2. Saturation:

Use the slider to choose the color saturation level.
3. Diffusion Color:

Another way to select a color is to click to choose a color from the system color picker.
4. Reflection, Shininess

Gives a reflective appearance to the material.

Page- 114



The Shaders Inspector - Transparent Fresnel Shader d

The reflection intensity is managed using gray scale values or RGB values from 0 to 255. Click on the selec-
tor to choose a color.

Entering a Limit value defines the maximum distance of the reflection.

wn

. Fresnel Transition:
6. Material ID Parameters:
Use the slider to choose the smoothness level for the material
7. Material Characteristics:
The material is visible or invisible.
The material either casts shadows or it does not.
The material either receives shadows or it does not.
8. Shader/Textures Navigator:

For a material, this makes it possible to navigate between related Shader and Textures editors.

NB: Before editing a color, click on the button associated with the command.

Transparent Fresnel Shader
[

Materials List: displays the materials of the scene.

yaris-glass : Transparent Fresnel

Bl @ I (@ (@[T

Transparent Frésnel Shader

| zs

I 255

un

Reflection

Q

Limit: | 0.00 m|

Shininess:

&= | 927

Fresnel Trangition:

o

B Transparency

_Glass ﬂ 15

Matenal 1D Parameters

Min Smoathness Max
..—(.,—.. 0.20

H Material Is Visible
Iﬂ Material Cast Shadawi
IH Material Receives Shadows
@
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1. Color Selector:

Click to select a diffusion color or enter numerical values (1 to 255) in the RGB fields.
2. Saturation:

Use the slider to choose the color saturation level.
3. Reflection, Shininess

Gives a reflective appearance to the material.

May be used in conjunction with the color from Diffise, Transparency or both. Drag the slider to make the
material reflect its environment or enter a value in the related field. The reflection intensity is managed using
gray scale values or RGB values from 0 to 255. Click on the selector to choose a color.

Entering a Limit value defines the maximum distance of the reflection.
4. Fresnel Transition
5. Transparency
6. Material ID Parameters:
Use the slider to choose the smoothness level for the material.
7. Material Characteristics:
The material is visible or invisible.
The material either casts shadows or it does not.
The material either receives shadows or it does not.
8. Shader/Textures Navigator:

For a material, this makes it possible to navigate between related Shader and Textures editors.

Shaders: Procedural, Mirror, Transparent, Marble, Lines

[+

Materials List: displays the materials of the scene.

G) ==
E4°

s
Roughmess:
—_—

Color Table:

Marerial I Parameters

Min Smogthness  max
e 0.
™ Material is Visible

¥ Material Cast Shadows

4 Material Receives Shadows

1. Color Selector:

Click to select a diffusion color or enter numerical values (1 to 255) in the RGB fields.
2. Saturation:

Use the slider to choose the color saturation level.
3. Color Picker:

Shader defined by two, three or more colors (e.g. checkerboard).

Page- 116



The Shaders Inspector - Luminous Glazing Shader d

4. Shininess
Drag the slider to make the material reflect its environment or enter a value in the related field.
5. Roughness:
Moving the slider lets more or less light move on the material.
6. Color Table:
Defines the gradient mode between two colors. The mixture depends on the Shader's geometry. e.g. Check-
erboard, Lines, Stone, Marble, etc.
Click on the curve, keep the mouse button depressed and move to redraw the curve.
A horizontal line at the top or bottom of the table indicates that a single color is applied.
A diagonal straight line indicates a regular shading.
Flip: The & button turns the Shader around its object.
Scale: Moving the slider adjusts the Shader proportionately.
7. Material ID Parameters:
Use the slider to choose the smoothness level for the material.
8. Material Characteristics:
The material is visible or invisible.
The material either casts shadows or it does not.
The material either receives shadows or it does not.
9. Shader/Textures Navigator:
For a material, this makes it possible to navigate between related Shader and Textures editors.

Luminous Glazing Shader

=

Materials List: displays the materials of the scene.

Neon Glass
-

| 2ss

IEER

Pawer; —
s e | 1

) Transparency ]
@ Air I3 ] 1.00

Reflection:

o]

Lmit. 000 m

Shininess 5 |
e &

Materal 10 Parameters

Min Smoothness  Max
—p— (), 6
® Material is Visible
¥ Material Cast Shadows
E Material Receives Shadows

1. Color Selector:

Click to select a color or enter numerical values (1 to 255) in the RGB fields.
2. Saturation:

Use the slider to choose the color saturation level.

3. Lighting Power:
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Drag the slider to increase power or enter a value (values from 0.1 to 5000) in the related field. Click to
choose a color from the system color picker.

4. Transparency
5. Reflection, Shininess
6. Material ID Parameters:
Use the slider to choose the smoothness level for the material.
7. Material Characteristics:
The material is visible or invisible.
The material either casts shadows or it does not.
The material either receives shadows or it does not.
8. Shader/Textures Navigator:

For a material, this makes it possible to navigate between related Shader and Textures editors.

Realistic Glazing Shader

=

Materials List: displays the materials of the scene.

Fresnel Glazing Shade
-

@ i
: 1.00
") Reflection | |
Lmit | 0.00m
shininess:
Y —

&

Fresnel Transition: @
_—
Clazing Quality. 5

Distortion size 1.00 m
XY EYTH
—_—f——— | 0.50
Flatness.

0.50

# Windowpane auto detection
Material 1D Parameters

Min Smoothness  max
—— 0.50

! Material is Visible

W Material Cast Shadows
¥ Material Receives Shado

1. Color Selector:
Click to select a diffusion color or enter numerical values (1 to 255) in the RGB fields.
2. Saturation:
Use the slider to choose the color saturation level.
3. Transparency
4. Reflection, Shininess
Entering a Limit value defines the maximum distance of the reflection.
5. Fresnel Transition
6. Glazing Quality:

Allows a discontinuous reflection to be created when there is a break between several surfaces on the same
plane. This effect accentuates the realistic effect of reflection on a glazed surface.

Distortion size:

Determines the length of the undulation. Enter a value into the related field.
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XY

To orientate the undulation mostly on the X- or Y- axis or both. The slider allows the proportion to be var-
ied. Enter a value into the related field.

Flatness:

Determines the amplitude of undulation. Enter a value in the related field.

Windowpane auto detection:

When checked, finds the limits of a contiguous shape to generate a glazed surface.
7. Material Characteristics:

Smoothness: Use the slider to choose the smoothness level for the material.
8. Shader/Textures Navigator:

The material is visible or invisible.

The material either projects shadows or it does not.

The material either receives shadows or it does not.
9. Shader/Textures Navigator:

For a material, this makes it possible to navigate between related Shader and Textures editors.

Editing Textures

A texture is an image or sequence that is imported onto a material. A material can receive one or more textures.

[

Applying a texture is done either by:

Materials List

'_{'.-
e Using the & Add Texture button in the Shaders inspector

S0l —ant Create Shader...
woanap 1o A t
weanap. 1 !
mam
e Right clicking on the name of the material = Tante-2 and selecting the Add Texture...

option
e By dragging and dropping the texture thumbnail from the Catalog to a material in Preview mode or in the list.

e Dragging and dropping the texture from a location on the hard drive onto a material in Preview or in the list.

Deleting a texture is done either by:

e Clicking on the button to delete the current texture.
e Using the Delete background key.

e Right clicking the name of the texture and selecting Delete in the pop-up menu.
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Texture Mapping

Dimension Moo |
e bl 100%
Size pace Rep. Mir. Flip

0.0l m 0.00m O 4gp

- -
0oL m 0.00 m .y
| Orthogenal -45‘

1. Preview:

Displays the thumbnail of the selected Texture. The blue cross represents the anchoring point of the texture.
Clicking in the image repositions this point.
2. Rotation:

Use the circular cursor (Shift + Click, to step every 15°) to turn the texture on its axis or enter a value in the
related field.

3. Mix Color:
Check and click on the selector to choose a color.
4. Reflection

Move the slider to change the reflection or enter a value in the related field. When the diode is red, the texture
reflects its environment.
Double click on the red diode to cancel the effect.

Entering a Limit value defines the maximum distance of the reflection.
5. Shininess

Use the slider or enter a value into the related field.
6. Ambient:

Use the slider or enter a value into the related field.
7. Bump:

Use the slider or enter a value into the related field to simulate the effect of bumps or hollows on the surface
of the material using the levels of gray contained in the image.
Double click on the diode to cancel the effect.

Normal mapping
8. Transparency:

Apply a level of transparency to the texture or enter a value into the related field. Click on the diode to cancel
the effect.

Use Alpha Channel: Activates/deactivates the transparency of the alpha channel.
Using a transparency color: Click on the selector to choose a transparency color.
9. Scale:
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Button ' : The texture is automatically adjusted to cover the maximum surface of the material horizontally
and/or vertically.

The slider changes the texture scale from 50 to 200% of the current size. Or enter a value into the related
field.

10. Dimension, Spacing:
Width/Height:

Size
0.51m

0.5l m

Enter the size of the texture, clicking on * retains the proportions. Click again to cancel the limitation.
Horizontal/Vertical Spacing:

Space |
0,00 my

0.00 m

Used for repeated textures. Defines the size of the spacing between each repetition.

Enter a spacing value as A and/or V. Clicking = keeps the same proportions. Click again to cancel the lim-
itation.
. Al . . . . . . .
Flip: horizontally or vertically inverts the texture with a mirror option between two repetitions.
Horizontal, Vertical repetition: duplicates the texture along the horizontal and/or vertical axis.
Horizontal Mirror, Vertical Mirror: Horizontally and/or vertically inverts each duplication.
11. Projection:

Adjusts the image to the surface on which it is placed. Automatically selects the adjustment best suited to the
project.

+ Planar
Orthoganal
Horizemntal
Vertical
Spheric
Y Cylindric
X Cylindric
u
Plamerary

Planar: is applied to a plane.

Orthogonal: is applied to an element. If the element is composed of surface planes, the texture follows the
surface planes.

Horizontal: the Shader is required to be set horizontally.

Vertical: vertical projection on the element. The horizontal parts receive the image while the vertical or tilted
parts are stretched.

Spherical: adopts a spherical form that depends on the size of the texture. Hence, it may leave empty spaces.
YCylindric: the texture is projected around the axis of a vertical cylinder.
XCylindric: the texture is projected around the axis of a horizontal cylinder.
UV: maintains the texture coordinates on an object coming from software that manages UV maps.
Planetary: vertical projection of the element while passing through the poles, without leaving spaces.

12. Shader/Textures Navigator:
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For a material, this makes it possible to navigate between related Shader and Textures editors.

Reaffect a Material

[

CENE .
Use the toolbar =~ = to reaffect a material

1. Click on the selection arrow — |

E 4

P OO

choose the type of selection in the drop-down menu  * , by triangles, planes, parallel planes, objects, material
or Magic Wand.

2. In the preview window, click on the items you want to reassign with the new material (click again on the selec-
tion button to cancel the current selection).

3. Click on the "Apply material" button — .
Reaffect material dialog box pop-up:

Apply material to the current selection

Selected material: | Bois-Pin horizontal =

@ Apply a copy of the selected material
Name: | material

() Apply the selected material

Cancel 0K~

5. Apply material to the current selection
There are two options:

"Apply a copy of the selected material" and "Apply the selected material".

o Apply a copy of the selected material:
Creates a copy of the selected material in the list. By default, the name remains the same as the original one.

e Apply the selected material:
Reaffect the selected material to the selected mesh. It is possible to change the selected material using the drop-
down menu.

NB: Elements making up an object cannot be selected.

NB: The File > Use Reference File command does not recognize reassigned or renamed materials.

The Materials and Textures Pop-up Menus

The pop-up menu depends on the name of the material or texture clicked.
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Material

e Right-clicking on a material name displays the following pop-up menu:

Create Shader Fram...

dd Tewture. ..

Merge Materials with 5ame Name
Merge Materials with Same Shader
Merge Wertex

+ Visible
+ Cast Shadow
+ Receive Shadow

Delere All Unused Materials

Explode Material By Mesh

Create Shader...

Opens the Create Shader dialog.

Apply to All Instances

Applies the modified material of an object to all identical objects in the scene.

Reset to Default

Applies the original material to the object.

Add Texture...

Open the dialog box and choose a TGA, JPEG, BMP, PNG, PICT, or Photoshop file.
Merge materials with Same Name

Materials with the same name will be replaced by the selected material.

Merge Material with the Same Shader

Materials with different names but having the same shader are grouped under the same name.
Merge Vertex

Merges superposed points of the polygons using this material.

(Avoids the problems of modeled object artifacts whose superposed points are not merged and allow the smoothing
of the polygons).

Visible
e Ifunchecked, the material becomes invisible.
Cast Shadow
If checked, the material casts shadows on the other elements.
Receive Shadow
If checked, the material receives the shadows cast from other elements.
Delete All Unused Material IDs
Clears the materials that are not assigned to the geometry.
Delete

Deletes the selected material.
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Split Material by Mesh

From an applied material the command creates into the list of materials as many as materials as meshes found.
Example:

NB: Does not delete a material from the original model.

NB: The File > Use Reference File command does not recognize reassigned or renamed materials.

Texture
e Right-clicking on a texture name displays the following pop-up menu:

Delete E ]
Tep Lef
Top Right
Bamonm Left
Bottom Right
Center

Delete: erases the related texture.

Merge Texture Origin: upper left, upper right, lower left, lower right, center.
Determines the texture's anchor point. In Preview, the origin is represented by a black cross.
In the thumbnail, the anchor point is represented by a blue cross.
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The Objects Inspector

Used to edit geometry, materials, coordinates, dimensions and animation settings

Editing the geometry from the list
There are two ways of displaying the elements in the scene: by Hierarchy or by Layer

m By Hierarchy allows the user to select the elements making up the scene in view and edit them. See " The
Objects Inspector by Hierarchy" page 126

m By Layer allows the attached objects to be ordered by layer. See " The Objects Inspector by Layer" page 128
= Multiple selection.

In the list, the coordinates and dimensions of a multiple selection of objects may be edited at the same time.

NB: Editing the scene information such as the infinite ground, movement of the origin, redi-
mensioning of the model and the coordinates may be accessed via the Window menu.

In this chapter you will learn about the following subjects:

The Objects Inspector by Hierarchy. . ... .. .. .. 126
GeOMNCRTY. . . e 126
OB eCt . e 127
SaVINE A SCOMe:. . . .. 127

The Objects Inspector by Layer. . . ... e 128
I 129
GeOMNCRYY. . . . e 130
L0 ) -T2 131

Editing the Scene. . ... . 131

Editing Objects. . . e 133
In the case of a Standard object:. .. ... . ..o 133
Object AnImation. . .. ... .. .. 134

Creating an Object from a Scene. ... .. .. .. . 134
Selecting Polygoms. . .. .. .. e 134
Creating the Object. . ... .. . .. 135
Canceling a Selection. . .. ... ... e 135

The Objects List. .. . e 135

Billboards. . . ... 137
Availability:. . e 137

Light Objects. . ... 139

Standard ObjJects. . . ... 140
Object ANIMAation. . ... ... e 140

Vegetation Objects. . ... .. e 140

Animated Character Objects. . .. ... . ... e 142
B aVIOr. e 142
Shad T . 142
Coordinates. . ... .. ... 143
Object AnNImAation. . .. ... .. .. 143

Instanced Object. . . .. e 143
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The Objects Inspector by Hierarchy

The elements listed represent the geometry of the scene and objects.
The contents of the inspector differs according to which option is selected from a list:

1. Scene geometry
2. Object added to the scene

Geometry

O | ¥ | 5 Ol 0|1} G e

0 (M =g

¥ Terrain2_L
Chéne 20m_1
Nolsetier Sm_1
Chéne 20m_2
Chéne 20m_3
Chéne 20m_4

Coordi — Chine 20m_§
Position: X ¥ z Noisetier Sm_2
o o Chéne 20m_6
Rotation: Av-car_1
& Plafonnier_L
¥ @ table
vase
. " CManD016_1
Dirapiicar People_035_1

X ¥ z

Keep propartions

Animation parameters

©

The name of a geometry selected in the list displays its coordinates, dimensions and animation parameters. These
parameters may not be edited.

NB: The settings related to the geometry cannot be edited (name, coordinates, dimensions).

o Delete the geometry from the list: does not affect dependent objects

Define As Target |

Delete
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Object

O | 9| O 0|1 e )

4 O = L_.it‘

Name
; v scene
r " B Terrain2_1
Plafonmier_L
¥ @ table
vase
o 200% CMan0016_1
HEight: m—m— 147 & People_035_1
| TT—

TrANSPArENCY. (m—— ]
Color: [ Red -+
I

Date
) Use Heliodon Date
[
Ol . o
Coordinates o
X
4687 m -3099 m 10

. S R
-0.00 -0.00 -0.00

Animation parameters

® Normal
() Orientation on the path

() Orientation on the path, X,Y only  —
7 —

The object settings can be edited as they are independent of the scene geometry.

Geometry pop-up menu selected

Define As Target
Delete

When the geometry is selected in the list, right-clicking the layer name displays a popup menu with the following

options:
Use/Do not use as target: to define (depending on the activation in the viewpoint inspector) whether a geometry

o
element or an object is suitable for being used as a target for the cameras

o Delete object from the list.

NB: Multiple selection is available with these commands.

The objects are available in the Media catalog

Object geometry

1. Edit Object
2. Types of objects: Standard, Light, Vegetation, Animated person —1 and Billboard

3. Creating an Object

Saving a scene:
To export a scene as an object, see Saving an AOF Document
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The Objects Inspector by Layer

Geometry elements are always contained in layers.
The layers come either from the CAD software, or are created in Artlantis.
The Inspector dialog changes according to which option is selected from a list.

There are three selection options:

1. Layers
2. Geometry
3. Objects.

Mame

v '_ Scene

SCEne

¥ -® | Light Objects
Platonnier_1
v i Animated Objects

CMan0016_1

'-g | Bilboards

¥ @ | Objects
Terrain2_1
Av-car_l
VAEE
@ mble
| Layer

Selecting more than one layer enables their visible/invisible status to be changed depending on the viewpoint.

Selecting multiple objects enables them to be moved to another layer.
Clicking the name of an object in the list makes its insertion point flash in the Preview window.

Renaming a layer

The name of the layer selected in the list is highlighted, select it to rename it.

NB: In Artlantis, renaming a layer created in the CAD software breaks the link to this layer. In this case,
modifications made using the "Use a Reference File..." command will not be recognized.
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Layers

OV O 0L ey ey )

Layer Informations: -
Q X =g
Name: 3D Plants Pame ]
Number of Instancies: 9 v Scene
Number of Triangles: 45228 scene

¥ || Light Objects

Plafonnier_L

Actions on layer:

Make Default

Hide In Current View | v Animated Objects
Layer Type: CMan0016_1
O None 4] Billboards !
= ¥ || Objects
@ | O objects 255
TerrainZ_1
A | @ 30 Plants Av-car_1
vase
] O sitboards 5 table
Layer
A | O animated objects L

] O Light Objects
Action on View having this layer visible:
_Edil _'i

(Activate ]

!(_Scene Infurmatiarls.,,?

|
 —]

1. Layer data:

name, number of instances contained, number of triangles making up the geometry
2. Actions on layers

o Use by default:
When you click the "Use by default" button, the layer selected becomes the default layer for dragged objects
dropped into the scene or objects created from the scene stored there.

e Hide/Display in the current view: displays what is necessary for the active viewpoint. Advantage: improves the
display and rendering.

3. Layer type:
None, Objects, 3D Vegetation, Billboards, Animated objects, Light objects

When you drag and drop objects into the Preview window, they can be stored automatically in the layers.
This is done by telling these objects what their destination layer is beforehand.
When a project is opened, Artlantis always assigns a default layer, its name is displayed in bold. This layer
receives any object added into the scene until another layer is declared as the "Default layer".
However, you can automatically associate certain types of object with certain layers
None: by default, the component dragged and dropped into the scene is stored in the layer whose name is
shown in bold, except if this type of component has already been associated with a specific Objects, 3D
Vegetation, Billboards, Animated objects or Objects with light layer.

To define a specific layer which is to contain a certain type of component, a new layer must be created in the
list or an existing layer chosen, then in Layer type, select the type.

Any layer in the list can be chosen. In the list, the symbol concerned will be assigned to the layer icon.

Example: You create a new layer. Then in Layer type, you click on Objects. All components (objects)
dragged and dropped will be stored automatically in this layer.
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4. Actions on the view containing the visible layer:
Edit. depending on the layer selected, lists only the viewpoints where this layer is visible. In the popup menu,
select the name of the view. The Inspector changes to Viewpoint inspector and the selected view is dis-
played.
Activate: depending on the layer selected, lists only the viewpoints where this layer is visible. In the popup
menu, selecting the name of the view activates it without changing Inspector.

5. Scene information: Displays the edit dialog for the scene

Geometry

v | Scene

- Define As Target
* \L Cielete
Move To [ 3

v | ML
Right-clicking geometry contained in the layer displays a popup menu with the following options:

e Use/Do not use as target: defines (depending on the activation in the viewpoint inspector) whether a geometry
element or an object is suitable for being used as a target for the cameras or lights.

e Delete: deletes the selected geometry contained in the layer.

e Move to: moves the geometry to another layer.

NB: The settings related to the geometry cannot be edited (name, coordinates, dimensions).

Object by Layer toolbar
Hiﬁ'flr(.};l'gl' Layers ]
‘_ @ H’ | = :;'.'

Create a layer

A

1. Create a layer — in the layer list. A new layer is added, click on the name of the layer to rename it.

2. To delete a selected layer, click o
When the layer contains geometry, a warning dialog offers to transfer the elements in this layer to another via a

popup menu or to delete all the elements it contains.

NB: renaming or deleting layers which have been created by the CAD software breaks the link with
it when the "Use a reference file..." command is used.

Creating an object

Selected layer popup menu

When a layer is selected in the list, right-clicking the layer name displays a popup menu which lets you:

e Default: define this layer as default
e Hide in the current view: makes the layer invisible for the current view.
o Edit the view containing the layer: the inspector view changes to the Viewpoint Inspector.

o Activate the view which has this layer visible: the view becomes active without changing the inspector.
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-

o Default layer for: defines the default type for this layer: Objects, 3D Vegetation, Billboards, Animated objects

and Light objects.

e Delete: deletes the selected layer, then displays the following dialog to move its content.

B Panel

The selected layer is not empty.

() Delete content

Please, choose what to do with its content.

® Move content to the following layer: | Scene 'Pb:!

{ Cancel ) @

o Delete all empty layers: deletes all layers which do not contain geometry.

Defauly
Hide in the current view

L]

- j Edit view having this layer visible |
Adtivate wiew having this layer visible »
Default layer for b

Delere
Delene All Empty Layers

|E|.'Pﬂ-il

NB: multiple selection is available with these commands.

Object

oy
e Types of objects: Standard, Light, Vegetation, Animated person —_| and Billboard.

The objects are available in the Media catalog

Editing the Scene

Data related to the whole scene is displayed using a command from the Window menu or from the Object inspector in

display mode by Layers.

Scene informations:

URL : fUsers/mjeanfrancois/Public/Loft_Stan22/
Loft_Start23.atl

Layers. 7

Triangles: 33143
Object triangles: 273
Perspective Views: 12

Faraliel views. 5
VR Dbjects: 1

Panoramas: 1

S Infinite Ground

Altitude: owom ¢
& ((editshader.. ) @

Translate Origin

Scene size
X ¥ £
105.76 m 125,70 m T@
Legecs = o, -
Position: X ¥
10,00 m Q.00 m a0
Rotation:
e 2L —
0.00 0.00 0.00
( Cancel ) (0K )
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1. Scene Information:

e File location:

e Number of triangles making up the scene,

e Number of triangles making up the objects,

e Types and numbers of viewpoints,

e Structure of Light, Heliodon and Material Groups.

2. Infinite Ground:

e Checking/unchecking activates and deactivates the ground. The ground receives shadows,
Shaders and objects.

o Click on the Alfitude cursor. Then, in the Preview window, click on the scene element
that will define the height of the ground, or enter a value into the related field.

e Edit Shader selects the Ground Shader and activates Shader edit mode.

3. Transfer the origin of the anchor point:

e Select the location of the new origin of the Scene.

Select Qrigin :
Center X,Y and Bottom
Center X, ¥ and Top
Center XY
Camara Target

Determine the object entry point (blue Moves the scene origin.
ball)

Center X, Y and below

Center X, Y and above.

Center X, Y

Camera target.
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NB: For an .aof the default anchor point can be changed in the 2D view.

4. Scene Size:
Resizes: geometry, objects, cameras, lights, etc. No impact on the size of Shaders and textures.

Editing dimensions; if Keep proportions is checked, X, Y and Z remain homothetic.
5. Coordinates:

e Model XYZ Position. Enter values in the related fields to move the scene origin.

e C(Clicking on ~ 1 Jocks them and clicking on “ unlocks them.

e Rotation: Pivots the scene along the X, y and z axes.
Shift+click and dragging the cursor restricts the movement to 15° steps.

Editing Objects

Select an object from either:

o List of Objects
e The Preview Window

e The 2D View window

The inspector palette displays the information.

In the case of a Standard object:

@t Edit Shader. )
oordinates -

Position:
-¥1.36 m -43.56 m 9.26 m
Rotation:
==

o S
0.00 [T 000

Dimensions

@' s I wion i e ]
 Keep proportions

Anirnation parameters
(=} Norrnal
() Orientation on the path
) Crientation on the path, XY only

1. Preview Thumbnail.
2. Edit Shaders...

e Choose the material to edit from the list, the Objects inspector switches to Shaders mode.
3. X,Y,Z Coordinates

e Position: Provides the X,y,z coordinates for the object's anchor point. Entering new values redefines
the position.
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NB: For an .aof the default anchor point can be changed in the 2D view.

e Rotation: Pivots the object along the X, y and z axes.
Shift+click and dragging the cursor restricts the movement to 15° steps.
-I

e Clicking on * " locks them and clicking on “ unlocks them.

4. Dimensions: changes the length, width and height settings.
e Click on the checkbox fo maintain the proportions. Clicking again removes the restriction.
5. Animation Parameters:
Object Position: 3 options

Normal: The object always moves parallel to its starting position. (e.g. a vector that always retains its orien-
tation regardless of the object's path).

Orientation on path: The object moves in X, y, z in the direction of the path (e.g. an aircraft performing a
loop).

Orientation on path, XY only : The object moves in x, y, z in the direction of the path but always remains par-
allel to ground level x,y (e.g. a helicopter taking off).

NB: Using the timeline, in a single sequence, the object can change behavior several times.

Object Animation

See "The Timeline Window" page 79
See "Animatable Object Parameters" page 199

Creating an Object from a Scene

From the geometry selected in the Preview window.

Selecting Polygons

K
Use the toolbar in the object list =~

1. Activatel— .

r00O4

2. Choose the type of selection in the B drop-down menu, by triangles, planes, parallel planes, objects, mate-
rials or Object Wizard.

3. In Preview, click on the elements that will make up the object.

NB: an object cannot be created from elements already used for another object.

&

4. Activate&.

NB: for an .aof the default anchor point can be changed in the 2D view.
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Creating the Object

Create object
Name: | Object from Selection
) Create internal object
() Create external object (.aof)
Destination layer: '_il:) Plants B

The object remains linked to the project but is saved either in the atl document, or in an independent aof file. In this
case, the aof file can be used in other projects.

Name the object

Create an internal object, or Create an external object (.aof). In this case select the location where it is to be
saved.

3. Destination layer: choose the layer for the new object.

NB: the geometry used to make up the object no longer exists since it has been converted to an
object.

NB: the use of the "Use a Reference File..." command maintains control of the layers except in the
following cases when:

in Artlantis:

- the geometry firom the CAD or modeler software contained in a layer has been moved to another layer.

- the names of the layers or the geometry contained in the layers have been renamed.
in the CAD or modeler software:

- the layers have been renamed or deleted.

Canceling a Selection

e C(Click on | again.

NB: geometry selection does not work on Artlantis objects.

The Objects List
[ Opens the list of object groups.
The geometry is displayed either by hierarchy or layer.
= By Hierarchy lists the elements of the scene together with the associated objects.

m By Layer lists the geometry of the scene by layer together with the associated objects.
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- [ Hierardn-_ Layers |

o [t =:¢

Mame

¥ scene
¥ Terrain2_1
Chéne 20m_1
Noisetier Sm_1
Chéne 20m_2
Chéne 20m_3

N B N

. Q deletes the selected object (and its dependencies). Double-clicking on the object name edits the name.
Changing the dependence of an object in the hierarchy is done by dragging and dropping.

e The objects can be placed in a hierarchy so the group of objects can be translated by moving the parent object

e Objects are classified alphabetically. Clicking on "Name" at the top of the list reverses the alphabetical order of
the classification.

NB: The Delete, Undo/Redo commands are available on the object list.

Pop-up menu for objects:

e Right-click on the name.

Mame

¥ Scéne
Tayota-Yaris_1
Lime 42'_1
Lime 42°_3

Li
Lirn

Delete
Apply Gravity

o Define as target: forces a camera to use the object as a target.

In the list, the object will have a red target in front of it.

In the Coordinate Viewpoint inspector, select the target object from the drop-down menu. Select target.
o Apply Gravity:

The anchor point of the object will drop to the surface beneath it.

Coordinates of the Perspective View Inspector:

Coordinates
X ¥ Z
[..'-‘ EL.75 m -55.44 m 31.54 m
Targer o « Fixed Vertex g

53T T

e The selected object has been created from the contextual menu as explained above.
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Multiple selection

Toyota-Yaris_1 |
| 9| O @[] G e )

o (M =g
Name

.. v Scine
1 Tayota-Yaris_L
Table_07_1

Armchair_01_1
Desk_01_1

Aml(&ll_ﬁi_l

e Edit Shader - str_TT_Objectinspector_
-

-, —
Translation:

‘B0 m | [ooom IR
Rotation;
-, .- .
-0.00 -0.00
Dimensions

o Keep proportions

Animation parameters
() Normal
() Orientation on the path

() Orientation on the path, X,Y only

e In the list, the coordinates and dimensions of a multiple selection of objects may be edited at the same time.

Billboards

Billboards are composed of a surface plane and an image.
Availability:

Available in the Catalog Manager, "2D Billboards" folder.

@08 : Catalog

wObjects “
720 Billboards
Pecples 2D
Fictograms 2D

Signs 20
Vegetation 20 L
Basic Ceometry

il Tree 004 Tree 005 Tree.006

I Exterior
B Furnitures - # -
objets . -

L —a—

Two types of Billboards

e Vertical, with relation to the ground (People and Vegetation).

e Flat, which lies flat on the receiving surface (Signs and Pictograms).
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®)

4
L2

®

&

-

=

v

®

Size: L7 m

6

T ¥

Color: | DefaultConfi

Display

¢
@ @

Brightness:

|

Contrast:

Coordinates

|

Ol

Thw | [-130m 2

Animation parameters
® Normal
) Orientation on the path
() Orientation on the path, X,Y onky

i)

Preview Thumbnail.
Horizontal and/or vertical symmetry.
3. Size of the element:

N

e Using the slider or by entering a value in the field (to go beyond the limits of the slider, type in a value.
The values of the slider will be updated accordingly).

4. Color:
Use the menu to change the color.
5. Transparency:

Used to render a Billboard with greater or lesser transparency depending on the desired level of trans-
parency: values from 0 to 100. 0 means opaque.

6. Display: Display Parameters in Preview
e Brightness: for changing brightness values from -0.25 to 0.25.
e Contrast: for changing contrast values from 0.5 to 1.5.
7. Coordinates:
Position:

e Provides the x,y,z coordinates for the object's anchor point. Entering new values redefines the posi-
tion.

[

K

Clicking on unlocks them.

e X Y, Z Rotation: Pivots the object.
Shift+click and dragging the cursor restricts the movement to 15° step.

Check ¥ i
8. Animation Settings1

locks the coordinates and clicking on

. to restrict the billboard to always face the camera.
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Light Objects

&y Edinshader.. =) @

@ y [ Editiight . =]

Coordinates
Position:

~|
2|

a |

TFaam | (346
Rotation
] ) [oea

Dimensions

o.15m 8ssm |

Animathon pararmeters

™ Keep proportions

) Noreal
) Orientation on the path
_) Orientation on the path, X,Y only

Preview Thumbnail.
Edit Shaders...

Choose the material to edit from the list, the Objects inspector switches to Shaders mode.
Light Objects...

Choose the light to edit from the list, the Objects inspector switches to Lights mode.

X, Y, Z Coordinates

Position: Provides the x,y,z coordinates for the object's anchor point. Entering new values redefines the posi-
tion.

Clicking on ~ ' Jocks them and clicking on “'" unlocks them.

Rotation: Pivots the object along the x, y and z axes.
Shift+click and dragging the cursor restricts the movement to 15° step.
Dimensions: for editing the parameters: length, width and height.

Click on the checkbox to maintain the proportions. Clicking again removes the restriction.

Animation settings

NB: Using the timeline, in a single sequence, the object can change behavior several times.

NB: A light object's light cannot be deleted from the Lights inspector list. This must be done from the
Objects list.

See "The Timeline Window" page 79
See "Editing Paths" page 63
See "Animatable Light Parameters" page 199
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Standard Objects

@ taitshader.. v
oordinates B

i
Position:

3136 m ~43.56m 0.26 m
Rotation:
o

—~ i =i
0.00 000 .00

Dimensions

@' wedm | | O6dm | | 0Bm |
L" Keep proportions

Animation paramerers

=) Norral
() Orientation on the path
[ Crientation on the path, X.Y only

Preview Thumbnail.
Edit Shaders...

DN

e Choose the material to edit from the list, the Objects inspector switches to Shaders mode.

w

X, Y, Z Coordinates

e Position: Provides the x,y,z coordinates for the object's anchor point. Entering new values redefines the posi-
tion.

e C(lickingon * ' Jocks them and clicking on “ unlocks them.

e Rotation: Pivots the object along the X, y and z axes.
Shift+click and dragging the cursor restricts the movement to 15° step.

4. Dimensions: for editing the parameters: length, width and height.
e Click on the checkbox fo maintain the proportions. Clicking again removes the restriction.

5. Animation settings

NB: using the Timeline, in a single sequence, the object can change behavior several times.

Object Animation

See "The Timeline Window" page 79
See "Editing Paths" page 69
See "Animatable Object Parameters" page 199

Vegetation Objects

Available in the media manager "Free VB Visual Plants Samples" Vol. 1 and 2.
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0% 200%
HESGHL: s— —
T <y [ :

Date

#) Use Heliodon Dare
o2 o )

Coordinates 1

Animation parameters
® Normal
() Orientation on the path

() Orientation on the path, XY onky o)

1. Preview Thumbnail.
Height:

e Using the slider or by entering a value in the field.

3. Transparency:

Used to render a vegetation object with greater or lesser transparency depending on the desired level of trans-
parency: values from 0 to 100. 0 means opaque.

NB: When the slider is at the end, typing a higher numerical value allows the sizes to go beyond the
end. The slider values will be updated accordingly.

4. Representation date:
e Choose: active heliodon date or calendar date.

m  Heliodon date: use the date of the active heliodon

m  Calendar: use the selected date.
5. X, Y, Z Coordinates

e Position: Provides the x,y,z coordinates for the object's anchor point. Entering new values redefines the posi-
tion.

e C(Clicking on ~ 4 locks them and clicking on - unlocks them.

e Rotation: Pivots the object along the X, y and z axes.
Shift+click and dragging the cursor restricts the movement to 15° step.

6. Animation settings

NB: Using the timeline, in a single sequence, the object can change behavior several times.

See "The Timeline Window" page 79
See "Working with Object Animations in 2D View" page 69
See "Animatable Object Parameters" page 199
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Animated Character Objects

nrry

e Available in the Media Catalog: Exterior, Furniture, Transport, etc. —

0% 00%
N e s [ 11
lor: | White B

Beniv; | Sit_Loop E ( : j

C—

o
Shader ——| CMan0016 -+ @
R
0.00

Reflection:
e—

Shininess: @
[
Bump: Lis :
2l ——— | 0.0

] Mix color | — |

Coordinates
Position:
X Y

1. Preview Thumbnail.
Rotation:

e Pivot the object on itself or enter a numerical value.
Shift +click dragged using the cursor limits the movement to a step of 15°.

3. Height:

e Using the slider or by entering a value in the field.

NB: When the slider is at the end, typing a higher numerical value allows the sizes to go beyond the end. The
slider values will be updated accordingly.

4. Color:
e Use the menu to choose the clothing color.
Behavior

5. Behavior: Use the menu to choose the character's attitude: standing, sitting, running, etc.

Shader:
6. Shader
o Select the material to be edited from the list.

7. Reflection, Shininess, Bump:
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o Reflection: drag the slider. When the diode is red, the texture reflects its environment. Double click on the red
diode to cancel the effect.

o Shininess: drag the slider to make the material become bright or enter a value in the related field.

e Bump: drag the slider to apply bump to materials or enter a value in the related field. Click on the red diode to
cancel the effect.

8. Mix Color:

e Check and click on the selector to choose a color.

Coordinates
9. X,Y,Z Coordinates

e Position: Provides the x,y,z coordinates for the object's anchor point. Entering new values redefines the posi-
tion.

e C(Clicking on ~ 4 locks them and clicking on - unlocks them.

Object Animation

See "The Timeline Window" page 79
See "Editing Paths" page 69
See "Animatable Object Parameters" page 199

Instanced Object

Principle: two objects: one table, one vase. The vase is placed on the table. If the table is moved, the vase follows the
movement

Instancing an Object

o [

| Name
| wScene
canap. 1
¥ Table-2_1
larmpe_1

- tapis_1

Using drag and drop:

e In Preview to another object
e In the list to the name of an object.

o In the list, the instanced object is shown off-center to the right under the reference object.
Delete a Dependency

e Drag and drop the dependant object to the "Model" name at the top of the list.

NB: The level of instances is unlimited.
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The Heliodons Inspector

Manages the calculations for sunshine according to the position of the sun, determined by the place, time and type of
sunshine. One heliodon may be associated with one or more viewpoints.

In this chapter you will learn about the following subjects:

City EdtOr. . . e 147
The Heliodons LSt . . . 147
Advanced Heliodon Parameters. . . . .. 148

=

Heliodons List: for handling heliodons on the list shown.

Sun light @ |
@ Location (D) Manm O as5*

Paris. ™ %
by 15/08/2004 1157  |»
il

Sky light

# Clouds

e ———
e Cirrocumulus T —
———
@ 10 =] CIM;@

Sunlight:

1. Rays of the sun projections: Location, Manual or 45°.
e Location: Select a city from the local menu.

2. City Editor: edits the list of cities

Set date and time:

o cither by clicking the arrows, editing the date dd/mm/yyyy and time hh:ss, or by moving the associated sliders.

20/10/2006 D859 =

4. Sunlight Power:

e Move the slider or type in a percentage value in the field. Clicking on the red diode resets the power to its initial
value.

5. Color Filter:

e Click on the color box to modify the color of the light coming from the sky. All elements in the scene receiving
projected light will be tinted with this color.
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NB: Does not tint the sky.

6. Shadows:
e The heliodon can cast shadows.The slider enables you to vary the shadows from hard to soft.

Light from the sky:

7. Power of light from the sky:

e Move the slider or type in a percentage value in the field. Clicking on the red diode resets the power to its initial
value.

8. Color Filter:

e Click on the color box to modify the color of the light coming from the sky.

NB: Tints the scene elements but not the sky.

Clouds:
9. Four types of cloud Cirrus, Stratus, Cumulus and Cirrocumulus.

e Move the slider or type a value into the numeric field to vary the size of the clouds.

10. Cloud distribution:

e Clickon @ to vary the distribution of the clouds or enter a value in the numeric field.
11.  Clouds mask sun:
e If'the box is checked, the sun remains behind the clouds. The sun rays will not be projected.

12. Click to open the Advanced Parameters dialog: pollution, halos, fog

NB: Clouds are visible in the current view if the 3D Sky option is set in the Viewpoints inspector.

Helindon Siy

6. Shadows:

City Editor
Heliodon List

Advanced Heliodon Parameters

NB: editing the scene information such as the infinite ground, movement of the origin, redimensioning of
the model and the coordinates may be accessed via the Window menu.

Heliodon Animation

See "The Timeline Window" page 79

See "Animatable Heliodon Parameters" page 198
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. .
City Editor
Iél
o :9
City Longitude
Perth 122723 || west I8y
Philadelphia Latitude
Riyadh '37°4E" || norn [
Raomie =
Salt Lake City 0 o Crnss |
San Diego

m' [ + 1 Hour Summer Time

¢ Cancel 9 \ oK 3

World Map

e The chosen city is circled in red. Clicking on the map points to the closest city.

i
L] Add creates a "New City":
m  Double click on "New City" to rename it. Adjust the longitude and latitude parameters.

NB: Alt+click to edit the longitude and latitude of the current city.
The mouse wheel provides dynamic zoom capability.

. Y Delete deletes a city
City

e Lists all cities. Clicking on a name selects this city and the position is instantaneously effective on the world
map.

Longitude and latitude

e Geographic position of the current city.
GMT
e Time difference (Greenwich Mean Time).

+ 1 in summer

The Heliodons List

o

opens the heliodons list. Double-click on the desired name to change it.
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Hellodon 12/01
Heliodon 20706
Heliodan 20710

o

3 g
The heliodons are classified alphabetically, clicking on "Name" at the top of the list modifies the alphabetical order of
the classification.

adds a heliodon, deletes the selected heliodon.

e Right clicking on a heliodon displays the contextual menu:

Delete

Denctivate for Current Wiew
Edit View Using This Heliodon
Activate View Using This Heliodon

v

Delete: The heliodon is removed from the list.
Activate for the Current View: Activates the heliodon for the current view (Name in bold).
Deactivate for Current View: Deactivates the heliodon for the current view.

Edit View Using This Heliodon: to choose a viewpoint, the inspector switches to Perspectives or Parallel
views, Panoramas, VR Objects or Animations mode.

Activate View Using This Heliodon: displays the chosen viewpoint in the preview window (the inspector
remains in Heliodon mode).

The Cut/Copy/Paste shortcuts are effective for the list.

Advanced Heliodon Parameters

Sky

® Pallution Factor T
<> 20
¥ Merge Sky Color With '.®

™ Sun lens flare
@ CIEEIE
=@

# Fog

@u.m + 1o ]
ibility Distance @

——— 25
r .
Animation parameters

™ wind ' £
POWEr (e '1.6@
@ [ Close 3

S

)

Sky:

1. Pollution factor:
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Fog:

8.

Move the slider or type in a percentage value in the field.
Merge Sky Color With:

Check the box to activate/deactivate the effect. Click the colored box to choose a color. The color is mixed with
the calculated sky color.

Luminous halo:

Check the box to activate/deactivate the effect.
Choose effect: Click on one of the four thumbnails.

Halo Power:
Move the Power slider or type in a value between 0 and 100%.
set fog parameters

Check the box to activate/deactivate the effect.

™ Fog

Seart distance 4 [osom
Visibility distance i
25.00 m

] -
Altitude — o

Calor

Starting distance: click | + | then, in the Preview window, click on the point from which the fog will be able to
be perceived, or enter a numeric value in the field.

Visibility distance: visibility distance begins at the starting distance. It provides the fog with a volumetric effect.

Altitude: Altitude takes effect from bottom to top. It depends upon the starting distance and the visibility dis-
tance.

Color: for assigning a color to the fog.

Animation settings:
used to animate the movement of the wind along with its direction.

9.

Wind

Check the box to activate/deactivate the effect.
Movement speed values go from 0 to 100.

The direction is specified using the circular slider, direction being relative to project North (see 2D view).

NB: Effective only in Artlantis Studio in animation mode

Page - 149



This page is left intentionally blank.



The Lights Inspector

Edit lighting schemes based on viewpoints. Interactive settings and immediate results in the Preview window. Using
the appropriate and correctly adjusted light model enhances the work carried out on the materials. Light groups may
be attached to one or more viewpoints. The lights are characterized by an illumination limit and a maximum illu-

mination area.

In this chapter you will learn about the following subjects:

Lights List.

=

| Lights List: for handling lights on the list shown.

Lighting
® ©
@ on @D OFF =i

Amenuation

—_@
@z

# Lens Flare
1 T 1
maam (9)
10 00 o

Coordinates

X ¥
®° 17esm  |[-382m  |[18
Target on:| Fixed Vertex

17.95m 3E2m 2.96 m

@

1. Select projection type

determines the lighting projection (fall-off) from 9 predefined types

2. On/Off
3. Color:

Double click to modify the source color.

4. Source power

Values from 1 to 1,000,000. Move the slider to change the power or enter a value.

5. Attenuation Distance

Calculates the attenuation distance for the lighting power.

Between the attenuation distance and source, the lighting power remains constant and at maximum.

The distance beyond distance A corresponds to the gradual diminishing of lighting power at 1/d  2;. When

the attenuation value equals 0, the light diminishes at 1/d  2; beginning at the light source.
Enter the distance in the numerical field (current unit).
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NB: In this area, the illumination principle is based on reality. The closer an object is placed to the
light source, the more illuminated it appears.

6. Change the Lighting Angle:
By sliding from 10 to 360° or by typing in a numerical value.
Example: A value of 360° provides an omnidirectional light.
7. Shadow projection
Activate/Deactivate shadow projection: Click on the box to check it.
8. Shadow type

Sharpness slider on the edge of the illuminated area. Values from 0 (diffuse area between the shadow area
and the illuminated area) to 100 (straight limit). Accepts a numerical value.

9. Luminous halo:
Activate/Deactivate: Click on the box to check it.

Halo Power: Move the Power slider or type in a value between 10 and 200%.

Choose effect: Click on one of the thumbnails:

10. X, Y, Z Coordinates: of the position of the light source and its target.

Clicking on " locks them and clickingon " unlocks them.

Activated target: choose between target on a fixed vertex or on an object defined as target.

NB: Editing the scene information such as the infinite ground, movement of the origin, redimensioning of
the model and the coordinates may be accessed via the Window menu.

Animations:

See "Editing Paths'" page 63

See "The Timeline Window" page 79

See " General Preview Display Shortcuts" page 213
See " Animatable Light Parameters" page 199

Lights List

e

opens the list of light groups.

SO
L] 1
| Name
Light
Lighe J
Ligohe 2
Light_3
W Light Group_1
Light_&
Light_5
Lighe &
wLight Group_2
Light_7
Ll &

The groups and their lights are classified alphabetically, clicking on "Name" at the top of the list inverts the alpha-
betical order of the classification.
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Double-click on the name of a group or a light to edit the name.

Moving a light from a group to another group is done by dragging and dropping.

Ghl
%% adds a light group,
qn

% adds a light at the current camera position if a group is selected. Duplicate the light if a light is selected.

. © deletes the selected light or group.

Light Group Pop-up Menu:

e Right clicking on the name of the group displays the contextual menu:

Delere

Deactivare for CUrrent View
[Edit View Using This Light Group 1 3

Paste: Pastes the clipboard contents
Delete: removes the selected elements.
Activate/Deactivate for Current View: the group takes part or otherwise in the lighting of the current view.

Edit View Using This Light Group: Choose the view point, the inspector switches to Perspectives or Par-
allel views, Panoramas, VR Objects or Animations.

Light Pop-up Menu:

e Right clicking on the name of the light displays the contextual menu:

Turn OFf
Duplicate
Cut

Copy
Delete

Edit View Using This Light ]

Activate/Turn off: the light

Duplicate: Creates a light identical to the current light.
Cut: The cut light is stored in the clipboard.

Copy: The copied light is stored in the clipboard.
Delete: Removes the selected lights.

Edit View Using This Light: Choose a viewpoint from the list. The chosen viewpoint is displayed in the pre-
view window. The inspector switches to Perspectives, Parallel views, Panoramas, VR Objects or
Animations mode accordingly.
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Selection and multiple editing of lights:

Lum_Cuis_3
; W Echairage travail

y £ Lumidre
—— :
w Platonnier_L
u
L
O O _ . Lz
B o— - by Travail
New light
& Lens Flare
10 200
e
(v
x ¥ z
o,
/3 - 2

T —
e

The Cut/Copy/Paste shortcuts are effective for the list.

To instantaneously assign a setting to several sources.

Select the sources by using:

Cmd click for a discrete selection. Shift click for a continuous selection.

The multiple selection is represented by hatching icons as well as dots in the numerical fields.
When you change a parameter, it will be changed for all selected lights.
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The Site Insertion Tool

In the Perspectives inspector , [nsertion enables the user to position a camera precisely vis-a-vis a model or photo.
Position a background image before using this command.

In this chapter you will learn about the following subjects:

Step 1 - Setting the Axis Markers in the 2D View. . ... . ... il 155
Step 2 - Setting the Axis Markers in the Preview Window.. .. ... ... .. .. . . . .. .. ... ... ... .. ... 156
Step 3 - Running the Insertion Calculation. . ... ... . . .. ... . . ..... 157

Opening the Insertion Command

Wide  Mormal Tele

. [ES

B

@&x Oy Oz
Use mouse wheel
'ﬂ or “+" or "-* keys to

2OOM in or oul.

# Show 30 Madel Q
Calculate
Cancel ) ( Vn.lidale)
e C(Click on

e The insertion dialog enables you to define the focal distance of the image, gives you the option of adjusting the
axes, and allows you to choose the reference axis, display the model and run/stop the calculation.

NB: When opening the dialog, the model from the preview window is hidden. The background image
remains, with a marker for the axes, which appear in red, green and blue.

Insertion is carried out in two steps: placement of a trihedron into the 2D view and into the Preview window.

Step 1 - Setting the Axis Markers in the 2D View

Setting the orthonormal marker on the geometry is performed in two steps in top view and in another view. If needed,
in the top view, pivoting one of the red or green axes will rotate the marker on the origin.
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0

Vue 2D

% a2 o= b

)
) @
D

*
+

The changes made to the axes in 2D View are not updated in the Preview window. This is why we must also set the
marker in this window. See step 2.

Step 2 - Setting the Axis Markers in the Preview Window

JEXEX:) Supermarket Start.atl (=)
o va2h o = [ >

Place the origin of the axis marker on the photo, then pivot the red, green and blue axes one by one.

NB: Make sure that the positions of the axes in 2D View and Preview do not conflict.

In the insertion dialog: Depending on the placement of the axes in preview, choose one of the following two view-
ing options:

3

The Y axis moves away from — " or towards

i

the camera.

Oy @

Determine the axis that will serve as a reference for sizing the 3D model in relation to the back-
ground image. Then, in the Preview window, adjust the size to the model by moving the yellow handle “. Do
the same in 2D View.

In the Preview Window: The magnifying glass helps you place the axis marker precisely on the background image.

To activate the magnifying glass, turn the mouse wheel. Each incrementation increases the zoom from x2 up to a max-
imum of x8.
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‘808 Supermarket Final.atl =

] vazao &) 3

Délai du dernier renduz. 74sec.

Step 3 - Running the Insertion Calculation

»
K # Show 3D Model

In the insertion dialog, chec . The model displays in Preview, and then launch U At any
time, the axes can be modified in real time in the Preview and 2D View windows. If the setting appears incorrect,

20 68 200
- ' ' '

modify the value of the camera focus wide  Mormal - Tele | adjust the slider or, if you know the value, re-enter
it directly into the appropriate field.

"

=

Sop stops the calculation.

YN Svpermarket Finalatd =)
o 04240 = k&

Délai du dernier renduz. 74sec.

NB: In order to avoid any inadvertent modification, when the insertion dialog is closed, the view locks auto-
matically.

To unlock it in the Perspectives inspector, open Coordinates, then click on the padlock &

To start again from the beginning, use the Cancel button.
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Post-Process Effect Filters

Enables the user to apply effect filters to the current view:

e The effects are added to the view, as well as to the parameters set in the viewpoint inspectors.
e The Post-Process effects are "viewpoint dependent”. Their settings do not affect other viewpoints.

e The check boxes activate/deactivate the effects.

In this chapter you will learn about the following subjects:

Tone Settings. ... ... ... . ...
Examples: Post-Process Rendering.

™ image Settings
. CDﬂ‘l;mif g
- " 'S o
=y —_—
. 1 3
_—
Saturation
@ g é ! o]
—— |
[ Mix Colar || '
™ Exposure -
o Exposure G —==
F Size
™ Grain
Brightness

¥ Edge and Pastel

i)}

Edge Intensity e
50
% Transparency
P | Eff ——
astel Effect %0
——C—
Set As Default 3
‘ ; Apply Defaults 3
Apply ta all )
& (o) @D

1. Image settings

Use the sliders or enter numeric values to set Contrast, Brightness and Saturation. Values from -100 to

100.

Clicking on the red diode cancels the effect.

The Mix Color box enables you to select a tint mix from the color picker, which will cover the entire image.

2. Exposure

Exposure: Determines the amount of light that enters the camera.
Size: Fluffs the effect to a greater or lesser extent.
Values from 0 to 100 for these two settings.

3. Grain:

Brighmess: Gives the image a granular appearance.
Size: Determines the size of the grains.
Values from 0 to 100 for these two settings.
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4. Edge and Pastel
Provides a photorealistic rendering mixed with crayon, or a completely crayoned rendering.
Edge intensity: Marks more or less the weight of the lines that determine the geometry contours.

Transparency: More or less masks the geometry while retaining the intensity of the contour and the pastel
effect.

Pastel Effect: Provides a crayoned rendering effect.
Values from 0 to 100 for these three settings.
Validate or cancel these settings to close the dialog again.
5. Saved settings
Define as default/Default settings/Apply to all perspective viewpoints:

Respectively allow the user to revisit Artlantis initial settings, to define current settings as the default or prop-
agate these settings to all other perspectives.

NB: Post-process effects are immediately visible in the Preview window.

When rendering, Artlantis always calculates in photorealistic rendering and applies the filters when the calculation is
finished.

Examples: Post-Process Rendering

Tone Settings

Tone Settings:

Darker
Light Tanes e 32
Lighter
Dark Tones = 28
G\! ( Cancet ) { OK )

L

Enables the user to apply tone settings filters to the current view:

e Light Tones: Move the cursor to the right to darken the lighter tones.
e Dark Tones: Move the cursor to the right to lighten the darker tones.

Examples: Post-Process Rendering

The effects can combine together to provide an extremely rich variety.

? o I—

Initial Photorealistic rendering
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Desaturation Contrast brightness and saturation

0

Contrast brightness and saturation Edge and pastel

-

Pastel Transparency and pastel
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Exposure Grain

Grain exposure edge and transparency Edge with no transparency
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Rendering

In this chapter you will learn about the following subjects:

Perspective Rendering Parameters. . . ... ... ... 163
Expert Mode Viewpoint Rendering Parameters in the '"Photorealistic" Engine. . .._._._. ... ... _._.... 164
ReNdeer. . . e 167
Rendering Animations. . . ... 167
Panorama Rendering . .. ... e, 168
Artlantis Batch Render. .. ... .. 171
The Batch Rendering Window. . .. ... ... e 173
The Partial Rendering Window. _ . ... 175
Panorama Rendering . .. ... e, 175
Parallel View Rendering Settings. .. ... . ... e 178
Panorama Rendering Parameters. .. ... ... ... .. ..., 180
VR Object Rendering Parameters. _ . . ... .. ..o 181
Animation Rendering Parameters. . .. ... ..., 183

Perspective Rendering Parameters

Accessible by:

e Clicking on the ~# | jcon available in the Perspectives inspector. The set values determine the rendering and

display in the Preview window.

Rendering size: | Special -:-;
jdth x Height: | 800 k= 600 | ¥
Resolution: 72 | dpi
Printing size:  0.28m —&— 0.2l m

E‘Anri—ﬂiasjng | High ‘ : '

™ Radiosity
Accuracy: | High

Lighting: | Custom

Set As Default

( Apply Defauits )

(" Apply 1o all Perspective Views )

" 4

(_Cancel ) (SS0KSS)

@

1. Display of rendering options for the "realistic photo' engine in the current mode
Rendering size
Print Resolution for Perspective View!

2. Anti-aliasing

Anti-aliasing: anti-aliasing Normal / High.

Page - 163



Chapter 15 i

Tip: to save calculation time, select a low value while increasing the Width/Height of the rendering.

3. Radiosity

The calculation times depend on the value chosen.

This menu allows you to set the precision parameters with predefined values. I you change the values with the sliders
or the text fields, the menu will be set to custom.

Precision : Normal / Average / High / Custom .
Lighting : Interior / Exterior / Custom.

NB: these settings have a very strong influence on the rendering time.

Tip: Calculate small-sized images or use the Batch Rendering command.

4. Application settings

Define as default / Default settings / Apply to all viewpoints for the selected inspector :

Respectively allow the user to define current settings as the default, to use the default settings or propagate these set-
tings to all other views for the inspector concerned.

NB: the display of options in expert mode is activated in the Preferences.dialog.

Expert Mode Viewpoint Rendering Parameters in the '""Photorealistic'' Engine

e Click on the = # ' icon available in the viewpoint and animation inspectors. The set values determine the ren-
dering and display in the Preview window.

NB: The display of options in expert mode is activated in the Preferences dialog.
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Rendering size; | Special 4

s
@id’thxntlghl: soo ~E— 600 | X
Resglution: 7z i

dpi

Printing size; | 0.26m —db= 0.21m

™ Anti-aliasing [ High ‘ : ,
[ High :Eﬂ

™ Radiosity

Accuracy:
95 ]
LOMG rAngs:  s——
0 48
SHOIE FANGE.  c——— 3,
Lighting: [ Custom -;3

First Dounce: e ie———— 1.50

1 16
Mext bounces: s r————— 1.50
o b
ANEAUATION!  e———— | (.90

Color bleeding:  se——— 0.70

{ Set As Default
( Apply Defaults

(" Apply to all Perspective Views )

"_’?‘) (_cancel ) oK)

1. Display of options in standard mode
Rendering size
Print Resolution for Perspective View!

2. Anti-aliasing

Anti-aliasing: Anti-aliasing Low/High

Tip: To save calculation time, select a low value while increasing the Width/Height of the rendering.

3. Radiosity

The calculation times depend on the value chosen.

This menu allows you to set the precision parameters with predefined values. If you change the values with the slid-
ers or the text fields, the menu will be set to custom.

Precision: Normal/Average/High/Custom.

NB: These settings have a very strong influence on the rendering time.

Tip: Calculate small-sized images or use the Batch Rendering command.
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o Widened oversampling: Values from 96 to 8 pixels.

The radiosity is calculated over a small number of pixels, the others are extrapolated. This distance represents
the mean distance in pixels between two points where radiosity is calculated. The lower the distance, the
more the density of calculated pixels increases.

NB: These settings have a very strong influence on the rendering time.

e Reduced oversampling: Values from 0 to 48 pixels.

This is the radiosity from near surfaces (e.g. the corner between 2 walls). This requires special processing
enabling shadow quality to be refined. The value selected represents the processing range. If 0, no calculation
is carried out. The larger the value, the better will be the calculation of shadows with regard to radiosity.

NB: These settings have a strong influence on the rendering time.

Lighting: Interior/Exterior/Custom.

These settings affect the general ambient lighting for the scene. They are used to precisely control how the scene is
exhibited.

The predefined settings Interior/Exterior give default lighting settings depending on the space chosen.

The Custom setting is used when the user opens a file prior to version 3 of Artlantis or when the lighting values have
been changed in expert mode.

NB: These parameters do not affect the calculation times.

Lighting power:

e First rebound: values from 1 to 16.

Controls the radiosity power of the first rebound (affects all surfaces receiving direct light from a heliodon or
light sources).

o Next rebounds: values from 1 to 16.
Controls the radiosity power of all rebounds after the first. This affects surfaces receiving indirect light.
Increasing the number of rebounds gives more light, particularly for interior scenes.

e Attenuation: values from 0 to 1.

Controls absorption of light after one or more surface rebounds. A low value increases the contrast of the
scene thus allowing strong shadows to be cast in an interior scene lit by indirect lighting.

NB: this parameter has almost no effect on exterior scenes.

e Color transfer: values from 0 to 1.
Controls the transfer of colors between surfaces.

Reducing the value desaturates the colors.
4. Application settings

e Define as default/Default settings/Apply to all perspective viewpoints

Allow the user to define the current settings as the default settings, to use the default settings or propagate
these settings to all other views for the inspector concerned.
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Render

Inspector Menu > Render

— @ Render Mow
. C e a )
Format: | JPEC ) £ Renter late (_Options...
E? Hide Extension [ New Folder ) (_Cancel w

Specify the name, destination of the file and format in the dialog box: JPEG*, BMP*, TGA, PICT, TIFF, Piranesi or
Photoshop**.

NB: * Formats that use the alpha channel. ** Photoshop PSD multi-layer format.

. Clicking on Options... opens the Rendering Parameters dialog.

. Render Now: Opens the rendering window, then displays the rendering progress and the estimated and
elapsed computation times. To stop the rendering click on the close box of the window.

° Render Later:

Postpones the rendering of the current viewpoint, the document is automatically saved. Rendering will be
done using Artlantis Batch Render.

NB: Batch rendering is managed later in the Inspector menu > Batch Rendering... It is processed by Art-
lantis Batch Render.

Rendering Animations

Inspector Menu > Render

Format: | Quicktime Movie )  (Options... ) ,@Re"der o,
SRS T . < (O Render Later
Compression Parameters
Codec: | MPEG-4 Video 5 Quality: ———————————
Min Max
# Hide Extension  { New Folder (cancel ) (Render Now)
Format:

e Specify the name, destination of the file and format in the dialog box: MOV, JPG or TGA

v Quicktime Movie
JPEG Files
TGA Files

Compression Parameters:

e Choose a Codec and a compression quality.
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Animation

Apple Pixlet Video
BMP

Cinepak
Component Video
DV - PAL
DV/DVCPRO - NTSC
DVCPRO - PAL
DVCPROSO - NTSC
DVCPROS0 - PAL
Graphics

H.261

H.263

H.264

JPEG 2000

Motion JPEG A
Motion JPEC B
MPEG-4 Video
None

Photo - JPEC
Planar RGE

PNC

Sorenson Video
Sorenson Video 3
TCA

TIFF

Video

<

Quality:

e Choose a compression rate:

Qualiry: Fa
Bin M

For low compression, move the slide to the left. For high compression, move it to the right.

e Clicking on Options... opens the Rendering Parameters dialog.

e Render opens the rendering window
Shows the progress and the estimated and elapsed time of calculation. Work on the project cannot continue at
the same time as the renderings.

e Postponed rendering saves the document.
Postpones the rendering of the current animation.

Stop Rendering in Progress.
Click on the "Close" box.

NB: Batch rendering is managed later in the Inspector menu > Batch Rendering... I is processed by Art-
lantis Batch Render.

Panorama Rendering

1- Rendering a Panorama:

Each rendered node is composed of six images saved in jpeg files. The file format of the panorama is html, to be
played on a web browser.

Select a destination folder.

Save As: | House.html =
Where: | [ test v4 -
Format: | HTML % © Render Now (Options... )
O Render Later L L
(_cancel ) (" Render Now )

The rendered panorama:

Page - 168



Rendering - Panorama Rendering N4

®00. RenderWindow

Elapsed time: 00:00:38 - Estimated Remaining Time: 00:05:07 14 11% (Step 11/24)

Into the destination folder, a folder with the name of the panorama is created. Inside are two folders named assets and
player and one html file with the name of the panorama.

(& assers
¥] House.html
(3 player -

The asset folder contains all jpeg square images of the panorama a promenade.xml file and a special folder.

i n_F6107F4F810FB4C2BBI7BTCIDEATIBSER. jpg
n_FO53858ADB4A54064EFSSE29CALCTBOES, jpg
n_FEEZEFFDEDOC3 459399 2EABF7ZFCET368.)pg
n_L2C00DEA4DEDI40DABBT 150BSADFAECED. jpg
n_L6107FAFE10FR4C2BEITETCIDEATIESES Jpg
n_L953B5BADE4AS4064EFSSE29CALCTBOES. jpg
n_LEEZEFFDADOCI4593992EABFT2FCET 368, jpg
n_R2CO0DEA4DED340DABE? 15085 ADFAECES jpg
n_RE1O7FAFELOFB4C2BBITETCIDBATIBSES jpg
n_R953858ADE4AS4964BF55E29CALCTBOSE jpg
B n_REEZEFFDBDOC3IA593992EARBFT2FCET 368 jpg
P n_UZCO0DEA4DEDI40DABE7 150BSADFAECES jpg
B n_UB107F4F810FE4C2BBI7E7CIDEATIBSES jpg
L]
a

[ House html

[ player

B
a
L)
-
=
E
L
2
L]

n_U35385BADB4AS4964BF55E29CA1CTEOBE jpg
n_UEEZE7FDED0C34593992EABF72FCETI6E. jpg
_ promenadd.xml
] w [l special .

The player folder contains the files necessary to run the panorama animation with a web browser, among them the
Flash swf file.

—5n

LS

e [

assets " j8 padd. s
House. htmil | paddplayer3.swif
player > * sharpness_filter.phj

B swlobject.js

A double click on the html file launches the current web browser, the panorama is displayed in a navigation window.
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Click and drag the cursor into the window, the camera turns on itself at 360°.

To move from a node to an other one:

They are two ways to switch from one node to another: One is using the thumbnails list and one is using the sensitive
triangles.

A- Using the thumbnail previews list:

Move the cursor into the lower part of the window a drawer displays the thumbnails of the panorama nodes.

Click on a thumbnail to switch to an other node.

B- Using the sensitive points displayed into the window

The sensitive points are the blue triangles followed by their names, a click on a triangle or its name to navigate to this
node.

To display a full screen the panorama click on the icon - in the lower right corner of the Web page.

2- Navigation option:

Another way to navigate into a 3D base is to overlap to the 3D View on the associated plan level, then to navigate
from one node to an other one by a click on a triangle or its name, doing so it switches to the corresponding node and
hides the plan level.

We just need to associate these plan levels with the already rendered panorama.

To do so:

Activate the parallel inspector then select the Type of projection: Top. In case of multiple levels create as many Top
views as necessary.
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Very important: to keep the level hierarchy of the 3D base, the name of the points of views must be set on 2 digit
numbers (space before between or after the digits are not allowed) Example: 00, then 01, 02... where 00 rep-
resents the basic level.

In 2D View, display an elevation view (Front, Right, Left or back). Set the point of view by moving the camera and
the target. See " Working with Parallel Views in 2D View" page 37

The point of view will refer to the higher part of the plan shown into the navigator.

Render the levels and save them into the special folder located into the asset folder when we rendered the panorama
(as explained previously)See "1- Rendering a Panorama:" page 168.

1,
When launching the panorama a new button will get displayed into the left corner of the window. =

A click on the icon displays the plan level centred into the window. Another click on the icon hides the current plan
level.

02.jpg (2/2)

When the plan level is displayed its name is showed at the top of the plan.

The sensitive nodes of the panorama are displayed on the plan. The current node is surrounded by a dynamic red cir-
cle. A click on a node will hide the plan and display the associated point of view in the navigation window.

To navigate from a plan level to an other use the arrows placed to the left or to the right of the plan.

Flash Player from Adobe company must be installed to perform the reading of the panorama.

http://www.adobe.com/support/flashplayer/downloads.html

Artlantis Batch Render

Artlantis Batch Render is an application independent of Artlantis. It launches the Artlantis batch rendering cal-
culation. It is located into the installed Artlantis folder.

When launched, the render later manager displays the waiting renderings.
If in Artlantis no Render later documents have been saved, then the list is empty.
If Render later documents have been saved the documents are listed.

The render later list manager can be used to change settings on documents to render, thus editing the rendering set-
tings without reopening the Batch Rendering window of Artlantis.
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NOe Batch Rendering —i

O B

Delete view Recalculate Render

@
S image Type: | TGA ] image Naming: [_indexed 19

Destination: [ Choose Folder... | /Users/picard/ Desktop/Artlantis 4 alpha/test v4

Document Name | View Name Kind

™ © House-va-2.atl House Panorama
L e House Perspective
Vi) Exterior 1 Perspective
@ O House-v4-2.atl Interior 15t floor Perspective
! & House-va-2.atl Interior 2d floor Perspective
# © House-vd-2.atl Sequence Sequence

© House-v4-2.atl VROBJECT 0 VR Object
[] & House-v4-2.atl Vue paralléle Pasallel
E 2 House-vd-2.atl Vue paralléle_1 Pasallel
# © House-va-2.atl Sequence Sequence

Image caloulée: (Users/picard/Deskiop/Artlantis 4 alpha/test v4/ Exterior Liga

Toolbars

° o Deletes the selected view

e — Mark the selected view as needed to be calculated, even if it has already been rendered.

. LHz] Launches the rendering. The Rendering windows is opened.
e [mage type: to redefine the rendering image format: JPEG, BMP, TGA, PICT, PNG, TIFF, Photoshop,
Piranesi or HTML or movie formats.
e [ndexed: names of renderings with the same name will be indexed numerically
or
e Replaced: the name of a render with the same name will replace the existing file.

Indexed
Imag

Destination: the destination of the rendering file can be redefined by clicking on the Folder button.

The Document List:
e Check the box opposite the name of the image in the list. This image will be rendered later.

m  Document name: the name of the atl file
m  View Name: the name of the viewpoint
m Kind: type of viewpoint; Perspective, Parallel, Panorama, Animation or VR object.

Diodes: color codes
Diode Status Comments
Gray Not rendered yet Waiting for processing by Artlantis Batch Render if the box is
checked.
Green Rendered
Orange  Error during rendering Check the information at the bottom of the Batch Rendering window
Red Not rendered due to one or more Check the information at the bottom of the Batch Rendering window
errors
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The window makes it possible to track the progress of the listed renderings. Each rendering displays a small progress
image (1). A report (2) provides details on:

e The location of the document and the image calculated on the disk.
e The size of each image and the time it took to render.
e Potential problems with the location of textures, Shaders, etc.

OO0 Artlantis Batch Render

m Artlantis Batch Render ©

Abvent

Current rendering &5

Elapsed time: 00:00:15 - Estimated Remaining Time: -——-—1-- - 1/1 - Rendering Preview
Total

Batch fila contains 80 document(s) including B0 1o compute

Processing document..,

Loading Documant: /AUsers/mjeanirancois/PublicLon_San22on_Sart22.al
Preparing data...

(_Quie ) e

Quit
e The Quit button closes the application, even if a calculation is in progress. The interrupted calculation infor-

mation remains in the batch render document (BatchRendererDocument.xml). Relaunching Artlantis Batch
Render will restart where it was stopped.

Pause

e Stops the image calculation in progress.

Resume

e Resumes the currently paused image calculation.

The Batch Rendering Window

All batch renders are processed by the "Artlantis Batch Render" application.

Inspector Menu > Batch Rendering.

The Artlantis rendering manager displays the list of items that are to be processed.
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@ @] | Add all E-]

Delete view Recalculate Add all views of the chasen type.

@ Image Type:| TGA ;] Image Naming: | Indexed -:]

Destination: ( Choose Folder... ) fUsers/picard/Desktop/Artiantis 4 alpha/test vd

Document Name & View Name Kind

E © House-vd-2.atl House Panorama
B -2, House Perspective
™ © House-va-2.atl Interior 15t floor Perspective
| © House-vd-2.atl Interior 2d floar Parspective
™ © rHouse-va-z.ail Sequence Sequence
[ © House-vd4-2.atl VROBJECT 0 VR Object
[ ©® House-vd-2.atl Vue paralléla Parallel

M © House-wvd-2.atl Vue paralléle_1 Parallel

™ © House-va-2.atl Sequence Sequence

Image calculée: Users/picard/Desktop/Artiantis 4 alpha/test va/ Exterior 1.1ga

Toolbars

° o Deletes the selected view

e — Mark the selected view as needed to be calculated, even if it has already been rendered.

. M of the current project to the list of views that need to be rendered.

e [mage type: to redefine the rendering image format: JPEG, BMP, TGA, PICT, PNG, TIFF, Photoshop,
Piranesi, html or movie formats.

e [ndexed: names of renderings with the same name will be indexed numerically
or

e Replaced: the name of a render with the same name will replace the existing file.

Indexed
Imnag

o Destination: the destination of the rendering file can be redefined by clicking on the Folder button.

Viewpoints List:
e Check the box opposite the name of the image in the list. This image will be rendered later.

m  Document name: the name of the atl file
m  View Name: the name of the viewpoint
m  Kind of view: type of viewpoint; Perspective, Parallel, Panorama, Animation or VR object.

Diodes: color codes

Diode Status Comments
Gray Not rendered yet Waiting for processing by Artlantis Batch Render if the box is
checked.
Green Rendered
Orange  Error during rendering Check the information at the bottom of the Batch Rendering window
Red Not rendered due to one or more Check the information at the bottom of the Batch Rendering window
errors
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The Partial Rendering Window

Calculates part of the content of the Preview window.

Inspector Menu > Partial Render

1. Draw a rectangle in the Preview Window. The Render window showing the progress is displayed.
866 = Island_Final-4.at| =N
® Pazro B B & L4 B =

2. Defining the rectangle

‘man & Island_Final-4.atl

@ Brzac B B @ @ & =

Last rendering time: 2. Lasec.

CIEXE]

Elapsed time: 00:00:57 - Estim:

ime: 00:0023 - 171 - Anti-aliasing ~

— ¥ =
= ‘ =S
-

4

3. Render window showing the progress of the calculation.

Panorama Rendering

1- Rendering a Panorama:

Each rendered node is composed of six images saved in jpeg files. The file format of the panorama is html, to be
played on a web browser.

Select a destination folder.

Save As: | House html 1=

Where: [ [ test v4 a

o ® Render Now
Format:  HTML E O Render Later ‘Options...

The rendered panorama:
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@00 RenderWindow

Elapsed time: 00:00:38 - Estimated Remaining Time: 00:05:07  1j4  11% (Step 11/24)

Into the destination folder, a folder with the name of the panorama is created. Inside are two folders named assets and
player and one html file with the name of the panorama.

(& assers
'¥] House.html
(3 player -

The asset folder contains all jpeg square images of the panorama a promenade.xml file and a special folder.

[l assets

& n_FELO7FAF810FB4CZBBITETCIDEATIESES.jpg
n_F953858ADB4A54064BF55E29CALCTBOES. jpg
n_FEEZEFFDSDOC3I4593902EABF72FCET3GB.\pg
n_L2CO0DEA4DED340DABBT 150B5ADFAECED jpg
n_LE107FAFE10FB4C2BBITBTCIDEATIESES Jpg
n_L953858ADB4A54964BF55E29CALCTBOES. jpg
n_LEEZEFFDSDOC34593992EABF72FCET 368 Jpg
n_R2ZCO0DEA4DED3I40DABET L50B5ADFAECES jpg
n_RELO7FAFB10FBAC2EBOTETCIDEATIBSES.Jpg
n_RI53B58ADE4AS4964BF55E29CALCTRBOBE jpg
n_REEZEFFDSD0OC34593992EABF72FCET368.jpg
n_UZC00D6A4DED340DABET 150BSADFAECES jpa
n_UG107F4F8 10FE4C2EBITB7CIDEATIBSES. jpg
n_U35385BADB4A54964BF55E29CALICTEDBE jpg
n_UEEZE7FDED0C3I4593992EABF72FCET 6B jpg
_ promenadd.xml
n " ﬁ special -

[& House.html
[ player v

(D e

The player folder contains the files necessary to run the panorama animation with a web browser, among them the
Flash swf file.

—a

L

e [

assets " B padd s
House, htmil | paddplayer3.swif
player " " sharpness_filter.phj

B swiobject.js

A double click on the html file launches the current web browser, the panorama is displayed in a navigation window.
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Click and drag the cursor into the window, the camera turns on itself at 360°.

To move from a node to an other one:

They are two ways to switch from one node to another: One is using the thumbnails list and one is using the sensitive
triangles.

A- Using the thumbnail previews list:

Move the cursor into the lower part of the window a drawer displays the thumbnails of the panorama nodes.

Click on a thumbnail to switch to an other node.

B- Using the sensitive points displayed into the window

The sensitive points are the blue triangles followed by their names, a click on a triangle or its name to navigate to this
node.

To display a full screen the panorama click on the icon - in the lower right corner of the Web page.
2- Navigation option:

Another way to navigate into a 3D base is to overlap to the 3D View on the associated plan level, then to navigate

from one node to an other one by a click on a triangle or its name, doing so it switches to the corresponding node and
hides the plan level.

We just need to associate these plan levels with the already rendered panorama.

To do so:

Activate the parallel inspector then select the Type of projection: Top. In case of multiple levels create as many Top
views as necessary.
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Very important: to keep the level hierarchy of the 3D base, the name of the points of views must be set on 2 digit
numbers (space before between or after the digits are not allowed) Example: 00, then 01, 02... where 00 rep-
resents the basic level.

In 2D View, display an elevation view (Front, Right, Left or back). Set the point of view by moving the camera and
the target. See " Working with Parallel Views in 2D View" page 37

The point of view will refer to the higher part of the plan shown into the navigator.

Render the levels and save them into the special folder located into the asset folder when we rendered the panorama
(as explained previously)See "1- Rendering a Panorama:" page 175.

—,
When launching the panorama a new button will get displayed into the left corner of the window. =

A click on the icon displays the plan level centred into the window. Another click on the icon hides the current plan
level.

02.jpg (2/2)

When the plan level is displayed its name is showed at the top of the plan.

The sensitive nodes of the panorama are displayed on the plan. The current node is surrounded by a dynamic red cir-
cle. A click on a node will hide the plan and display the associated point of view in the navigation window.

To navigate from a plan level to an other use the arrows placed to the left or to the right of the plan.

Flash Player from Adobe company must be installed to perform the reading of the panorama.

http://www.adobe.com/support/flashplayer/downloads.html

Parallel View Rendering Settings

Accessible by:

e Clicking the = # ' icon available in the Parallel Views inspector. The set values determine the rendering and
display in the Preview window.
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Rendering size: | Special ]
idth % Meight: | 320 =F= 240 |
Resalution: | 72 | dgi
Scale = 1 1498 %)
m.ﬁmi-aliasing Lawws ‘ : '
i Radiosity
ALTUTACY! Normal
Lighting: | Custom
{ Set As Defaul ;
@ [ Apply Defaults )
f ™

Apply to all Parailel Views

x

65 _ Cancel "{P OK \

1. Display of rendering options for the "realistic photo" engine in the current mode
Same parameters as for rendering Perspectives, except for printing.
Rendering size
Print Resolution for Parallel View!

2. Anti-aliasing

Anti-aliasing: anti-aliasing Normal / High.

Tip: to save calculation time, select a low value while increasing the Width/Height of the rendering.

3. Radiosity

The calculation times depend on the value chosen.
This menu allows you to set the precision parameters with predefined values. I you change the values with the sliders
or the text fields, the menu will be set to custom.

Precision : Normal / Average / High / Custom .
Lighting : Interior / Exterior / Custom.

NB: these settings have a very strong influence on the rendering time.

Tip: Calculate small-sized images or use the Batch Rendering command.

4. Application settings

Define as default / Default settings / Apply to all viewpoints for the selected inspector :
Respectively allow the user to define current settings as the default, to use the default settings or propagate these set-
tings to all other views for the inspector concerned.

NB: the display of options in expert mode is activated in the Preferences.dialog.
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Panorama Rendering Parameters

Accessible by:

e Clicking on the * * | jcon available in the Panorama inspector. The set values determine the rendering and dis-
play in the Preview window.

Flash Player Size: | &S00 x 00 Small -;-]
Width x Height: | 00 =k = 600 ' f
Rendering size: | 640 x 640 ﬂ
M Anti-aliasing | Low |
[+ Radiosity
Accuracy: Mormal ﬂ
Lighting: | Interior [

Sat As Default

Apply Defaulis

-

-

Apply to all Panoramas

-

{'_-7\' ( cCancel ) oOK

1. Display of rendering options for the "realistic photo' engine in the current mode

Flash Player size: Defines the size of the Flash player.
Small 800 x 600, Normal 900 x 500 (iPad), Large 1280 x 720

« BOD x 600 Small
GO0 x 500 Mormal
1280 x 720 Large
Special

e Select a size from the menu or
o Enter the Width and Height in pixels of the Flash Player.

The size represents the default display in the rendering window.

X

o Increase/decrease the values by two by clicking on the = icons.

Rendering size
The size in pixel of the calculated images. The rendering is always in a square format.
Select a size from the drop down menu: 640 x 640, 1024 x 1024, 1600 x 1600 or 2048 x 2048.

640 x 540
1024 x 1024

1600 x 1600

2048 x 2048

Recommended size:
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e 640 quick check or small Web format.

e 1024 Web page usage and for iPad (1 or 2) and iPhone.
e /600 local usage with Flash

e 2048 local usage with Flash or for iPad 2 in HD.

Choosing a higher value definition gives a better quality, especially when zooming in the navigator. But it will need a
longer rendering time.

NB: The nodes of the panorama are composed of six square images.

2. Anti-aliasing

Anti-aliasing: anti-aliasing Normal / High.

Tip: to save calculation time, select a low value while increasing the Width/Height of the rendering.

3. Radiosity

The calculation times depend on the value chosen.

This menu allows you to set the precision parameters with predefined values. I you change the values with the sliders
or the text fields, the menu will be set to custom.

Precision : Normal / Average / High / Custom .
Lighting : Interior / Exterior / Custom.

NB: these settings have a very strong influence on the rendering time.

Tip: Calculate small-sized images or use the Batch Rendering command.

4. Application settings

Define as default / Default settings / Apply to all viewpoints for the selected inspector :

Respectively allow the user to define current settings as the default, to use the default settings or propagate these set-
tings to all other views for the inspector concerned.

NB: the display of options in expert mode is activated in the Preferences.dialog.

VR Object Rendering Parameters

Accessible by:

e Clicking on the * * ' icon available in the VR Object inspector. The set values determine the rendering and dis-

play in the Preview window.
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Rendering Size: | 320x240 Small -:-]

@xnemm: 320 ~FL- 240

Number of images: 52

mAnli—lliasing | Low ' : '
™ Radiosity

Accuracy: | Koremal

Lighting: | Custom

¢ Set As Default

@ Apply Default

Apply 1o all VR Objects

@ (_Cancel ) EoOK)

1. Display of rendering options for the "realistic photo" engine in the current mode

Rendering size

Number of images: Information on the number of images to be rendered to make up the VR objects depending on ver-
tical and horizontal step.

2. Anti-aliasing

Anti-aliasing: anti-aliasing Normal / High.

Tip: to save calculation time, select a low value while increasing the Width/Height of the rendering.

3. Radiosity

The calculation times depend on the value chosen.

This menu allows you to set the precision parameters with predefined values. I you change the values with the sliders
or the text fields, the menu will be set to custom.

Precision : Normal / Average / High / Custom .
Lighting : Interior / Exterior / Custom.

NB: these settings have a very strong influence on the rendering time.

Tip: Calculate small-sized images or use the Batch Rendering command.

4. Application settings

Define as default / Default settings / Apply to all viewpoints for the selected inspector

Respectively allow the user to define current settings as the default, to use the default settings or propagate these set-
tings to all other views for the inspector concerned.

NB: the display of options in expert mode is activated in the Preferences.dialog.
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Animation Rendering Parameters

Accessible by:

e Clicking on the * # ' icon available in the Animations inspector. The set values determine the rendering and
display in the Preview window.

ndering Size: | 76Bx576 PAL G]
e -4
idth x Height: 768 = = 5TH &

¥ Render from Frame a w 250

Number of images: 251

mAnli—aliasing | Low ‘ : J

™ Radiosity

Accuracy: | Mormal

Lighting: | Custom

{ Set as Default )
@ { Apply Defauits )

Apply 10 all Sequences

) (" Cancel l:' Ok '1

1. Display of rendering options for the "realistic photo'" engine in the current mode
Film size

. Select a size from the menu or enter the width and height in pixels.
X

. Increase/decrease the values by two by clicking on the = signs.

Render from X to Y Image. Enter the numbers of the corresponding images to calculate a portion of the sequence.
First Frame is set to 0.

Number of images: Information on the number of images or selected frames to be rendered to make up the animation.
2. Anti-aliasing

Anti-aliasing: anti-aliasing Normal / High.

Tip: to save calculation time, select a low value while increasing the Width/Height of the rendering.

3. Radiosity

The calculation times depend on the value chosen.

This menu allows you to set the precision parameters with predefined values. I you change the values with the sliders
or the text fields, the menu will be set to custom.

Precision : Normal / Average / High / Custom .
Lighting : Interior / Exterior / Custom.

NB: these settings have a very strong influence on the rendering time.

Tip: Calculate small-sized images or use the Batch Rendering command.
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4. Application settings

Define as default / Default settings / Apply to all viewpoints for the selected inspector

Respectively allow the user to define current settings as the default, to use the default settings or propagate these set-
tings to all other views for the inspector concerned.

NB: the display of options in expert mode is activated in the Preferences.dialog.
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The Panorama Inspector

In this chapter you will learn about the following subjects:

Panorama Last i 186

v
| Panorama List: for handling panoramas on the list shown.

ama.

in mm

———
& Depth of field
il S T
i Show ™ Activate 67 °
Lighting
@ Nane 24
¥ Light Group vl
. color : Neon Light -]
il layers
Scene;Plantes 3D;0bjets lumiére bwi]
Enviranment
Background Foreground
[ 20 image 3
Coordinates
X ¥ Z

@us.zam -23.36m | 543m
(" Make First Node
2

1. Panorama

Focal Length: Changes the focal length when the slider is used or a value is entered in mm or degrees
(adjusts the angular opening of the camera).

Depth of Field: click = then, in the Preview window, click to define the clear point of the scene, with the
rest remaining blurred. The cursor adjusts the blur amount.
Clipping Box: for defining clipping planes.
Show: in 2D View
Activate: Representation in Preview mode
2. Lighting

To handle light schemes linked to the view, select them from the drop-down menus.

Heliodon: links a heliodon to the view. Selecting "None" deactivates the heliodon.

Light Group: Links one or more light groups to the view. Selecting "None" deactivates the light groups.

Neon Shaders: Links one or more Neon Shaders to the view. Selecting "None" deactivates the lighting.
3. Environment

Handles the background and foreground of the scene.

Defining a Background: Background type: 3D Sky, Gradient, 2D Image, 3D Image, 3D Cubic

Foreground Images

4. Visible layers: check them in the drop-down menu.
5. Coordinates
Camera XYZ Position.

Clicking on - locks them and clicking on unlocks them.
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6. Tone settings

Set the Tone for the current view.

7. Post-production

Applies effects to the current viewpoint: The effects combine into, as well as with the parameters set in the
inspector.

8. Rendering Parameters

Prepares the document for final rendering.

NB: Editing the scene information such as the infinite ground, movement of the origin, redi-
mensioning of the model and the coordinates may be accessed via the Window menu.

Panorama List__|

=

opens the panorama list. Each is displayed by name and preview thumbnail.

&

Mame

o

el o)

¥ House
Swimming pool

st flear
2d flear
¥ House
Swimming pool

To edit, double-click on the name.

g}‘ duplicates the selected panorama and its first node

LH

duplicates the selected node or the first node if the panorama is selected (In 2D View the new node over-
laps the duplicated node).

. o deletes the selected item from the list.
Panorama Pop-up Menu
e Right-clicking on a view displays the pop-up menu:

Duplicare
Delete

Add 1o Perspective View List
Add 1o Parallel View List
Add 1o VR Object List

Add 1o Sequence List

Edit Heliodon
Edit Light »

Make First Mode

Duplicate: use the original to create a new superimposed panorama or node.

Delete: the panorama or the node is removed from the list.

Add to: Perspectives List:
Add to: Parallel Views list:

Add to: VR Object List:
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Add to: Animation list:

Depending on the option selected, adds current view from Panoramas to Perspectives, Parallel Views, VR
Objects or Animations.

Edit Light: select a light, the inspector palette switches to Lights mode and the light is selected.

Edit Heliodon: The palette inspector switches to Heliodon mode and the heliodon is selected.

Make First Node: The selected node becomes the First Node, this is the first one displayed when playing the
panorama. When the node is already the first node a disabled "Is First Node" item is displayed.

Create links between nodes
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The VR Objects Inspector

Manages viewpoints defined by a camera, a target and a focal length. Each viewpoint is considered to be an inde-

pendent document with its own parameters which can receive its own environment.

A VR Object view is made up of several images taken from different points in a sphere. A view is defined by a cam-
era that moves in a sphere, a target, the center of the sphere and a focal length, as well as two horizontal and vertical

angular movement steps.

In this chapter you will learn about the following subjects:

VR Object LSt . .. e 190

3

VR Object @ k24

= ] H o
ot |

52 Focal in degrees

os  ——— [s0
@ M Depth of field 7y
™ show ™ Acivare [0 ®
Lighting
.-.'.‘UI';Q @
@ fmreson =
(None -]
Vigible layers

| Scene:30 Plants;Light Objects:a

Environment

Background Foreground
[(amimge  73)
Coordinates
X i z
75m 55.44 m 3l.54m
oriz. Shift  Horlz. Angle Radius
o 360 4.26 m

—1

]

1. VR object Navigation

VR projection choice: lHemispherical,

VR Object List: for managing VR objects on the list shown.

Torus,

Spherical.

Modifying values in angular horizontal and vertical step degrees.

Number of images: Indicates the number of images that will be needed to calculate the VR objects. This
number is dependent on the values defined for the angular horizontal, vertical steps and the horizontal angle.

Focal Length: Changes the focal length when the slider is used or a value is entered in mm or degrees

(adjusts the angular opening of the camera).

NB: An angular step of 10 degrees provides a good compromise between the number of views
needed (size of the file) and fluidity (vour objects will not be jerky).

Depth of Field: click s then, in the Preview window, click to define the clear point of the scene, with the

rest remaining blurred. The cursor adjusts the blur amount.

Clipping Box: for defining clipping planes.

Show: in 2D View

Activate: Preview Representation

Page - 189



Chapter 17

N

=

6.

Lighting:
To handle light schemes linked to the view, select them from the drop-down menus.
Heliodon: links a heliodon to the view. Selecting "None" deactivates the heliodon.
Light Group: Links one or more light groups to the view. Selecting "None" deactivates the light groups.
Neon Shaders: Links one or more Neon Shaders to the view. Selecting "None" deactivates the lighting.
Visible layers: check them in the drop-down menu.
Environment:
Handles the background and foreground of the scene.
Defining a Background type: 3D Sky, Gradient, 2D Image, 3D Image, 3D Cubic
Foreground Images

Coordinates:
XYZ Position of Center of VR

Clicking on * 1" Jocks them and clicking on “ unlocks them.

Horizontal Constraint: According to the trigonometric circle, turns the opening point of the VR object. Enter
a value in degrees.

Horizontal Angle: For restricting the opening angle. Enter a value in degrees.
Radius: the radius of the VR.

Post-Production:

Applies effects to the current viewpoint. The effects combine into, as well as with the parameters set in the
inspector.

7. Rendering Parameters:

Prepares the document for final rendering.

NB: Editing the scene information such as the infinite ground, movement of the origin, redimensioning of

the model and the coordinates may be accessed via the Window menu.

VR Object List —J

|1—

opens the viewpoint list. Each is displayed by name and preview thumbnail.

& &

Name

e Double click on a name to edit it.
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, &

VR Object Pop-up Menu

adds a viewpoint; ‘as’ deletes it.

e Right clicking on a view displays the pop-up menu:
Duplicate
Delete

idd 1o Perspective View List
add to Parallel View List
#Add to Panorama List

Add 1o Seguence List

Edit Heliodan

[Edit Light 1 3

Duplicate: Uses the original to create a new superimposed viewpoint.
Delete: The viewpoint is removed from the list.

Add to: Perspectives list

Add to: Parallel Views List

Add to: Panoramas List

Add to: Animations list

Depending on option selected, adds current view from Perspectives to Parallel Views, Panoramas, or
Animations.

Edit Light: Choose a light. The inspector palette switches to Lights mode, and the light is selected.
Edit Heliodon: The palette inspector switches to Heliodon mode and the heliodon is selected.
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The Animations Inspector

Animations: General Information
A Sequence is defined by a camera: A viewpoint, an aim point and a focus distance.
Each sequence is considered as an individual document with its own parameters.

In this chapter you will learn about the following subjects:

General Animation Imformation. . _ . .. 194
S OQUEIICE. - . . 194
Real Time Display:. . .. ... e 195
Elements that can be animated. _ . . ... ... 195

AnImations LSt | . 195

Animation Coordinates. . .. ... .. .. ... 196

Animatable Camera Parameters. . . ... .. ... ... 197
What can be animated. .. . ... 197
What cannot be animated. .. ... ..o 198

Animatable Heliodon Parameters. .. ... .. .. . .. ..., 198
What can be animated. .. ... ... 198
What cannot be animated. . . ... 198

Animatable Light Parameters. . . ... . ... 199
What can be animated. ... ... 199
What cannot be animated. . . .. ... ... 199

Animatable Object Parameters. .. .. ... .. 199
What can be animated. .. . ... 199
What cannot be animated. .. ... ... 200

3

Animations List: for managing animations on the list shown.

Animation @ 2 @
Focal in
e ———
o Depth of field L
@ +
= %

W Show ™ Activate [0

Lighting
Helisdon_4 |
["Lumiere_Salon -!
NOHE - 1
Vigible layers
@ Scene;3D Plants;Light Objects;A » |
viranment
Background Foregrownd

Coordinates

15068m 24.99m .54 m

Target on; | Fixed Vertex ; :'_
Z
-27.23 m 15, 34 m

Camera Roli: o o0

@
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1. Animations
Depth of Field: click ' * | then, in the Preview window, click to define the clear point of the scene, with the
rest remaining blurred. The cursor adjusts the blur amount.
Clipping Box: for defining clipping planes.
m Show: in 2D View
m  Activate: Preview Representation
2. Lighting

To handle light schemes linked to the view, select them from the drop-down menus.

Heliodon: links a heliodon to the view. Selecting "None" deactivates the heliodon.
Light Group: links one or more light groups to the view. Selecting "None" deactivates the light groups.
Neon Shaders: Links one or more Neon Shaders to the view. Selecting "None" deactivates the lighting.
3. Visible layers: check them in the drop-down menu.
4. Environment:
Handles the background and foreground of the scene.
Defining a Background: Background type: 3D Sky, Gradient, 2D Image, 3D Image, 3D Cubic.
Background type: Foreground Images

5. Coordinates:

6. Post-Production: Applies effects to the current viewpoint: The effects combine into, as well as
with the parameters set in the inspector.

7. Rendering Parameters: Prepares the document for final rendering.

NB: Editing the scene information such as the infinite ground, movement of the origin, redimensioning of
the model and the coordinates may be accessed via the Window menu.

See " Working with Camera Animation in 2D View" page 55
See " Working with Light Animation in 2D View" page 63
See "Working with Object Animations in 2D View" page 69
See "The Timeline Window" page 79

See "General Preview Display Shortcuts" page 213

B
General Animation Information —

Animation makes it possible to produce and play a scene made up of one or more sequences.

Sequence

A sequence retraces the camera path in time.

NB: The camera may also be a fixed plane in which object lights, or a heliodon are animated.

The camera path is processed in:

e The Animations Inspector, (animating parameters, focal distance, association to lighting groups, depth of
field, roll, etc.).

e The Timeline window, (time management).

e The Preview Window (managing camera targets).
e The 2D View. (Managing paths: cameras, lights, objects).

Animating in a sequence of parameters for other inspectors:

Parameters respectively accessible from:
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e Lights Inspector*: [llumination configurations
e Heliodons Inspector*: Heliodon configuration

e Objects Inspector*. Object configurations
e 2D View: Creating and editing paths for moving cameras, lights and objects.

e Timeline Window: Creating and editing keyframes (changing parameter of an element at a T instant, inter-
polation of parameter changes between two keyframes), synchronizing keyframes of elements that either belong
or do not belong to the same inspector.

~ NB: To animate the parameters for light, heliodon and object inspectors, they must first be displayed in the

Animation Inspector before being displayed in the relevant inspector, i.e. light, heliodon, object.

Real Time Display:
e Preview Window: Shows and plays in real time the result of adjustments.

Elements that can be animated

All elements can be animated except for those related to the Shader inspector, or which are listed as not being able to
be animated in:

e Animatable Camera ParametersSee "Animatable Camera Parameters" page 197

e Animatable Heliodon ParametersSee "Animatable Heliodon Parameters" page 198

e Animatable Light ParametersSee "Animatable Light Parameters" page 199

e Animatable Object ParametersSee "Animatable Object Parameters" page 199

Animations List |

=

opens the sequence list. Each is displayed by name and preview thumbnail.

& @

Sequence_1

e To edit, double-click on the name.

° adds a sequence, s deletes it.
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Animation Pop-up Menu
e Right clicking on a view displays the pop-up menu:

Duplicate
Duplicare WView and Path

Add 1o Perspective View List
Add 1o Parallel View List
Add 1o Fanorama List

Add 1o VR Object List

Edit Heliodon

Edit Light >

Duplicate: Starting with the current sequence, a sequence is created that takes up the position of the camera
but not the existing path.

Duplicate View and Path: Starting with the current sequence, a sequence is created that takes up the position
of the camera, the existing path and key frames.

NB: Only the camera path is duplicated; the paths of objects and lamps are excepted.

Delete: The current sequence is removed from the list.
Add to: Perspectives list

Add to: Parallel Views List:

Add to: Panoramas List

Add to: VRObject List

Depending on option selected, adds current view from Perspectives to Parallel Views, Panoramas, or VR
Objects.

Edit Heliodon: The palette inspector switches to Heliodon mode and the heliodon is selected.

Edit Light: select a light, the inspector palette switches to Lights mode and the light is selected.

oo
Animation Coordinates |

From the viewpoint (Position) and Target of the camera.

Coordinates
x ¥ z
-12.18 m -97.30 m 30,29 m
Targevon: (FxedVerex  9)
X ¥ z
-15.32 m =74.35 m 20,38 m
Camera Roll: 0.00 :

The Camera Position defines:

e Viewpoint position: Provides the X, y, z coordinates. Entering new values redefines the position.
e Target Position 2 options:

On a fixed vertex: The camera moves on its path aiming at a fixed vertex in the scene. The fixed vertex is
defined in the Preview window or in 2D View.

Target on: | Fixed Vertex 3
x ¥ ra
-12.17m -37.30m D.2%m
Camera Rodl:| 0.00
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Orientation on path: The camera moves tangentially to the path. Horizontal and vertical angles can be defined
relative to this tangent. The Distance provides the distance between the camera and the aim point.

Target on: choose between target on a fixed vertex or on an object defined as target.

Targer on: |_Path s

Angle H Angle ¥ Distance
0.00 0.00 1.00 m
Camera Rell: 0.00 %

NB: Using the Timeline, in a single sequence, the camera can change behaviour several times.

R

Animatable Camera Parameters —

What can be animated

I From the Cameras Inspector I Editing in I

Camera coordinates Animations Inspector - Coordinates tab - 2D
View

Target coordinates Animations Inspector - Coordinates tab - 2D
View

H target angle relative to the tangent to the Animations Inspector - Coordinates tab

path

V target angle relative to the tangent to the Animations Inspector - Coordinates tab

path

Activated and/or displayed clipping box Animations Inspector - Coordinates tab - 2D
View

Modification box

Focus Animations Inspector - Coordinates tab - 2D
View

Colored background Animations Inspector

Depth of Field Animations Inspector

Atmosphere Animations Inspector

Roll Animations Inspector

Settings are available in the Animations Inspector.See "The Animations Inspector" page 193
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What cannot be animated

I Cameras I

Ambient

Changing a heliodon

Changing light groups

Background and foreground images

Changing the Photorealistic/Hatch ren-
dering engine

e
Animatable Heliodon Parameters —|

What can be animated

From the Heliodons Inspec- Editing in

tor

Time Heliodons Inspector
Date Heliodons Inspector
Power of the Sun Heliodons Inspector
Celestial illumination Heliodons Inspector
Celestial color Heliodons Inspector
Color Heliodon inspector
Lens flare Heliodons Inspector
Halo type Heliodons Inspector
Lens flare power Heliodons Inspector

Parameters are available in the Heliodons Inspector. See "The Heliodons Inspector" page 145

What cannot be animated

I Heliodons I

Cities

Shadows ON/OFF

Shadow type

Contribution to radiosity

Colored sun On/Off

Orientation of North
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Animatable Light Parametersm_fl:

What can be animated

I From the Lights Inspector I Editing in I

Status ON/OFF Lights Inspector

[1lumination type (omni, spot, Lights Inspector

direct.)

Power Lights Inspector

Associating a halo Lights Inspector

Changing halo Lights Inspector

Shadows ON/OFF Lights Inspector

Soft shadows Lights Inspector

Shadow power Lights Inspector

Source coordinates Lights Inspector - Coordinates tab - 2D
View

Target coordinates Lights Inspector - Coordinates tab - 2D
View

Spot Opening Angle Lights Inspector - Coordinates tab - 2D
View

Fall-off Lights Inspector - Coordinates tab - 2D
View

Soft shadows bias Lights Inspector - Coordinates tab - 2D
View

Distance A Lights Inspector - Coordinates tab - 2D
View

Parameters are available in the Light Inspector. See "The Lights Inspector” page 151

What cannot be animated

| Lights |

| Radiosity contribution |

e
Animatable Object Parameters |

What can be animated

From the Objects Inspec- Editing in

tor

Coordinates Objects Inspector - Coordinates
tab

Rotation Objects Inspector

Dimensions Objects Inspector
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e For 3D vegetation: Plant sizes, colors, date, etc.
e For Billboards: Size, luminosity, brightness, etc.

Parameters are available in the Objects Inspector. See "The Objects Inspector” page 125

What cannot be animated

I Objects I

Scene coordinates

Scene rotation

Scene dimensions
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Artlantis settings enable you to organize your working environment.

In this chapter you will learn about the following subjects:

Preference Settings. .. ... L.

Preference Settings

Artlantis settings enable you to organize your working environment.

Access: Artlantis Menu > Preferences

Preferences
General
Focal Units 2 o
(5] degrees
Default Location: Madrid E
C
Viewfoint Update Mode: J el s
® Auvtomanic Update
™ Display expert rendering parameters
Preview

Max Preview Size: I'sau_ B
W Autarmatic Switch to DpenGL

Open GL

E Camera Light
[ All Model Lights
[} Last Manipulated Light Shadow

1 n
FPS  af—— 4

Final Renderer
Rendering Output Folder: () Use Document Folder
1 Use Default Output Folder

Select Falder...

[Users fmyeanfrancols Pictures

[Default File Format: [ IPEG @

Defawlt File Name: 'B View Name
) Document + View Name

General

Ceneral

)
®) degrees
Default Location: MJ

) Manual Update
) Automaric Update

Focal Units:

ViewPoint Update Mode:

E Display expert rendering parameters

e Work units: In the drop-down menu choose (mm, m, cm, inches, feet and inches).
e Focal Units: select mm or degrees for the viewpoint inspector focus.
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o Default location: In the pop-up menu. The change becomes effective the next time a DWG, DWF, DXF, OBJ
and 3DS file that does not contain any location-related information is opened.
e Viewpoint Update Mode: select the viewpoint update in manual or automatic mode. This concerns the positions
of the camera, the viewpoint, the roll and focal length.
. Automatic
Each time the camera settings are modified, it is the last state that is used and the previous states are not
retained, except when clicking on the Back tool (provided the document has not been saved in the meanwhile
or another viewpoint has not been activated).
° Manual
When the camera settings have been modified and the user wishes to keep them, the user must update the
new state. If the new state is not updated, the next time the file is saved or the next time the viewpoint is
changed, the viewpoint that was last updated will be the one to display.

L _ T eeeterences

General
Dirmension Units Meters

g
. 3
O mm
Focal Units
@ degrees.
Default Location: [ Madrid =
& marf jate

ViewPolnt Update Mode:
(0 Automatic Update

W)

Update the viewpoint by clicking on in the Preview window toolbar.

NB: Updating or not updating the viewpoint will have no effect on edits to Shaders, objects, lights, or
backgrounds, which continue to be backed up automatically.

In manual update mode, in the viewpoint list, the thumbnails will be updated when the use clicks the
"Update" button, or when a new view is activated.

The thumbnails in the list will not be updated when Shaders, lights or backgrounds are modified.

e Display Expert Rendering Parameters: checked, in the viewpoint rendering parameters window, enables refine-
ments to be made using the Expert Viewpoint Rendering parameters.

Preview

Preview |
Max Preview Size: (=00 ]
# Autarmatic Switch to DpenGL

Open GL
™ camera Light
| All Model Lights
"1 Last Manipulated Light Shadow

w
lPs-'c—--i

o Maximum Preview size:

Choice of the maximum size of the Preview window content (using the shortcut Command +). In the pop-up
menu (640, 800, 1024, 1200), the value means the size of the preview image displayed in that window.

e Automatic permutation in OpenGL mode:

When this box is checked, the display mode switches from photorealistic to OpenGL mode when the camera
is moved. Speeds up display in small configurations.

NB: The refresh time of the window is proportional to the size of the display.

OpenGL options

The following options affect the Preview window rendering display in OpenGL mode.

Camera light:
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when this option is checked, it simulates the white omni-directional light emitted from the camera. The scene
is always lit.

NB: This option is independent of the anti-aliasing of the final rendering.

o All light sources:
When this option is checked, OpenGL takes into account all active light sources: lights and sun.

NB: The refresh time of Preview slows down when the option is activated.

e Last manipulated Light Shadow:

When this option is checkec, OpenGL takes into account shadows cast from the last light or sun manip-
ulated.

NB: The refiresh time of Preview slows down when this option is activated.

e FPS:

Increases or reduces OpenGL navigation fluidity. The greater the number, the better the fluidity. On the other
hand, a low figure gives better image definition.

Move the slider or enter a value of between 1 and 30 images per second.

Final Renderer

e Rendering output folder:
Two choices for the default rendering output folder:
m  Document directory: The renderings are saved at the same level as the current file.

m  Default recordings: The renderings are saved in the folder defined by clicking on Select Folder-...

Final Renderer
Rendering Output Folder: () Use Document Folder
) Use Default Output Folder

(" Select Folder... )

JUsers/mjnanfancon Fenses

Default File Formart: JPEG _31

Default File Name: (@) View Name
() Docurment + View Narme

Default file format: in the drop-down menu, choose: JPEG, BMP, TARGA, PICT, TIFF, Photoshop or
Piranesi.

Default file name: either the name of the viewpoint, or the name of the document plus the name of the
viewpoint.
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Mouse and Keyboard Shortcuts

Available in 2D View and Preview.

In this chapter you will learn about the following subjects:

General 2D Shorteuts. .. .. ... 206
2D Shortcuts - Working with Perspectives. . ... ... ... .. ..., 207
2D Shortcuts - Working with Parallel Views. _ ... .. ... 207
2D Shortcuts - Working with the Clipping Box. . .. ... .. ... ... 207
2D Shorteuts - Working with Objects. . .. ... ... ... 209
2D View shortcuts - Working with Lights. . ... . ... ..... 210
2D Shortcuts - Working with Heliodons. .. ... ... . ... . ... 210
2D Shorteuts - Working with Panoramas. ... .. ... ... ...l 212
2D Shortecuts - Working with VR Objects. . ... ... ... .. i 212
2D Shortcuts - Manipulating Animations. . ... .. .. .. .. ... ...l 213
General Preview Display Shorteuts. . ... ... 213
General Preview Navigation Shorteuts. .. ... ... ..., 214
Activated Object Inspector Preview Shortecuts. .. ... . . .. . .. . ... ... 215
Preview Shortcuts Specific to Insertion into Site (Perspectives inspector)........ ... . ... ........... 216
Activated Heliodon Inspector Preview Shorteuts. . ... .. ... ... ... ...... 216
Activated Shaders Inspector Preview Shorteuts . ... .. ... . ... 218
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General 2D Shortcuts

Actions Combination and Key Strokes
Enlarge the display +
R
Reduce the display =
e
Fit to Window =
e

Camera pan movement.

/
.fJ&—Jor _

Enlarge a part of the window by drawing a rectangle with two oppos-
ing angles

El El

+ or - Dynamic Zoom as a function of the point being aimed at

]
\

=

Change 2D View

Following the view, depress the keyboard
key:

1 (Above), 2 (Front), 3 (Right), 4 (Left),
5 (Rear)

Previous view

Next View

[ [z
l

Activate the Pop-up menu

Force a movement on a 45° incremental scale.
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2D Shortcuts - Working with Perspectives

Actions Combination and Key Strokes
Inspectors: Shaders, Lights, Heliodons, Objects and Per-
spectives
Graphically move: .

The camera, the target or the bisector

e

Graphically modify the focal distance

Duplicate a Viewpoint:

Alt
& —
2D Shortcuts - Working with Parallel Views
Actions Combination and Key Strokes
Inspectors: Shaders, Lights, Heliodons, Objects, and Parallel
Views.
Graphically move: .

The camera, the target or the
bisector

—
Graphically modify the section .
width

Duplicate a Viewpoint:

2D Shortcuts - Working with the Clipping Box

In order to use the Clipping Box tool, the "Show" option must be checked in the Perspectives inspector.
W Shew W Activare g

The command takes effect with all inspectors
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Actions:

e Blue contour line entry
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e Move the origin of the circular cursor by clicking and dragging from the center.

The recall lines coming from the center help with positioning.

2D Shortcuts - Working with Objects

Actions

You can only manipulate objects in Objects

Move an object

mode.

=

Duplicate an object

Alt \
& \-=-

Duplicate an object several times

- _f"J& € .

.l..

e

increase or

e

decrease the number of copies

Redefine the anchor point of an
object

.E‘l& =
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2D View shortcuts - Working with Lights

Actions Combination and Key Strokes

Inspectors: Shaders, Lights, Perspectives, Parallel
Views, Panoramas, VR Objects, Animations.

Graphically move the source, the target and the bisector,
modify the light cone and the lighting distances.

Duplicate a light
Alt

— & =

»
ElEl.€.
+

|

Duplicate a light several times

to increase or

| e
decrease the number of copies.

2D Shortcuts - Working with Heliodons

Depending on the operation chosen in the Heliodons inspector, there are three options available: Location, Manual
and 45°.

%) Locatian Mariual 33
f San Francisco E] ‘:ﬁl

Location option:

e Defines the direction North by moving the yellow point around the compass.
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&

o

Result: Shadows are recalculated.

Manual Sun Position option

&

R .

e Graphically moves the sun icon around the yellow circle.

&

o

Result: Shadows are recalculated.

There is an option for shadows to be projected at 45° depending on the position of the viewpoint.

&

e The angle between the viewpoint bisecting line and the position of the sun always remains at 45°.

Result: Even after the camera is graphically moved, the shadows remain at 45° to the camera.
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2D Shortcuts - Working with Panoramas

Actions Combination and Key Strokes

Inspectors: Shaders, Lights, Heliodons, Objects and
Panoramas

Graphically move: ‘

The camera, the target or the bisector

e
Graphically modify the focus (Perspectives, VR Objects, ‘
Animations)

Graphically modify the view width (Panoramas)

I

Duplicate a Viewpoint:

Alt
o .
2D Shortcuts - Working with VR Objects
Actions Combination and Key Strokes
Inspectors: Shaders, Lights, Heliodons, Objects and
VR Objects
Graphically move: ‘
The camera, the target or the bisector
e
Graphically modify the focus (Perspectives, VR Objects, ‘
Animations)
Graphically modify the view width (Panoramas)
k.
Duplicate a Viewpoint:
Alt
& e
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2D Shortcuts - Manipulating Animations

Actions

Combination and Key Strokes

and Animations

Path edit mode:

path, or a control point.

For graphically moving the camera, viewpoint, bisecting line,

Time edit mode:

For moving a keyframe

Graphically modify the focal distance

Extend Path:

Alt

& e

To the path's final control point

General Preview Display Shortcuts

| Actions Combination and Key Strokes
Enlarge the content of the Preview window.
38 o
P R S
NB: the camera does not move.
Reduce the content of the Preview window.
gg -
PN R AR—
NB: the camera does not move.
Fit to Window 3£ e
PR R —
Zoom + 3£ | “ |
& release, draw a rectangle
Zoom -

3 | * | Alt
& release, then draw a rectangle
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General Preview Navigation Shortcuts

| Actions Combination and Key Strokes
Animations
Mode
Parallel NB: For
Views and VR a camera
Perspectives Panoramas Objects with no
Mode. Mode. Mode. path.
Turn the camera around the clicked point . N/A N/A .
| —— | ——
Alt | Alt |
& &
Turn the camera around its target . N/A = .
—— —— ——
Turn the camera on itself. N/A
o o o
't 't
| |
The + or - Dynamic Zoom is focused on the position
of the cursor. . N/A N/A B
— —
't '
I ]
Change the focus distance. N/A . . N/A
| e
]
1:
—
|.. NB: For
a camera
with no
Camera pan movement. . N/A N/A path.
|
Pan To: % |
& x
Place a viewpoint perpendicular to a surface. Click N/A N/A Click &
ic
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Mouse and Keyboard Shortcuts - nd

v

&
Move the camera through the scene. Click
When the cursor is pointed towards the top of the NB: For
window, the camera moves forwards in the scene; a camera
when it is pointed towards the bottom, it moves lat- W with no
erally, towards one of the sides Click & N/A N/A path.

ic

NB: In Shaders, Lights, Heliodons and Objects modes, you can navigate just like in the viewpoints inspector

Space Bar
by releasing the current Edit Shaders mode. Press the key and then use the com-
binations described in the table.

Example:

In Shaders mode with a Perspectives display, you must use the following shortcut to turn the camera around its tar-

Space Bar I Alt | L Space Bar I
get: & & = . Once you release the

Edit Shaders mode is reactivated.

Activated Object Inspector Preview Shortcuts

Combination and Key
Actions Strokes
Select and/or move the object. .
e
Duplicate the object. Alt -
& —
Replace the object with a different one using a drag & drop from the Catalog or
Desktop. S | -
& | ——
Move with no change of the hierarchy 3& .
& T
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Preview Shortcuts Specific to Insertion into Site (Perspectives inspector)

Actions

Combination and Key
Strokes

reference axis.

Move the origin of the trihedron, pivot the axes or slide the yellow cursor to the defined

i ile maintaining the directi Alt
Move the origin of the axes while maintaining the directions. &
'
i
Show/Hide the magnifying glass. Each incrementation increases the content of the mag-
nifying glass from x2 to x8. e
Activated Heliodon Inspector Preview Shortcuts
Combination
and Key
Actions Strokes

Manually move the sun.

NB :Only available when the Manual option is selected in the Heliodon inspector.

ﬁ & Locm:i Cyase

San Francisco .

Define fog start (advanced heliodon settings).

# rog

Seart distance -¢n- . 0.50 m

Click on the target icon and then click on an element in Preview.

Example of manually moving the sun:

Preview: Manually moving the sun.
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Result after movement.

NB: Ifthere is no sun in the current view, you can display it by modifying its position in the 2D View.

Example of positioning the start of fog:

Click on the airplane in the foreground to define the fog start.

Click on the airplane in the background to redefine the fog start.
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Activated Shaders Inspector Preview Shortcuts

Actions Combination and Key Strokes

Select a Material or a Shader .

NB: The material is highlighted.

Select a material or a Shader located behind a transparent surface. T | . -
Select a material or a Shader by reflection in another material. .
NB: if the Specular slider is at maximum. R
el &

Duplicate a Shader or texture. Alt
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